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Foreword

Punjab School Education Board, since its inception has been engaged in an
endeavour to prepare text books on various subjects at school level. This textbook is
one in the series and is designed to focus on student-centered learning for the students
of Computer Science. The book has been developed as per recommendations of
Punjab Curriculum Framework 2013 based on National Curriculum Framework-2005,
according to which the school life of the students needs to be linked to the outside
world. The book is step forward to move from the traditional book-based learning to
activity-based learning.

The need for study of Computer Science as a subject in increasing day by day
because in the age of scientific and technological advancement computer education
improves the work efficiency in every field related to socio-economic life. With the
advancement of communication and information technology, computerization is being
done in every department. Computer Education has become mandatory to have
access to information from various departments, e-governance and internet access
in various aspects of modern life such as education, business, health, transportation
and many more.

Keeping in view such requirements, Punjab School Education Board has
implemented the guidelines of the Punjab Government to make the Computer Science
subject as a compulsory subject from Class VI to XlI. Every effort has been made to
include requisite information according to level of class Ninth in this book. Hopefully
this book will be useful for students and teachers.

Punjab School Education Board acknowledges the sincere efforts made by
writers, translators and vetters for the preparation of this book. Board also welcomes
comments and suggestions for any further improvement.

Chairman
Punjab School Education Board
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NETWORKING

,—[ Objective of this Chapter: }

1.1 Network
1.2 Need of Networking

1.5 Types of Networks
1.6 Network Topologies

1.7 Data Communication

1.3  Advantages and Disadvantages of Network

1.4  Components of Computer Networks

INTRODUCTION

We have studied about working with standalone computer. Only single user can do work on

standalone computer at a time. To perform complex tasks, that may require a team work to

perform different activities to complete the task, we need to connect our computer with other

computers. Such an interconnection between computers forms a Computer Network. These

networks help us to communicate and share files among a group of users connected to the Network.

In this chapter, we are going to study various concepts of networking in detail.

1.1 NETWORK :

A network is the group of two or more
computers that are linked in order to share
resources such as printers, files and other
resources. It also allows communication
among different users within a network.
The computers in a network may be linked
through any communication media, such
as: cables, telephone lines, radio waves,
satellites or infrared light beams. Network
is capable of sharing Software and
Hardware resources among users within a
network.

Modem Printer

Fig 1.2 Computer networking

In general, network connections between computers are created using cables (wires). However,
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connections can be created using radio signals (wireless / wi-fi), telephone lines (and modems)
or even for very long distances, via satellite links.

Note: A computer that is not connected to a network is known as a standalone computer.

1.2 NEED FOR NETWORKING: The ability to exchange data and communicate efficiently is
the main purpose of networking. Some of other common usesof Networking are given below:

We

> Remote Printing

File Transfer

?
-

\‘p - O

Security

Fig. 1.2 Need for Networking

—

Remote Access to computer or other terminals.

Ensured privacy among all the users of network.

Sharing hardware devices like printer, scanner, modem etc.

File sharing across the network.

Sharing of software or operating programs on remote systems.

Make information easier to access and maintain among network users.
Multiple users can play games from different locations.

Multiple users can share the Internet connection.

e S S N B

Communication via email, video conferencing, instant messaging, etc.

10. Secured centrally access and backup of data among network users.
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1.3 ADVANTAGES AND DISADVANTAGES OF NETWORKS

Advantages of Networks:

Sharing files,data and information:You can share data, programs and different
resources with it. It is only possible because all the files are stored on server (Central
computer, Server allows sharing of these files)

Sharing Hardware and software: you can share hardware and software within
network easily.For example, a printer can be shared among the users in a network so
that there’s no need to have individual printers for each and every computer in the
organization.

Fast Communication : Network provides a very fast communication media e.g. E-
mail is used as a fastest way of communication in different offices.

File Integrity: File integrity remains continuous due to network. It saves much time.
Network helps in fast saving and sharing of files.

Cost effective: We can share costly input and output devices like printer with network.
Thus, it reduces the cost of system.

Reliability: Network ensures use of many resources to us e.g. when hardware fails,
information can be recovered from other computer with the help of network.

Flexibility: It provides more flexibility because there is a possibility of connecting
devices of different organizations in it.

Backup: It is difficult to get back up of a file from different computers. But it is easy
to take backup from server if we are linked with network.

Security: Network provides security to us. Network user can be restricted to access
files or applications.

Speed:Sharing and transferring files within networks is very fast which saves time
and money.

Disadvantages of Networks:

Network Failure: All the central facilities may fail due to network failure.
Management: For managing entire network, technical experts are required.
Security: There are security threats in a network. Data can be misused in network.

Expensive to Build: Building a network is costly, especially for Large scale
organizations. Cost of cables and other hardware equipment is very high.

1.4 COMPONENTS OF COMPUTER NETWORKS:

A computer network consists of several components. Each of these components is very important

for the proper functioning of a network. Computer network components include the major
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parts that are required to install a network both at the office and home level. Before exploring the
networking process, we should be familiar with its parts so that we could choose and buy the
right component that fits with our network system.

a. Computer: The purpose of a network is to interconnect computers. The first step for setting
up a network is to identify computers and users who want to participate in the network.There are
two types of computers which are used for creating a network:

e (lient: Client is a normal computer system. These computers are connected to a
network for sharing various types of resources.

e Server: Server is a powerful computer system. It helps in sharing of resources or
information in the network. It controls all other nodes within a network.

Server

—

Client C!it

Fig 1.3 Client/Server

Note: A Node can be a Computer, Printer, Switch, Scanner or any other device connected to the
network for sharing purpose.

b. Network Interface Card: A Network Interface Card(NIC) is a Printed Circuit Board (PCB).
It is installed on the motherboard inside a system-unit so that a computer can be connected to a
network. It should be fitted in each client and server computer.

There are two types of network cards:

e Ethernet Card: The Ethernet NIC uses Ethernet cables and connectors as a medium
to transfer data

e  Wireless Card: In wireless card, the connection is made using such an antenna that
employs radio wave technology.
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Network Interface Card Wireless Card

Ethernet Cable

Ethernet Part ‘

Fig: 1.4 Network Interface Cards

c¢.HUB / Switch:A networking Hub/Switch is a device that allows us to connect multiple
computers to a single network. In simplest form, a hub works by duplicating the data packets
received at one port and making it available to all other ports, therefore allowing data sharing
between all the devices connected to the hub/switch.

& E

Printer
twrk smtch File sefver

A 2

Network using Network using Network using

Fig 1.5 Hub/Switch Fig 1.6 Network using Hub/Switch

d. Router: A router is a hardware device designed to receive, analyze and forward incoming
data within a network or to another network. It decides the forwarding-route for each incoming
data-packet of the network.

Fig 1.7 Router
e. Transmission Media: Transmission media is a communication channel that carries the

information from the sender to the receiver. They are of two types:

e Guided Media: It is a wired media, such as Twisted Pair Cables, Coaxial Cables, and
Optical Fiber etc.

e  Unguided Media: It is a wireless media, such as Microwave signals, Satellites etc.
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1.5 TYPES OF NETWORKS:

There are several different types of computer networks. Computer networks can be characterized
by their size as well as their purpose. The size of a network can be expressed by their geographical
area and the number of computers that are connected to a network. Networks can cover anything
from a handful of devices within a single room to millions of devices spread across the entire
globe.

Networks may be small or large based on its size, complexity and Distribution area. On the basis
of their size, Networks can be categorized as follows:

1.  PAN(Personal Area Network)

2.  LAN (Local Area Network)

3. MAN (Metropolitan Area Network)

4.  WAN (Wide Area network)

1.5.1 Personal Area Network

A Personal Area Network or PAN, is a computer network | ) ‘g
organized around an individual person within a single g

building. This could be inside a small office or residence. ™ of
Personal area networks can be constructed with cables e E
or it can be wireless. It refers to the interconnection of ' """" ' " ‘
information technology devices or gadgets (include L ¥
laptop computers, PDAs, cell phones, printers) within ‘ @
the environment of an individual user (typically within )

10 meters).

1.5.2 Local Area Network (LAN):

Fig. 1.8 PAN

A LAN is a network that is used for
communication among computer
devices, usually within an office
building or home. LAN’s enable
sharing of resources such as files or
hardware devices that may be needed
by multiple users. Itis limited in size,
typically spanning a few hundred
meters, and no more than a mile. It is
fast, with speeds from 10 Mbps to 10
Gbps. It Requires little wiring, Fig 1.9 LAN
typically a single cable connecting to

each device. It has lower cost compared to MAN’s or WAN’s. LAN’s can be either wired or
wireless. Twisted pair, coaxial or fiber optic cable can be used in wired LAN’s. It is suitable to
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bus, ring or star topologies. Generally Coaxial Cable on Twisted Pair transmission media is
used in these networks.

1.5.3 Metropolitan Area Network (MAN):

This type of network is distributed in a city, college campus or large area just like a Cable TV
network.A MAN is optimized for a larger geographical area than a LAN, ranging from several
blocks of buildings to entire cities. A MAN might be owned and operated by a single organization,
but it usually will be used by many individuals and organizations. Many LANs may be inter-
connected in this type of network. A MAN often acts as a high-speed network to allow sharing of
regional resources. A MAN typically covers an area of range between 5 to 50 km diameter.
Examples of MAN: Telephone company network that provides a high-speed DSL to customers
and cable TV network.

Network of Building-2

Fig 1.10 MAN Network of Building-3

1.5.4 Wide Area Network (WAN):

WAN covers a large geographical area such as a country, continent or even the entire world.
WAN can contain multiple smaller networks, such as LANs or MANS. In this network,various
types of communication media such as - telephone lines, satellites, microwave signals etc. are
used. These transmission media are linked with Router. Router is a device which determines the
route of information from sender to receiver. The world’s most popular Wide Area Network is
the Internet.
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1.6 NETWORK TOPOLOGIES:

Fig 1.11 WAN

Network topology is the arrangement of the elements such as links, nodes, etc.of a

ComputerNetwork. The term Topology refers to the way in which the various nodes or computers
of a network are linked together. It describes the actual layout of the computer network hardware.

Topology determines the data paths that may be used between any pair of devices of the
network.Two or more nodes connect to a link; and two or more links form a topology.

Link
between computers

Node-1

Node-2

Fig 1.12 Link vs. Topology

- -
AEm— -~

Computer Network
Topology

Node-1

Node-3

The selection of a Network Topology depends on the choice of media and the access method

used. The following factors are considered while selecting a topology:

1.

8 B

A

Cost

Reliability
Scalability
Bandwidth capacity
Ease of installation

Ease of troubleshooting
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1.6.1 Types of Network Topologies:

Following figure shows the different types of topologies:

Network Topologies

[ Bus l Ring l Star lMesh l Tree [Hybrid

1.13 Networks Topologies
1.6.2.1 Bus Topology:

Bus Topology is the simplest type of network topology.In this type of topology, all the nodes
(Clients, Servers and other Devices) are connected to the single cable with the help of T-
connectors. This central cable is the backbone of the network and is known as Bus. Every
workstation communicates with other devices through this Bus.Terminators are placed at both
ends of the bus cable to prevent signal bouncing.

When a signal is broadcasted from the source, it is transmitted to all other nodes connected to the
bus cable. Although the message is broadcasted, but only the intended recipient, whose MAC/IP
address matches, accepts it. If the MAC /IP address of machine doesn’t match with the intended
address, machine discards the signal.

Node-2 Node-4
Node-1
& i o i
<)
¥ il T-Connector ‘ ‘
Terminator
Cable Wire - a -~ i
(Bus) Node-3 Node-5

Fig 1.14 Bus Topology
Advantages of Bus Topology:
e  Any new computer can be attached easily.
e Itis a cheaper topology.
e If one computer fails, others are not affected.

e  (Cable requirement are least as compared to other network topologies.
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e  Used in small networks.
e [tis easy to understand the layout and connectivity.
Disadvantages of Bus Topology:
e [f the main central bus fails, the entire network breaks down.
e The efficiency of network is reduced with the increase in number of computers.
e (Cable length is limited.
e [t is slower than some other topologies.
e Terminators are required at both ends of the backbone cable
e  Difficult to identify the problem if the entire network breaks down
1.6.2.2 Ring Topology:

In Ring Topology, all the computers are logically linked in the form of a ring. In this type of
topology, each node is connected with two adjacent (Neighboring) nodes. All traffic travels
either clockwise or anticlockwise around the ring. At the time of accepting data, each node
checks its address. If address matches with the node,

node will accept it. Otherwise, data will be rejected by the node. There are two kinds of ring
topologies:

1. Single Ring - In single ring network, a single cable connects all the devices and data
travels only in one direction. Each device waits for its turn and then transmits data.
When the data reaches at its destination, another device can transmit data.

2. Dual Ring: This topology uses two rings to send the data in both directions, i.e.
clockwise and anti-clockwise. Thus, it allows more packets to be sent over the network.

Node-1 Node-2

- o=

I’\Iode-S Node-4 Node-5 Node-4

e - o= - e

Fig 1.15 Ring Topology
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Advantages of Ring Topology:

e  Very systematic network where every device has access to the data and the opportunity
to transmit data.

e Performs better than a bus topology under heavy network load.
e Does not require a central node to manage the connectivity between the computers.

e [tiseasier to locate the problems with device and cable i.e. fault isolation is simplified.
If one device does not receive a signal within a specified time, it can issue an alarm.

Disadvantages of Ring Topology:

e  Failure of one computer can affect the entire network.

e  Difficult to troubleshoot.

e  Adding or removing Computers disrupts the network

e A ring network requires more cable than a bus network.
1.6.2.3 Star Topology:

In Star Topology, all the nodes are connected to a central device. This central device can be a
Hub, a Router or a Switch. This Hub/Switch is the central node of network and all other nodes
are connected to this central node. Nodes in star topology cannot have a direct connection with
each other. They have to be linked via hub.

Fig 1.16 Star Topology

Advantages of Star Topology:

e [tis easy to setup and connect.
e  Failure of one computer does not affect the other.

e  More nodes can be connected easily.

NETWORKING B 11




e ]t is easier to find faults in network.
e  Easy to troubleshoot.

e  Easy to modify.
Disadvantages of Star Topology:

e  Failure of hub results in failure of entire network.

e  Cost of installation is high.

e  Performance depends on the capacity of central device.

e Cable requirements are more as compared to some other network topologies.
1.6.2.4 Mesh Topology:

In Mesh Topology, each node is directly connected to other nodes in the network. A mesh topology
can be a fully or partially connected mesh topology:

e In afully connected mesh topology, each computer in the network has a direct
connection to all the other computers in that network.

e In a partially connected mesh topology, at least two computers in the network have
connections to other computers in that network.

Node-3 ~ Node-4
Fig 1.17 Mesh Topology

Advantages of Mesh Topology:

e Data can be transmitted from different devices simultaneously. This topology can
withstand high traffic.

e [f any of the components fails, there is always an alternate route available. So, data
transfer doesn’t get affected.

e  Expansion and modification in topology can be done without disrupting other nodes.
Disadvantages of Mesh Topology:
e Installation and configuration process is difficult.

e  Cabling cost is more.

12 B NETWORKING




1.6.2.5 Tree Topology:

A Tree topology is a special type of structure where many nodes are connected in hierarchical
structure like the branches of a tree.In Computer Networking, tree topology is known as a
combination of a Bus and Start network topology.Tree network topology is the simplest topology
in which only one route exists between any two nodes on the network. The pattern of connection
resembles a tree in which all branches spring from one root, hence Called Tree Topology.

> e -
Node-4 Node-5 Node-6 Node-7 Node-8

Fig 1.18 Tree Topology
Advantages of Tree Topology:
e It is an extension of Star and bus Topologies.
e  Expansion of Network is possible and easy.

e  We can divide the whole network into segments (star networks), which can be easily
managed and maintained.

e  Error detection and correction is easy.
e If one segment is damaged, other segments are not affected
Disadvantages of Tree Topology

e Because of its basic structure, tree topology, relies heavily on the main bus cable, if
it breaks whole network goes down.

e The maintenance becomes difficult when more nodes are added.
e  Scalability of the network depends on the type of cable used.
e It has higher cabling cost in setting up a tree structure.

1.6.2.6 Hybrid Topology:

A hybrid topology is a type of network topology that uses two or more other network topologies,
including bus topology, mesh topology, ring topology, star topology and tree topology.It is a
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mixture of any two or more topologies. In the following figure, Bus, Star and Tree topologies are
connected to form a Hybrid Topology.

Node-2 Node-3

— Bus —
“j&== Topology -| s

Topology L4
Node-7
v - - — Tree
Node-6 Topolog
- e
> - ==
Node- Node-9

Fig 1.19 Hybrid Topology

Advantages of Hybrid Topology:

e Reliable as Error detecting and troubleshooting is easy.

e  Scalable as size can be increased easily.
Disadvantages of Hybrid Topology:

e  Complex in design.

e  Costly.
1.7 DATA COMMUNICATION

Data communication is the exchange of data between two or more computers (a sender/source
and a receiver/destination) with the help of communication medium. The device that transmits
the data is known as sender/ source and the device that receives the transmitted data is known as
receiver/destination.Data communication must fulfil following three conditions:

1. Delivery: Network should deliver the data at intended destination.

2. Accuracy: Data communication should be free from fault.

3. Time limit: Data should reach at destination without any delay.
1.7.1 Components of Data Communication

There can be many varieties of components that may involve in Data communication. Some of
the essential components of data communication are as follows:

1. Sender: Sender prepares information (data) and sends it

2. Medium: It carries the information from sender to receiver. It can be guided or unguided

media.
14 B NETWORKING




3. Receivers: Receiver receives the information sent by the sender.

4. Protocol: These are the set of rules that manages data transmission between sender
and receiver

Step 1
Step 2:
Step 3:

Protocol _ Protocol

.’.“-I\ Medium -

Sender - -"
Receiver

Fig 1.20 Data Communication

1.7.2 Modes of data transmission:

Modes of data transmission refer to the direction of flow of data between sender and receiver.
Modes of data transmission are given below:

Transmission
mode

Simplex Half-Duplex | Full-Duplex
mode mode mode

1. Simplex: In this mode of data transmission, communication is in one direction only.
In this type of data transfer mode, only sender can broadcast information and receivers
can only receive the broadcasted information. No receiver can send any type of
information to anyone. Example: television communication.

Uni-directional Transmission
— ) ——
J

~

Sender Receiver
Fig 1.22 Simplex Mode

2. Half duplex: In this mode of data transmission, information can flow in both directions
but not at the same time. In other words, if information is sent by one node then
second can only receive it or vice versa as shown in the following figure. Example:
walky-talky system used by police and army.

Bi-directional Transmission
S 2
—— ‘ ——

—, (One side at a time) - o=
Sender Receiver
Fig 1.23 Half-duplex Mode
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3.

Full duplex: In this mode of data transmission, information can be transmitted in
both directions at same time as shown in following figure. It provides fast
communication between nodes. Example: Telephone System:

- Bi-directional Transmission _
-« >
— (Both sides at a time) —
r = - &=
ender Receiver

Fig 1.24 Full-Duplex Mode

POINTS TO REMEMBER

1.

10.

I1.

16 B

A network is a group of two or more computers that are linked in order to share
resources such as printers, files and other resource.

A computer that is not connected to a network is known as a standalone computer.

A computer network consists of several components like Computer, Network Interface
Card, HUB/Switch, Router etc.

On the basis of its area of distribution, network is divided into some categories like
PAN(Personal Area Network), LAN (Local Area Network), MAN (Metropolitan Area
Network) andWAN (Wide Area network).

A personal area network, or PAN, is a computer network organized around an individual
person within a single building.

A LAN is a network that is used for communicating among computer devices, usually
within an office building or home.

A MAN is distributed to a city, college campus or large area just like Cable TV network
it is also single. Many LANSs are connected in it.

A WAN covers a large geographic area such as country, continent or even whole of
the world. WAN can contain multiple smaller networks such as LANs or MANSs.

Network Topology refers to the way in which the various nodes or computers of a
network are linked together.

Some examples of Network Topologies are Bus, Ring, Star, Mesh, Tree and Hybrid.

Data communication is the exchange of data between two or more computers (a sender/
source and a receiver) with the help of communication medium.

NETWORKING




12.

13.

14.

Components of Data Communication are Sender, Medium, Receivers and Protocol.

In Star Topology, all the nodes are connected to a central device. This central device can be
a Hub, a Router or a Switch.

There are three modes of Data Transmission- Simplex, Half-Duplex and Full Duplex.

EXERCISE

Que:1 Multiple Choice Question :

I

is a group of two or more computers that are linked in order to share

resources such as printers, files, and other resources.

A. Network B. Internet
C. Wireless D. Topology
Which of the following is the smallest type of network?
A. MAN B.WAN
C.LAN D. None of these

is a device that allows you to connect multiple computers to a single
network.
A. HUB B.BUS
C. Ring D. Star
In network topology, a single backbone cable is shared by all the devices.
A. BUS B.TREE
C.MESH D.STAR

prepares information and sends it.

A. Protocol B. Receiver
C. Sender D. Hub

Que:2 Write True/False

I
I

m
v

We cannot Share hardware or Software among network devices.
LAN covers a large geographic area.
In full duplex, information can be transmitted in both directions.

Protocols are set of rules by which data transmission takes place between nodes.
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Que:3 Write the Full Forms:

==

A%

LAN

MAN

WAN

PAN

NIC

Que:4 Short answer type questions

==

\%

Write the names of any four Network Topologies.
Define Network Interface Card (NIC).

Write the name of components of data communication.
Write a short note on HUB.

What are the two types of ring topologies?

Que:5S Long Answer type questions

]

< B F

18 B

What is Network? Explain its advantages and disadvantages.

Explain the various components of computer network.
Write about different types of networks.

Explain the various modes of data transmission?

NETWORKING



| Lab Activity |

1. Give the name of different Topologies in the given diagram:

[[ NETWORK ]

()

2. Identify the following topology and write the name of various components of the

given topology.

Name of Topology:
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INTERNET APPLICATIONS

,—{ Objective of this Chapter: ]

2.1 Introduction to Internet

2.2  E-mail

2.3 CAPTCHA Code

2.4 Concept of Downloading and Uploading
2.5 Cloud Networking and Cloud Printing
2.6  Google Apps

2.7 Digi Locker

2.8 Internet Threats & Security

2.9 Cyber Crime & Cyber Ethics

2.1 INTRODUCTION TO INTERNET

The Internet is the global system of interconnected computer networks that communicates between
various networks and devices. It is a network of networks that consists of private, public, academic,
business, and government networks of local to global scope, linked by a broad array of electronic,
wireless, and optical networking technologies.

Internet is a worldwide collection of computer networks, cooperating with each other to exchange
data using a common software standard through telephone wires and satellite links. Internet
users can share information in a variety of forms. One can surf for any kind of information
regarding various topics such as Technology, Health & Science, Social Studies, Geographical
Information, Information Technology, Products etc. over the internet with the help of any search
engine.

Apart from communication and source of information, the internet also serves a medium for
entertainment. For example: Online Games, Songs Videos, Social Networking Apps etc.Internet
also provides a concept of electronic commerce that allows the business deals to be conducted
on electronic systems. The Internet allows us to use many services like Internet Banking, Online
Shopping, Online Ticket Booking, Online Bill Payment, email etc.
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2.2 E-MAIL

Email, stands for “electronic mail” is one of the most commonly used features
over the Internet. It allows us to send and receive messages to and from
anyone with an email address, anywhere in the world.

Email is a way of sending electronic messages or data from one computer
user to one or more recipients. Various webmail services are as follows:

1. Gmail
2. Yahoo! Mail
3. Rediff Mail
4. Hotmail

2.3 CAPTCHA CODE

A CAPTCHA stands for “Completely Automated Public Turing test to tell Computers and Humans
Apart”. It is a type of test used in computing to determine whether or not the user is human.

Fig 2.1 E- mail

CAPTCHA codes are mostly used on the signup or login pages of websites. A CAPTCHA is a
technique that protects websites by generating and grading tests that humans can pass but current
computer programs cannot. For example, humans can read distorted text as the one shown below,
but current computer programs can’t.

7445 vy

Type the characters above:

Fig 2.2 CAPTCHA

2.4 CONCEPT OF DOWNLOAD AND UPLOADING

Downloading is a process of receiving data/file from a remote computer (server) to the computer
of the user (client). We can use this option to download any media from the internet such as
Study Material, E-Books, Images, Songs & Videos.

Uploading is a process of sending data/file from a local computer (client) to a remote computer
(Server). We can upload our files like Notes, Pictures, Video Lectures etc Google Drive, Social
Media Sites, Youtube etc.
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2.5 CLOUD NETWORKING & CLOUD PRINTING

The term Cloud refers to a Network or Internet. In other words, we can say that Cloud is
something, which is present at remote location. Cloud can provide services over public and
private networks, i.e., WAN, LAN or VPN. Applications such as e-mail, web conferencing,
customer relationship management (CRM) execute on cloud.

Cloud Networking: Cloud networking refers to manipulating, configuring and accessing the
hardware and software resources remotely. It offers online data storage, infrastructure, and

@@@

application.

®, Qb . |
Fig 2.3Cloud Networking

Cloud networking offers platform independency, as the software is not required to be installed
locally on the PC. In cloud networking it is simple to add more hardware and software. Cloud
networking provides the ability to scale up and down when additional users are added and when
the application requirements change.

Cloud Printing:

Cloud Printing enables users to print documents and other materials on any device associated
with the cloud (network). We can connect all our devices including our computers, laptops,
tablets, phones etc. to one particular printer. We can print straight from any of the devices those
are not directly connected to the printer but connected to the cloud network using Internet.

Fig 2.4 Cloud Printing
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Cloud printing services allows the user to print from any web-connected device by routing print jobs
between your computer, smartphone or tablet and sends them to an internet connected printer. It also
allows users to quickly discover printers and print from their own device without the need to set up
driver installations. Users can create content and send the file to a cloud printing service provider via
whatever device they choose, which then routes the file to a cloud-attached printer at a location selected

by the user.

2.6 GOOGLE APPS

Apps is an abbreviation for application. An app 0 o~~~ Q
is a piece of software/program. It can work on a

the Internet, on our computer or on our phoneor  Aceaunt search Maps

other electronic device. The word “app” is amore

modern usage, but this is really the same thing as
a program. u ' B

Google refers to their online services as apps,but ~ YouTube Play Forms

(o

they also sell a specific suite of services known
as Google Apps.

Google Apps is a suite of Web-based applications

from Google that includes e-mail, calendar, word Meet Chat
processing, spreadsheet and presentations. Let’s

Gmall
have alook at the common google apps: e ‘ l 31

comtacts Drive Calendar
2.6.1 Gmail

‘Google Mail’ or ‘Gmail’ is a free email service & & o
Duo

provided by Google. In many ways, Gmail is like
any other web-based email service: Youcansend ~ 'ranslate Photos

and receive emails, block spam, create an address

book, and perform other basic email tasks. But it a a .
also has some more unique features that help to

make it one of the most popular email services Docs Sheets Slides

on the Web. Fig 2.5 Google Apps
2.6.1.1 Creating new account
In this section, we’ll study about how to get started with email by creating an account in Gmail.

Note: We are using Chrome as our browser; however other browsers such as Internet Explorer and
Firefox will look similar.
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Follow these step-by-step instructions to create a Gmail account
e  Open the internet browser.

e  Type www.gmail.com in the address bar:

« - C m www.gmail.com |

Google

Fig 2.6 Gmail

Note: You can also click on ”"Gmail” link at the top right corner of the google homepage.

_

& & C A © wwwgooglecom + | =

N |

GOig|€

==

Google Search I'm Feeling Lucky

Fig 2.7 Google Home Page

We’ll now be in the ‘Signin’ section.

Go gle

One account. All of Google.

Sign in to continue to Gmail

Email

Password

] Stay signed in Neead help?

reate an a

One Google Account for everything Google
HMD 2> E

Fig 2.8 Create New Account and Sign In
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As we don’t have a Google account yet, we need to create one. Click Create an account. To set up
our new account, Google needs some information about us —

e  Our first and last name.

e  The ‘choose your username’ is the unique email address that we wish to create, which
will be placed before ‘@gmail.com’.

Because it needs to be unique, Google
may have to check the availability of any
name that we decide on to make sure that -
C=OSC YOUr uscrmamse
no one already has it. Type an email name
into the ‘choose your username’ box. | prafar to use my currant amal address
Once we finalize our email address, it’s a Create a password
good idea to make a note of it so that we

can refer to it until we remember it. Confirm your password

e  We’ll need to give a password so that we

. Birthday
can log in securely to our account. We )
should try to set a password with at least
Gender
8 characters long to be secure. Use letters = )
and numbers to make the password more
Mobile phone

secure and difficult to guess. We’ll need -

to re-enter our password in the “Confirm
Your cusrent email address

your password” box to ensure its

accuracy.
Location

e Then fill Birthday (Month, Day, Year), Untted Sextes
Select Gender (Male/Female), Enter
Mobile phone number and any other m

e-mail address (if exist).

Fig. 2.9 opening gmail account
Once we have completed this page fully,

clicking Next Step will take us to the next Page.

GO gle i8f  testuserafh@gmail.com ~

Access apps, check notifications, and edit - ""EI
your account S/

\_A‘_\,r
Welcome, Test

Your new emall address is test.user.afh@gmail.com

Thanks for creating 2 Google Account. Use it to subscribe to channels on YouTube, video chat for free, save
favorite places on Maps, and lots more.

Continue to Gmail

HME O 2> H

Fig 2.10 Continue to Gmail
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We will now have set up our account. Click “Continue to Gmail” to go to our inbox and get

started.

2.6.1.2 Log-in to Gmail account:

Follow these step-by-step instructions to Login a Gmail account

e  Open the internet browser.

e  Type www.gmail.com in the address bar:

e  Type the email or phone in the textbox and Click on Next button as shown in the Fig 2.11

e  Type the password that you choose for your Gmail account in a textbox and the click on

Next button as shown in the Fig 2.12

Google
Signin

Continue to Gmail

[ Email or phone ‘

Forgat email?

Not your computer? Use Guest mode 1o sign in privately.
Learn more

Create account m

Fig 2.11 Login—User ID

2.9.1.3 How to send E-mail?

To send an email, click
“Compose Mail” located above
the folder list. An entry form
appears in the Gmail interface.

Google

Welcome

@ ashisinghal23@gmail.com v

Enter your password =

@ Your password was changed 21 hours ago

Forgot password? m

Fig 2.12 Login—Password

ot vl st TS oyt e e npe g, s
[ N A -

Ty o e T b o st 1 7T S

Emnt v i s

Birasea b hms
Bgomrcepm B B oesaem -

[ o
B, Bt B et

e et e Tobe M b rhec ot ot e W3 e g o S5 £
10 o s & Lt

Mo &

Fig 2.13 Compose Mail
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€« — C M | @ https//mail.google.ccom/mail/u/0/?shva=1#inbox?compose=14208cbbc @ 7| »|

GO 'L)gle “ 2 H ! Share

Gmail - - C More ~ 1-3 0of 3 < > to B
Il nbox(3) email@gmail.com Et9

Starred

Important 0GB (0%) ¢ Suybject
Sent Mail AN e

Drafts (2) TEXT HERE]|
» Categories

» Circles

wikiHow
More ~

Fig 2.14 Send Mail
The Recipients:

e In the “To:” box, type the address of the person we want to write an email to. For
multiple recipients, separate the addresses with commas.

e  Ccmeans “carbon copy”. To add/view the “Ce:” recipients, click on Cc option and type
the addresses of people who are not the main recipients of the message, but we still want to
send a copy to.

e  Bcc stands for “Blind Carbon Copy”. To add/view the “Bee:” recipients, click on Bee
option and type the addresses of people we want to send a copy of the mail to, without
knowing other recipients.

The Subject:
e In “Subject:”, enter the subject of the email.
Body Contents of Gmail:

e  Type the message in the window shown below the Subject field. By default, Gmail
will send a message in HTML format. When we finish typing our mail, click the
“Send” button to send it immediately or we can save it as a draft.

Attach file(s) with email message:

e Inthe new message window, click the paper-clip icon to add an attachment. From the
Open dialog box, select the files we wish to attach, then click “Open”.We can see the
list of attachment added to our message in the message window.
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Fig 2.15 Window to Upload an Attachment
2.6.1.4 How to Read E-mail?

All received emails are stored in the inbox. The number of unread messages is indicated to the right of
the “Inbox” folder. Gmail automatically checks if new messages arrived. To read any email, just click on
the email that appears at the right side of the Gmail Interface

By default, a single message is summed up in one line:
e  Dispatcher
e  Subject
e The first words of the message

e  Dispatch/Receiving date (or time)

a v T N0 :
[ Rescing bt

Other bosiomats

Onlie business losns sbmplified - - amincbac crputer 1) Your e nesnage grie ried o

Btaes bom nas

M ng<oneceom. BN imeckgnons1E B s tiae Baniem -

LN

P Fak

Wattred atiut healn?

TE ened actmpcter t ol com erieas

286

Your e-mesange geeesated o6 20210211 163804 Yo

B saoviome [ WENNGER

ek g o

s S Morztey, Fezncery 1. 2022 13167 PM T newacoh o=

corer page T amd 81 - Remak Peciadd

Chech Here - (LEFSP), Lucinow o UP Pollc

B ocral Pumas. [ Pocheh Pamiste.

Apply far Businesy Loan for up 18 Ry Crare. - vansmb scompinnr |1 155 8-mensage genermea on 3
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Fig 2.16 Reading

e 13 Yous
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2.6.2 Google Calendar:

Google Calendar is a time-management web application and mobile app created by Google. Users are
required to have a Google Account in order to use this app. Google Calendar allows multiple calendars to
be created.Each calendar can be shared, either read-only or with full edit control, and either with specific
people or with everyone (public calendars). Google Calendar allows users to create and edit events.
Events can have a start time and stop time, with an option for an “All-day event”. Reminders can be
enabled for events, with options available for type and time.

= [ Calendar wasy | ¢ > February2022 QA @ @ wx-| &
+o--) 20 (21] 22 23 24 2 26
a2 oo [
2@ o= ou s
& saarch for people 1
My calendars PN 5o
| vanshiks Computer o
Birthdays
5 Reminders 7
] Tasks o |
Other calendars + A -
Holboays in Inaia
Fig 2.17 Google Calendar
2.6.3 Google Maps:

Google Maps is a web mapping service developed by Google. It offers satellite imagery,
street maps, 360° panoramic views of streets (Street View), real-time traffic conditions
(GoogleTraffic), and route planning for traveling by foot, car, two-wheeler, or public

transportation. Google Maps for Android and iOS devices Google Maps
€ 3 C B geoglecsi 1208477 7558588821 Bd On0
G Google ) AddomsStore ) Gening Started Firefox Boskmaris Other bookmarcs | ] Resding list
e a0 GUUOWAra SN0 B r——
o Sk Goocke Mici Q| § | o | M Restaurants | @ Tokaout | pm Hotels | @ Gas | Bl Pharmacies & coffen m=n° 3 e@”
T momennas TR R e e =
WrEaH B3 6 'mm 9 Rors Dhibocafor dalaider et 9
v wxeulnndnm MO \)
Aggarwal (fer & SHAKT| NAGAR o} oot Police Chowk
9 Qcm supersnmalny Lo b= » 0 @ P Tack e B \
P
; Food Bazar JCResort
qt SO 4 e TR T Sl
i) s B PHASE2
® % H 4 Qammv .:..Tf': i avs feoa
"
Sl a ospt\a? Patel Hospital #m2 SubPostoff
i 0 e e
f £ The Regent Park -"' Sy, ama
egent Par . Brahmi Giand Baba ~
Office of The Deput
! u-a!.’:ﬂ'(° é‘v Studio ¥ . cmumsslumw X 5“‘1""‘*5""‘""’” 0 "'9
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Gurdwara Dera n 2 L. Y N
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Fig 2.18 Google Maps
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was released in September 2008 having features GPS, turn-by-turn navigation along with dedicated
parking assistance.

2.6.4 Google Translate:

Google Translate is a multilingual neural machine translation service developed by Google, to translate
text, documents and websites from one language into another. Google Translate is a free service that
translates words, phrases, and web pages between English and over 100 other languages.

| Gorge :

Transiate 6 B
_Vtunum-a--w- ‘.‘.num_m-n

1 mynama s vann | am shudng i govt sehod X | 3y v d Amnrd m ke vl et d x|
dom-

Yar cotrinton wl b mad 1o mpres sl Bon gaity and may 2 1howt D e sroeyToYy

= -

Fig 2.19 Google Translate
2.6.5 Google Docs

Google Docs is an online word processor that allows us to create and format text documents online.
Using google docs, we can collaborate also with other people in real time. Google Docs
allows us to create and edit text documents right in our web browser, no special software
is required. Even better, multiple people can work at the same time and we can see
people’s changes as they make them, and every change is saved automatically.

ik o 10 create » rew document,

Fig 2.20 Google Docs
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2.6.6 Google Sheets

Google Sheets is a web-based online spreadsheet application that enables the users
to create, update and modify spreadsheets and share the data online in real time.
Google Sheets allows us to format spreadsheets online and simultaneously work
with other people.

2.6.7 Google Slides

Google Slides is an online presentation app that allows us to show off our ideas in a
visual way. Google Slides allows us to easily collaborate and share presentations
with text, photos, audio, or video files. It can be accessed in a web browser from
any device with an internet connection.

2.6.8 Google Form

Google Forms is free online software that allows us to create surveys, quizzes. The
collected information through these forms can be automatically entered into a
spreadsheet.

2.6.9 Google Sites

Google Sites allows us to create a website without having to know how to code it
our self. The great thing about Google Sites is that we get to choose who can and
can’t access our site. So, whether we want external visitors to be able to visit our
site or we want to give collaborative editing privileges to certain users, we can easily
do that with just a few clicks using Google Sites.

2.6.10 Google Photos

Google Photos is a photo sharing and storage service developed by Google.
It was announced in May 20135. It works for both Android and 10S devices,
and provides an automatic backup for our media. It organizes pictures and
videos automatically and provides also the feature of sharing media with

- B

others. Google Photos
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2.6.11 Google Lens

Google Lens is an Al-powered technology that uses your smartphone camera
and deep machine learning to not only detect an object in front of the camera
lens, but understand it too. It can perform various actions such as scanning,

translation, shopping, and more. Google Lens offers the following features:

e Google Lens facilitates to translate text by pointing our phone at

text. This can also work offline.

‘o

e Itallows Smart Text Selection as we can point our phone’s camera at text, then highlight

that text within Google Lens, and copy it to use in our phone.

e Itallows Smart Text search as when we highlight text in Google Lens, we can also search

that text with Google. This is handy if we need to look up a definition of word, for instance.

e It works for just about any item we can think of, accessing shopping or reviews.

e Google Lens allows us to just scan the questions and come up with answers.

e Google Lens facilitates to detect and identify our surroundings.

2.6.12 Google Meet:

Google Meet is a video conferencing service from Google. It’s a great solution
for both individuals and businesses to have meetings through audio and video
calls. Google Meet is available on the web, phones and tablets for Android
and i0S. Google Meet is a handy app to conduct online school classes.

2.6.13 Google Play Store:

Google Play Store is Google’s online store for use on Android-powered
smartphones, tablets, Google TV and similar devices. We can use it to
purchase and download apps, music, books, movies and similar contents.
The Google Play store, which comes pre-installed on Android devices,
allows users to purchase, download and install applications from Google
and third-party developers.

2.6.14 Google Drive

Google Drive is a service offered by Google that allows us to store and
share files online. The service was launched on April 24, 2012 and provides
15 GB of free storage. Additional storage can be purchased for a monthly
fee.

»
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2.6.14.1 Benefits of Google Drive

Google Drive allows us to send large files to our colleagues, clients and friends directly
from our Gmail account.

Google Drive allows us to access our files remotely. With Drive, all our files become available
on the web.

Google Drive has its own mobile application which gives us access to our files on our
iPhone or smartphone, no matter where we are.

Google Drive has an efficient built-in search engine which allows us to find content easily
with a keyword. We can also look for files by owner or by file type.

Google Drive is equipped with an OCR (optical character recognition) function, which
allows us to search for words or expressions in scanned documents. For example,
finding someone’s name in an old newspaper article that was scanned and saved on
Google Drive is possible.

Google Drive allows users to open various types of files, like.ai (Adobe Illustrator)
and even .psd (Photoshop) files.

2.6.14.2 How to share file(s) from google drive?

1. Open your Google Drive
2. From the list of files and folders shown on the Google Drive, Select the name of a file
or folder that we want to share and click the share icon at the top.
L Drive Q I = @ @
'_ — Shared with me | @
v [B myDrive i 1

@© necent
¥y Starred B Punjabi last file. pmd
Shared in the past week by GS Graphics
[  Trash
&5, o Name Shared by Share date L3
—
8.79 GB of 15 GB used pastmesk
R avtves B Punjabi last filepmd 2% o# GS Graphics Feb 19, 2022
Earlier this month
Bl satyameva dayate 2 (2021) 15878.mkv 2% @ rupinder kaw Feb 8, 2022
_ Older o
3. Under “People and groups” in the sharing box, type the email addresses of the people

or Google Groups that we want to share with. We can also search for contacts by
typing them into the box.
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e Share with people and groups {3

Add people and groups

Abc User (you)
abc@gmail.com

Send feedback to Google

© cetlink

Restricted Only people added can open with this link )
. . Copy link
Change to anyone with the link J

L

4. Choose the type of access we want to provide for these users by clicking the dropdown
arrow to the right of the text box:

e Share with people and groups

(0] X

Notify people

Viewer

Message
9 Commenter

+ [Editor

B How to Share a Google Doc

Send feedback to Google Cancel

Fig 2.21 Share File — Access Levels

° Editor: Users can edit the file or folder and share it with others
° Commenter: Users can view and add comments to the file, but can’t edit the file.
° Viewer: Users can see the file or folder but can’t edit or comment on it

5. After setting the access level, click on Send button. The users will receive an email letting
them know we’ve shared the file or folder with them.

6. If we want to share multiple files at once, add the files to a folder in Drive and then share the
entire folder with the people we want to share the files.
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2.7 DIGILOCKER

DigilLocker is an Indian digitization online service provided by the Ministry
of Electronics and Information Technology (MeitY ), Government of India ‘
under its Digital India initiative. DigilLocker provides an account in cloud
to every Aadhaar holder to access authentic documents/certificates such
as driving license, vehicle registration, academic mark sheet in digital format
from the original issuers of these certificates. It also provides 1GB storage

space to each account to upload scanned copies of legacy documents.

DigiLock
In the current scenario, the various Education Board including Punjab Igl 0 c e_r
Your documenls anytime, anywhere

School Education Board also facilitates students to download their
certificates of Class X and XII from DigiLocker and share them with Fig 2.22
agencies as required.

2.7.1 Objectives of Digital Locker

The key objectives with which the Digil.ocker was introduced by the Government of India are as
follows:

e  ToEnable digital empowerment among the citizens of the country.

e Tominimize the physical usage of documents and enable the feature of e-signing by making
documents available electronically.

e Digilocker will increase the authenticity of documents by online upload and reduce the
existence of fake documents.

e  Web portals and mobile applications shall be made available for easy access.
e  Reduce the administrative overhead of Government departments and agencies.

e  With the availability of documents online on the cloud, residents can easily access the
documents anytime and anywhere.

e Facilitates sharing of documents easily.

e  Ensure privacy and authorized access to user’s data.

2.8 INTERNET THREATS & SECURITY

An Internet threat is any threat that uses the World Wide Web to facilitate cybercrime. Internet
threats are also known as Web threats. These threats use multiple types of malware and frauds.
Sources of these threats can be links sent by an email or malware attachments etc. Cyber criminals
steal information for subsequent sale.
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2.8.1 Internet Threats:

The Internet is indeed private and secure, but there are a number
of serious security risks. Some of the common internet threats are

as follows:

36 B

Virus: VIRUS stands for Vital Information Resources
Under Siege. A computer virus is acomputer program

that cause damage to a computer software, hardware . .
) ) . Fig 2.23 Virus

or data. It can also replicate itself into other computer

programs. Once a virus is present on a computer, it typically performs some type of

harmful action, such as corrupting data or
files.

Spyware: Spyware is a malicious program
designed to enter our device. It collects the
data and forward it to a third party without
our consent. Once the spyware program is
installed, it starts collecting information
without our knowledge.

Some spyware programs are relatively
harmless and collect very generic
information that does not personally identify Fig 2.24 Spyware

us. Other harmful spyware programs may record our actual keystrokes, including passwords.
Such spywares may search through any of our files looking for something that looks like a
credit card number etc. These types of spyware programs can definitely be harmful.

Spyware often enters our system when we install some type of free software from an
untrusted source. Since we authorized the installation, conventional protection methods,
such as antivirus software, do not
prevent spyware from getting installed

in this manner.

| Destry | | Change? | | Transmit |

Trojan horse: A Trojan horse, often
shortened to Trojan, is a type of
malware designed to provide
unauthorized, remote access to a user’s
computer.

Trojan horses do not have the ability to
replicate themselves like viruses;
however, they can lead to viruses being Fig 2.25 Trojan horse
installed on a machine since they allow
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the computer to be controlled by the Trojan creator. The term gets its name from the Greek
story of the Trojan War, when the Greeks offered the Trojans a peace offering in the form
of a large wooden horse. However, once the Trojans wheeled the horse behind their closed
gates and night fell, the soldiers hidden

inside the horse climbed outand opened  gumesmssemr eI
. . 1001101001 8@ eeiePei101001011
the Clty gates’ allOWIHg the Greek anny to 1ea ‘{‘ 191002010610 201 ‘(‘ 1! @161 ;.‘ ae10
. . e1epPp01000200101 1 ie11901001100111
infiltrate Troy and capture the city. 0100 01010
1001 20101
Trojan horse software operates the same =« =
. . 1010 Login

way, where Trojan is our computerand =~ = * wennnn
i ks Password

the horse is the malware application. s il wrnnent
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Phishing Scams: Phishingisane-maill = = = °

100

fraud method in which the wrongdoer '
send legitimate-looking email in an attempt

to gather personal and financial
information. Fig 2.26 Phishing Scam

These messages appear to come from well-known and trustworthy Web sites. The message
tricks people into providing sensitive information, such as their login details. A typical scam
consists of a message that describes some issue with our account and requires us to login to
our account to confirm something. The message looks very official, using logos and formal
language, just like we would expect from a genuine source. When we follow the link, the
webpage looks very real - but if we look closely, the Internet address is actually not the
official one. Financial institutions don’t send out these types of messages.

2.8.2 Internet Security:

By the mean of Internet Security, we refer to the software or preventive measures which are used to

protect our computer from the internet threats like malicious activities. Some of the common tools and

techniques used for this purpose are given below:

Anti-virus: The best way to deal with the internet threats such as a computer virus is to use
antivirus software. Antivirus software helps to protect a computer system from viruses and
other harmful programs. One of the most common ways to get a virus on our computer is to
download a file from the Internet that is infected. Antivirus software scans our online activity
to make sure we are not downloading infected files. Antivirus software also helps to detect
and remove viruses from our computer system if we do get infected. Some of the commonly
used antivirus are Norton, Kaspersky, Avira, Avast, Mcafee etc.

Anti-Spyware: Anti-spyware is a type of software that is effective to detect and remove
unwanted spyware programs. Removing spyware can be difficult as often the program
installs itself again as quickly as we delete it. To counter spyware, we need to use a
dedicated spyware management tool. Some antivirus softwares are bundled with the
spyware management tools.
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e Prevention from Trojan Horse: To keep our system safe from Trojan horses, we should
never download or install software from a source we don’t trust upon. Never open an
attachment or run a program received via email from unknown or untrusted sources. Make
sure a Trojan antivirus is installed on our computer and having a valid license.

e  Prevention from Phishing Scam: In order to protect yourself from these Phishing Scams,
don’t follow the link and login only from the official website.

2.9 CYBER CRIME & CYBER ETHICS
2.9.1 Cyber Crime:

Cybercrime is a crime that involves a computer
and a network. The computer may have been
used to commit the crime and in many cases, it
is also the target. Cybercrime may threaten a
person or anation’s security and financial health.
Cyber Crime is an unlawful act wherein the
computer is either a tool or a target or both.
Cyber Crimes can involve criminal activities that
are traditional in nature, such as theft, fraud,
forgery, defamation and mischief.

Any offenses committed against individuals or

Fig 2.27 Cybercrime

groups of individuals to harm the reputation or
cause physical or mental trauma through electronic means can be defined as Cybercrime. Electronic
means can include but are not limited to, the use of modern telecommunication networks such as the
Internet (networks including chat rooms, emails, notice boards and groups) and mobile phones (Bluetooth/
SMS/MMS).

We can categorize Cyber Crimes in two ways:

e  Computer as a Target: Using acomputer to attack other computers. For Example: Hacking,
Virus/Worm attacks, DOS attack etc.

e  Computer as a Weapon: Using a computer to commit real world crimes. For Example:
Cyber Terrorism, IPR violations, Credit card frauds, EFT frauds etc.

2.9.1.1 Preventive measures against Cyber Crime:

Anyone using the internet should exercise some basic preventive measures. Here are some measures
you can take to protect yourself against the range of cybercrimes.

1. Theuser must use a full-service internet security suite.

2. Theuser must use strong passwords for various online websites.
3. Keep your software updated.
4

Keep your personal and private information locked down.
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It’s a good idea to start with a strong encryption password as well as a virtual private

network.
6. You can teach your kids about acceptable use of the internet without shutting down
communication channels.
7. Keep yourself up to date on major security breaches.
8. Take measures to protect yourself against identity theft:
9. Ifyou believe that you’ve become a victim of a cybercrime, you need to alert the local police.
2.9.2 Cyber Ethics

Cyber Ethics is the conduct of acceptable usage of online resources by a user. Cyber ethics refers to

the code of responsible behaviour on the internet. It is to be ensured that users understand their
responsibilities for conducting themselves online.

2.9.2.1 Principles of Cyber Ethics:

Don’ts:
[ ]

Do’s:
[ ]

Do not use a computer to cause harm to other people.

Do not interfere with other people’s computer work.

Do not snoop around in other people’s computer files.

Do not use a computer to steal unauthorized information.

Do not copy or use proprietary software for which you have not paid.

Do not use other people’s computer resources without proper authorization.

Do think about the social consequences of the act that you are doing online.

Do always use a computer in ways that ensure respect for your fellow humans.

POINTS TO REMEMBER

1.

E-mail allows us to send and receive messages to and from anyone with an email
address, anywhere in the world.

A CAPTCHA is a type of test used in computing to determine whether or not the
user is human.

All emails received are stored in the inbox.

Google Apps is a suite of Web-based applications from Google that includes e-mail,
calendar, word processing, spreadsheet and presentations.

Cloud networking refers to manipulating, configuring, and accessing the hardware
and software resources remotely.
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10.
I1.

Cloud Printing enables users to print documents and other materials remotely on any
device associated with the cloud (network).

The Internet is indeed private and secure, but there are a number of serious security risks.

Phishing is an e-mail fraud method in which the wrongdoer sends out legitimate-looking
email in an attempt to gather personal and financial information from recipients.

Cyber Ethics refers to the code of responsible behaviour on the internet.
Cyber Crime uses a computer as a Target or/and a computer as a Weapon.

Google Drive is a service offered by Google that allows us to store and share files online
with multiple users.

EXERCISE

Que:1 Multiple Choice Questions

I
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‘Gmail’ is a free email service provided by

A. Yahoo B. Google

C. Rediff mail D. Hotmail

A is a type of test used in computing to determine whether or not the user is
human.

A.CAPTCHA B. DERTSA

C.HEPTCHA D.NEPHCA

is a type of malware designed to provide unauthorized, remote access to a user’s

computer.
A. Spyware B. Trojan
C. Malware D. Horse

is a computer program that replicates itself into other computer programs.
A. Spyware B. Virus

C. Phishing D. Malware
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A" is an Indian digitization online service provided by the Ministry of Electronics and
Information Technology (MeitY), Government of India under its Digital India initiative.

A. DigilLocker B. DigiProgram
C. DigiHacker D. DigiBanker
Que:2 Write True/False

I Spyware is an e-mail fraud method in which the wrongdoer sends out legitimate-looking
email in an attempt to gather personal and financial information from recipients.

I Google Drive does not allow us to store and share files online.

III The best way to deal with the threat of a computer virus is to use antivirus software.

IV The Web threat is any threat that uses the World Wide Web to facilitate cybercrime.

V  Google Meet is a video conferencing service by Google.
Que:3 Short Questions Answer
Define E-mail.
Give the names of any four Google apps?
Define Cyber Ethics?
Whatis Digilocker?
V  Whatis Cloud printing?

=8 F "

Que:4 Long Questions Answers?

I Whatare Google Apps? Explain any two Google Apps.

I Whatis Google Drive? Write various benefits of Google Drive.

I Write about various methods of Internet Security.

IV Whatis Cyber Crime? Write various preventive measures against Cyber Crimes.
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| Lab Activity |

Give the name of different apps whose icons are shown below:

0
pat

L.

r
>
L
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MICROSOFT EXCEL (PART-1)

,_( Objective of this Chapter: ]

3.1  Introduction of MS Excel

3.2 Common uses of MS Excel

3.3  How to Start MS Excel

3.4  Components of MS Excel Window

3.5 MS Excel Terminology

3.6  Working with Data in Excel Worksheets

3.7  Operations on Workbooks and Worksheets

INTRODUCTION

We have studied Word processor program in our previous classes. As we know, Word Processor are
used to prepare and print Applications, Letters or other Text based written documents. For the best
use of word processor in different fields, there are a lot of tools and automations available.

Other than these types of documents, if we are going to prepare our school result, annual report of a
company, invoice for any sale counter or any other these type of data related documents where more
emphasis is given to correct and effective computation rather than just style,we use spreadsheet packages.
The working area in these types of packages is divided into rows and columns. Spreadsheets are used
for monitoring and analyzing the data, and present the data in pictorial form by using charts. Let’s learn
about one of this type of spreadsheet package known as “MS Excel”.

3.1 INTRODUCTION OF MS EXCEL

Microsoft Excel is a spreadsheet program used for organizing and calculating numerical data. We can
use it to organize our data into rows and columns and to perform mathematical calculations. We can
easily represent our data in such a form which is needed for better representation. We can have a lot of
automatic calculations in excel. We can format our data in any style and layout to meet our all
requirements. Excel can also produce a range of charts and graphs that can be used to present the data
in a graphical manner. We can explain some of the best features of MS Excel as follows.
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Easy Data
Analysis

Data -
Protection Conditional
and Formating
Organisation

Key Features
of
MS EXCEL

Application Data
of Formulas Validation

Easy Store
and Find
Data

Fig 3.1 Features of MS Excel

3.1.1 Features of MS Excel

Microsoft Excel spreadsheet package provides some of the features as described below:

Easy Data Analysis: MS Excel provides very advanced tools like Sorting, Filtering, Charts,
Pivot Tables, Goal Seek etc. which helps in analyzing the data very effectively.

Conditional Formatting: We can format our data based on different rules and conditions.
It helps in highlighting the facts from data or information.

Data Validations: This feature enables us to validate data based on certain criteria while
entering.

Easy to Store and Find Data:There is no limit to the amount of information that can be
saved in a spreadsheet. If the information is stored in any of the word processor or text file,
finding any particular piece of data may take more time. However, this is not the case with
excel spreadsheets. Finding data is easy.

Application of Formulas: Performing calculations in MS Excel are easier and less time-
consuming by using different formulas.

Data Protection: Sheets of MS Excel can be protected using passwords for different
access.

Organized Data: It is convenient to store our different data in multiple worksheets
which can be added in a single MS Excel workbook.

3.2 COMMON USES OF MS EXCEL
Following are the some common uses of MS Excel:

1) Excel can be used for mathematical calculations.

2) In Excel, data can be represented in a graphical format with the use of Charts.
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3)  We can also prepare school Timetable.
4) Salaries of employees can be calculated.
5) Results of students can also be prepared in Excel.

3.3HOW TO START MS EXCEL

To open MS Excel easily, one of the following methods can be used :—

e  Start :E - All Programs - Microsoft Office > Microsoft Office Excel 2010

OR

e Type “Excel” in search bar. Excel program will appear in the start menu. Press enter button
after selecting EXCEL program. We can directly click on Excel program also from the
program menu to open it.

3.4 COMPONENTS OF MS EXCEL WINDOW

The following figure shows the various components of MS Excel Window:
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St 5 ) € —

Br g

: o | v s |9 Comgtunsl Pormst el | Waed Deiete Fon son s Pesd
BA- EESN EB® @uepad 4 a g e e Tl b Cos™  poer= Suct®

ﬁ l]?&

'
L
'. : g =
x i " N o [ Q [ [ U =l
Furmula Bar

Active Cell

Spreadsheet Area
a1

Scroll Bar
@ @
,
Shewt] ~Taet2 Pty %3 1)

T RS

Fig 3.2 Different Components of MS Excel Window
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Let’s understand each part:
1. Quick Access Toolbar:

EE9- " I’

We shall see this toolbar on the left-upper corner of the screen. Its purpose is to display the most
frequently used commands of the Excel. We can customize this toolbar based on our choice.
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2.Title Bar:

The header or title bar of the spreadsheet located at the top of the window. Almost all the applications
are having this part as an interface. It presents the name of the active filename and Program name itself.

3.Control buttons:

These buttons are present in the upper-right of the window that allows us to modify the minimize,
maximize/Restore and close the workbook.

4.File Tab:

—

This tab of MS Excel represents a menu which is used to perform file related operation. Some of
the basic operations present in this menu are to create new excel documents, open an existing
file, save, save as, export, print file, etc.

5 Tabs:
- T T T — " -
Home | Insert  Pagelayout  Formulas Data Review  View

Under the title bar of MS Excel, the name appeared for each related tab. These tabs are called
Menu bar, and consist of a File, Home, Insert, Page Layout, Formulas, Data, Review, View,
Help, and a Search Bar with a light bulb icon. These menus have sub categories that simplify the
distribution of tools and commands used for different purposes.

6.Ribbon/Toolbar:
E ;:‘w' Calibri LR Wy -'@ ?" P wrap Text General ¥ ﬁ ¥ g E- ? @ ;:::fsw- %-Lr ﬁ
Rt Frommpung | B 2 BB | 2L BT | R E Buupeacmn-| G- % 7 || Cncony ol ok | ot e font | aare o

Clipboard . Font Ta Alignment o Number i Styles | Cells Editing
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There are series of elements those are part of each menu bar. On the selection of any Menu/Tab, a
series of command options/icons will be displayed on a ribbon. For example, if we press the “Home”
tab, we will see cut, copy, paste, bold, italic, underline etc. commands. Toolbar/Ribbon is a group of
organized commands in three sections.

*  Tabs:These are the top section of the Ribbon and contain groups of related commands.
Home, Insert, Page Layout, Formula, Data etc. are the examples of tabs.

*  Groups:These organize related commands; the name of each group appears below the
Ribbon. For example, a group of commands related to fonts or group of commands related
to alignment, etc.

e Commands:These appear within each group as mentioned above.

7. Dialog Box Launcher:

=0 X Cut
—— (53 Copy ~
Paste
»  <J Format Painter
Clipboard

This is a very small arrow located in the lower-right corner of a command group on the Ribbon. By
clicking this arrow, we can open related dialogue box to perform advanced operations.

"3 v (

8. Name box:

This is a first part of formula bar which shows the address of active cell, row or column. We can also
make any selection using this part of MS Excel.

9. Formula bar:

ETS ~

This part of MS Excel used to display cell contents or formula written within a cell. We can also
edit the contents of an existing cell using this bar. This bar is an area just below the ribbon area.

10. Scrollbars:

'« m | S

These are the slider appeared on right and bottom side of our spreadsheet. It allows us to slide
both the vertical and horizontal view of the spreadsheet. We can use the mouse wheel to
automatically scroll up or down or use the arrow keys for this purpose.

MICROSOFT EXCEL (PART-1) B 47




11. Spreadsheet Area:

e —
( Spreadsheet Area )
[ s ) /

It is the working area where we enter our data. It constitutes the entire spreadsheet with its rows,

columns and cells. Each spreadsheet area having column header is known as Column Bar and display
at top and row header at left side of the screen known as Row Bar. Columns are represented using
Alphabets like A,AB,BCC etc. and rows on the other hand are represented by numbers starting from
1. The active cell is represented using a bold rectangular area in the spreadsheet and the blinking
vertical bar called “cursor” is the insertion point. It indicates the insertion location of the typing.

12.Leaf Bar:

4> M h v

This part of the MS Excel screen is used to display sheet name. It appears at the bottom of the
working area. We can have multiple worksheets in one MS Excel file known as workbook. This
sheet bar explains the spreadsheet that is currently being used. We can alter several sheets at our
convenience or add a new one using this part of MS Excel.

13.Status Bar:

Ready | |

also displays other very important information related to our spreadsheet. This area of MS Excel
screen also shows the information if anything goes wrong, or the document is ready to be delivered
or printed. Status bar displays quick calculation of the selected digits, like sum, average, count,
maximum, minimum and etc. as per our settings. We can configure the status bar by right-
clicking on it. We can insert or remove any command from the provided list.

14.View Buttons:

Page Break View

Page Layout View
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Itis a group of three buttons arranged at the left of the Zoom control and close to the right-bottom of
the screen. We can see three different types of MS Excel sheet views with the help of these buttons. All
these views of MS Excel are as under:

*  Normal View:This displays the Excel page in normal view.

»  Page Layout View:This displays the exact view of MS Excel sheets as these are going to

be printed.
e Page Break View:This shows page break preview before printing to adjust page layout
easily.
15.Zoom Control:

100% (=) 0 )

Zoom control is located at the lower-right area of the window. It allows us to ZOOM-IN or ZOOM-
OUT a particular area of the spreadsheet. It is represented by magnifying icons with the symbols of

maximizing (+) or minimizing (-) which allows you to manipulate them by clicking on any of these icons.
In the recent version of Microsoft Excel 2010, it allows us to zoom out by 10% and zoom up to 500%.

16. Active Cell:

An Active Cell is a cell of spreadsheet in which we are currently working. The active cell is always
represented by a bold rectangular box.

3.5MS EXCEL TERMINOLOGY
Following are the terms commonly used in Excel:
1. Workbook:

A workbook is a collection of the worksheets. By default, each workbook contains three worksheets.
We can add hundreds of worksheets in a single workbook.

2. Worksheet:

Worksheet is one spreadsheet of MS Excel which contains columns and rows. We can insert worksheets
in workbook by pressing the button “Insert New Worksheet” from leaf bar.

3. Row:
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A row is a collection of all adjacent cells which are referenced by one single row number. When we

click on any row header, all the cells which belongs to that particular row are get selected and one big

rectangular area got highlighted. Whole collection of these cells is called row. Rows are named as

1,2,34,...... . SO on
4. Column:

A column is a collection of all adjacent cells which are referenced

by one single column name. When we click on any column header,

all the cells which belongs to that particular column gets selected
and one big rectangular area got highlighted. A column is used to
represent a particular field of data. Whole collection of these cells
is called column. Columns are named as A,B,C,D...... LAALAB,,.

o~ e e e

. SO On.

= |8

Column
%)
p

5. Cell:

A cell is a smallest rectangular part of our spreadsheet in
which our data is entered. A cell is an intersection of arow |

and a column. Each cell is identified by a cell address.

)

6. Active Cell:

This is a cell of spreadsheet in which we are currently working. A bold
rectangular box around the cell identifies an active cell. Contents of active
cell are always displayed in formula bar and the address of active cell is
always displayed in Name box.

7. Cell Address:

Every cell in Excel worksheet has a unique address. A cell address has
a column letter followed by a row number. For example, Al is the
intersection of the column A and row 1. The combination of a column
coordinate and a row coordinate make up a cell address.

Comparison between Worksheet and Workbook:
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As we have studied both these terms of MS Excel. Let’s see how worksheet is different from Workbook.
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Worksheet Workbooks

1. Worksheet refers to a spread-sheet of MS | 1. Workbook is a File created in MS Excel
Excel which consists of Rows and which may consist of number of
Columns. Worksheets.

2. There can be many worksheets in one | 2. No workbook can exist within a
workbook of MS Excel worksheet as worksheet is a part of
workbook.

3 No worksheet can be saved without 3. Workbooks are saved individually with

workbook. the extension .xIsx

4. Workbooks are used to have different
type of data to be stored in different

4. Worksheets are used to have our data of

one type in the form of spread-sheet.
sheets as a one file.

3.6 WORKING WITH DATA IN EXCEL-SHEETS

As we have studied the basic functions of worksheet of MS Excel. It allows a series of functions to be
performed in a worksheet. Let’s understand these functions as a graphical presentation as under:

3.6.1 Basic functioning in Worksheet:

Following figure shows the basic functions on Data that can be performed in the Excel Worksheet:

Entering Data Editing Data

Selecting Data Deleting Data

Fig 3.3 Basic functions in Worksheet

e Entering Data:We can enter data in any of our cell of worksheet. For entering new data in
acell, firstly place the cursor in the cell in which we want to enter data. Type the required
data to be entered into our cell. We can press enter key to complete the entry of data into
one cell and moving to next cell of same column. We can use tab key also to complete the
entry of data and move to the next cell in the same row. We can press Alt + Enter key if we
want to change line within cell itself and keep entering the data. If we need to delete data
during the data entry, then we can use delete or backspace keys accordingly. To change the
active cell position arrow keys are used. However, we can use arrow key in edit mode of a
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cell which got active by pressing F2 key. Data entry within a cell may contain two types of
data:

»  Entering Formula or Function: As we already know, Excel is used for mathematical
calculations using Formula or Functions. We can enter any formula just followed by
equal (=) sign. For Example: =A1+B1

»  Entering Contents other than formula or function: We can also store our contents
to describe our data or facts. We can enter any type of a data without using any sign
before contents. For Example: “Computer”.

Editing a Cell Data:When we enter data into a cell, it may be needed to change already
entered data. We can edit the data by pressing F2 after selecting that particular cell or just
double click within the cell. We can also edit the contents of cell by using the Formula bar.

Deleting Data:We can delete the contents of a cell. To delete the entire contents of one or
more cells, we can just press delete button from the keyboard after selecting the particular
cells. In the case when partial contents of a cell are required to be deleted then we can use
F2 key or double click of mouse on the cell and the cell will be converted into edit mode.
We can use arrow keys in edit mode of cell and use delete or backspace key to delete the
required contents.

Selecting Cells:When we wish to perform any function or format on a group of cells, we
must first select those cells by highlighting them. We can use Mouse for selecting the cells.
We can also use shift and arrow keys in combination for the same purpose.

3.6.2 Entering Same Data in a Row or Column:

We can enter the contents of one cell to other adjacent cells in either row or column using several ways.

Some of the ways are as under:

I. Using Fill Command: We can enter same contents in multiple cells using fill command as:

1.
2.
3.

52 B

Select the cell whose contents are to be copied along with the blank cells.
Goto to Home—> Edit Group—> Fill option:

There are a lot of options available for this purpose like DOWN, RIGHT, UP, LEFT,
SERIES etc.

Select our required option. For example, if same contents are to be copied into a
column downward then select DOWN option.
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Fig 3.4 Entering same data to multiple Cells using Fill Tool

Our contents would be copied in all the selected cells.We can also use the following Shortcut keys for
this purpose:

> Fill Down : Ctrl+D
> Fill Right : Ctrl+R

I1. Using Copy and Paste:We can copy the contents of one cell to other cells using copy and paste
option also. We can use this command as follows:

1. Select the cell or cells having the contents to be copied.

2. Select “COPY” option from Clipboard group of HOME Tab. We can also use shortcut
key. i.e. Ctrl + C.

3. Select the cells in which the contents are to be copied.

4. Now, select “PASTE” option from Clipboard group of HOME Tab. We can also use
shortcut key. i.e. Ctrl + V.

AN ATy A__A | AN
I 1 [Computer] 1 [Computer 1 [computer,
2} 2 | 2 2 |Computer
L mE e
4| 4 | 4 4 |Computer
5 S | 5 5 |Computer
6 6 6 6
71 7! 2.1 7.

Fig 3.5 Entering same data to multiple Cells using Copy and Paste Option

Note: We can also use Paste Special option for more advance options. We shall discuss
these options in next chapter.

II1. Using Fill Handle: This option of MS Excel is used for several operations. We can copy
same contents in multiple cells as under:

1. Enter our contents in a cell to be copied into multiple cells.

2. Select the cells where contents are entered.

MICROSOFT EXCEL (PART-1) B 53




3. Now hold the fill handle of the selection and drag the mouse in required direction. i.e.
Column or Row.

4. Qur selected contents would be copied into all the cells as we drag.
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Fig 3.6 Entering same data to multiple Cells using Fill Handle

Note: If our entered data represents a series item already saved in MS Excel then the fill handle
option will automatically enter the series. In such a case if still same contents are required to be
copied then we must enter the same content in at least two cells and fill handle is to be used after

selecting both or all these cells.

3.6.3 Working with Series in Excel Worksheets:

Series is a collection of data represented by a specific category, pattern or formula. MS Excel provides
a wide variety of series of data to be entered into cells, such as Series of Numbers, Name of Month,
and Name of Days Series etc. Let’s understand how to work with such series using Fill Handle option:

I. Series of Month/Day Names:Fill Handle creates the series according to the selected cells. We

can create Month/Day Names series as under:

i.  Enter the series item in the starting cell. Item can be any value of the series. Our series
would start from the given item. For example, if June is entered into a cell then the
series of Month-Names would start from June and move to next month in iterative
manner for as long as we drag it. Similarly, Series of Day-Names would start from
Tuesday if Tuesday is entered into a cell to create the series.

ii. Hold the Fill Handle and drag it in any direction, i.e. Row or Column.

iii. Our particular Series will be filled in the dragged cells. Each item of series will be

entered into a single cell.
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Fig 3.7 Creating Month Name Series using Fill Handle

Note: If our selected cell content does not belong to any of day/month series, the same contents
of the selected cell will be copied as we have studied earlier.

ii. Series of Numbers:We can also create Number Series using Fill Handle option. Number Series
are the series with numerical Growth. We can use following steps for this purpose:

1. Enter our numbers at least in two cells as shown in the following figure.
i.  Selectboth or all the cells.
ii. Hold the fill handle and drag it in any direction. i.e. Row or Column.

iv.  Our particular number series will be entered in dragged cells. The growth of the series will
be calculated by MS Excel itself. For example, if we enter 2 and 4 in two adjacent cells and

use fill handle on these cells then the series would be 2,4,6,8,10. ... .soon.
4 A A A A A A4 A
1 2 1 2 1 2 1 2
2 4 2 4 2 4 2 4
i e
4 - B ' 4 8
5 5 5 \ 5 10
6 6 6 6 12
7 7 1 7 :

Fig 3.8 Creating Number Series using Fill Handle

Note: We must take care of numerical growth for all the items to be generated automatically.
MS Excel only generates Arithmetic growth-based series.

3.7 OPERATIONS ON WORKBOOK AND WORKSHEETS

We have already studied about worksheets and workbooks in previous section of this chapter.
We have also discussed the differences between both these terms. We can perform different
operations on workbooks and worksheets. Let’s study about these operations in detail.
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3.7.1 Operations on Worksheets

As we know, Worksheet is a spreadsheet in MS Excel which can be used to record our data or other
objects. We can perform several operations over the worksheets which are contained within a
workbook. Some of the basic operations to be applied on Worksheets are as given below.

Inserting new Worksheet:

Each worksheet is used to store one type of data. To have Different data to be stored as one file, we
have to insert multiple sheets in MS Excel file which is also known as Workbook. We can insert new
worksheet using “Insert Worksheet” option of Leaf bar shown at Left bottom corner of work Area.

Insert worksheet

M 4 » M| Sheetl /Sheet2 / Sheet3 /%J

Renaming Worksheet:

Renaming operation on worksheet is also required sometimes when we want to represent particular
data among different sheets within a workbook. To rename a worksheet, we can follow some steps:

1. Rightclick on Sheet Leaf which is required to be renamed.
2. Select Rename option from pop-up menu appeared.

3. Type the new name and press Enter to Finish.

s -
15 | Insert... —1%
16 2l _Delete 15
17 [ Rename E
E Move or Copy... 17
. zg G view Code %
E lih Protect Sheet... E
= Bocor Y =

23 Hide e
24 Unhide... o4
25

=
-

lect All Sheets 5 '
> h Shee;; . iﬁeeEZ 7 Sheet3 /Y32 .~ M 4» 'Il New Namel fSheet2 “Sheet3 /¥ ~

Fig 3.9 Renaming an existing worksheet
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Removing Worksheet:

If we have any sheet which is no longer required to be there in a workbook then we can remove the
worksheet. This option can be very useful to have only the meaningful worksheets within a workbook.
We can remove an existing worksheet using following steps:

1. Rightclick on Sheet Leaf which we want to remove.
2. Select Delete option from pop-up menu appeared.

3. Our selected sheet will be removed and respective leaf will no longer available.

- -

7 14

L ln“ﬂ 15

= L Delete 16

1 Rename 17

18 -

M

19 Move or Copy 15

20 Gd  View Code "

21 Eill Protect Sheet... "

22 Tab Color » 2

23 Hide 23

24 =

= 25

- Select All Sheets -
_D"em ) W v || Sheet2 ~Sheets ¥3
Ready | Ready |

Fig 3.10 Removing an existing worksheet

Copying a Worksheet:

Copying a worksheet is a common operation over worksheets when we have to create same
worksheets for number of purposes. We can copy an existing worksheet and can change that
copied sheet as we want. Let’s understand the process of copying a sheet:

1. Right click on sheet leaf which we want to copy.
Select Move or Copy option from pop-up menu appeared.
Move or Copy dialog box will appear.

2

3

4. Click on “Create a copy” option at the lower left corner.

5. Select the location of sheet from Before Sheet list of dialog box.
6

Press “OK” button.
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Fig 3.11 Copying an existing worksheet
3.7.2 Operations on Workbooks

As we know, Workbook is a file created in MS excel. We can perform several operations over the
worksheets contained in a workbook. We can create new workbook. It can be saved permanently to
be used in future, opened when needed and can be duplicated to have a copy of it. Let’s discuss all
these operations in details.

Creating New Workbook:

Everytime we open MS Excel, it opens the default blank workbook for the user to work in. We can
also create a new file when we are already working in a workbook. We can use following steps for
creating anew File:

1. Click File tab and a Pane will appear.
2. Click New.

3. Now alist of available templates will be displayed. We can select the required template or
Blank workbook to be used.

4. Click New. Excel will create a new file and file will be opened.

Note: We can use Ctrl + N as a shortcut for creating a new file in MS Excel.

Saving Workbook:

When we are working with a workbook, it is very important to save our work after a short interval of
time. This task of saving workbook is different when we save first time as, it asks for filename for the
first time. Each of our MS Excel file is saved with .xIsx in Office 2010 or later version. Before office
2007 (Office 97-2003) all files were being saved with .xIs extension. When the filename is given, we
use save command all the time, our file remain updated in previous file already saved. We can save our
file using following steps:

1. Click File tab and a Pane will appear.
2. Click Save. The Save As dialog box will appear.

3. Goto the directory/drive in which we want to save our file.
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4,
5.

Type suitable name for file in the File Name field.

Click Save. Excel will save our file.

Note: We can use Ctrl + S as a shortcut for saving a file in MS Excel.

Opening an Existing Workbook:

When we want to continue our work in a workbook which is already saved then we have to open it

first. We can do this when we start MS excel using “Recent list” or “Open Workbook™ option. We can

also open a workbook when we are already working in a workbook. Let’s see the list of steps for

opening a workbook.

1.

A

Click File tab, a Pane will appear.

Click Open. The Open dialog box will appear.

Go to the directory in which our file is already saved.
Select our file to be opened.

Click Open. Excel will open our selected file.

Note: We can use Ctrl + O as a shortcut for Opening an existing file in MS Excel.

POINTS TO REMEMBER

10.

Microsoft Excel is a spreadsheet program used for organizing and calculating numerical
data.

Salaries of employees and Results of students can be prepared in MS Excel.

Worksheet contains columns and rows. We can insert more worksheets in workbook
by pressing the button “Insert New Worksheet”.

A cell is an intersection of a row and a column.
Row is a collection of all adjacent cells which are referenced by one single row number.

Column is a collection of all adjacent cells which are referenced by one single column
number.

Each MS Excel file is saved with .xIsx /.xls extension.

Active cell is the cell in which we are currently working. A bold rectangular box
around the cell identifies an active cell.

Each cell is identified by a cell address. The cell address of our active cell always
being displayed in Name Box.

We can use Mouse for selecting the cells. We can also use shift and arrow keys in
combination for the same purpose.
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11. We can edit the contents of a cell by pressing F2. We can also use double click of mouse in

the cell for this purpose.

12. MS Excel worksheet can be viewed in Normal View, Page Layout or Page Break Preview.

EXERCISE

Que:1 Multiple Choice Question :

I

A workbook is a collection of the

A.Cell B. Row

C. Column D. Worksheet

A cell is an intersection of a and a

A. Row,Column B. Row,CellAddress
C. Column, Formula Bar D. None of these

Fill handle in MS Excel can be used for

A. Copying the contents of a Cell B. Entering Number Series
C. Entering Custom Series. D. All of the above.

The Extension of MS Excel file is

A. .docx/.doc B. xlsx/.xls

C. .pptx/.ppt D. .txt

Which one of the following is not a view of MS Excel?

A. Page Layout B. Page Break Preview

C. Normal D. None of these

Que:2 Write the Shortcut keys for following tasks:

I

< 25 =

60 B

To Open an existing file in MS Excel

To Save a file in MS Excel

To Create anew file in MS Excel

To Fill Down in MS Excel

To Fill Rightin MS Excel
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VI To Copy contents in MS Excel

VII To Paste contents in MS Excel

Que:3 Write True or False:
I Address of Active Cell always displays in Name Box.

II  All Columns of MS Excel are represented by numbers starting with 1.

I Cell containing formula displays the result of the formula, whereas the formula itself displayed
in Formula Bar.

IV MS Excel is a widely used Word Processor.
\Y%

We can insert Number Series in MS Excel using Fill Handle.

Que:4 Short Answer Type Questions:
I Define MS Excel.
I What are the uses of MS Excel?
I Explain Ribbon in MS Excel.
IV Whatis Name Box?
V  Explain Rows and Columns in MS Excel.

Que:S Long Answer Type Questions:
I What are the Basic Operations for MS Excel worksheet?
I Explain the Features of MS Excel.

Write the differences between Workbook and Worksheet.

| Lab Activity |

1. Fill in the name of various parts of MS Excel Window.

o U AN "m > B

S ;-.':...4. B I 5 A EEE BE e Ny

:
]
[\
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2. Prepare the following table as directed:

62 B

I

Use Series Option for Sr. No column.

I Use Fill handle to enter Day and Type.
W A B L | D |
1 Sr.No. Day Type Subject
2 | 1 Monday Theory Hindi
3 2 Tuesday Practical Punjabi
4 3 Wednesday Theory English
S | 4 Thursday Practical Math
6 5 Friday Theory Science
7 6 Saturday Practical SST
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Microsoft Excel (Part-2)

Objective of this Chapter: ]

4.1  Formatting in MS Excel

4.2 Inserting row, column and other objects in MS Excel

INTRODUCTION

In the last chapter of MS Excel, we have studied the different parts of MS Excel window and different
options for working with data in MS Excel. In this chapter we are going to learn about formatting tools
to be used in MS Excel. We can make our data more readable and effectively representing the information
from facts of data. We will further read about different objects which can be added in our worksheet.
Let’s begin with learning about formatting tools.

4.1 FORMATTING IN MS EXCEL

MS Excel sheets without formatting are very difficult to understand. Formatted data and cells
can be useful to get attention to specific parts of the spreadsheet and make the spreadsheet more
visually appealing and easier to understand. There are many tools in MS Excel which can be used for
formatting text and cells. These tools can change the color and style of text and cells, aligning texts
and applying special formatting to numbers and dates. Some of the formatting tools are as under.

4.1.1 Changing the text styles:

MS Excel offers lots of different options to change the text styles. Some of these are as under:

“Font ) C Size
~—X ,
D i J—
Calibri *i11 "~ A A (Font Colop
/"—‘\\ e | T3 - b /";/;
"Bod >=—B Z U ~ | i A
—;‘;’// W ‘hﬁ:?-::\\
— / \ e
(,|ta|ic )] |' ’." Font \\\ ~

I
Border Text Background Colop>

P Ly
( Underline )
\‘-‘_ _,—/

Fig 4.1: Text Styles
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1. Font: A Font is basically a style of text being typed. We can also change the language of text being
typed. Some basic fonts are Arial, Times new Roman, AnmolLipi etc.

y A

1 |Computer
2 {

3 i

4 i

5 i

6 |

-

"

Calibri lH-A'A' ==

Theme Fonts - | |

Calibri Light
Calibni

All Fonts
Aachen-Bold
Aachen-Light
AARCO
AARCO/

Aarcover
ARardvark

Obbey-Medum

Alh. .. MR F % .

(Headings)
Body)

Aachen-Light

Fig 4.2: Font Text Styles
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2. Size: As per its name, this option of text style increasesor decreases the size of text being typed. We
can have our contents in different sizes in a single worksheet to make it more effective.

-

1
2
3 {
4
5
6
o/

A

| Computer I

» =
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18
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Fig 4.3: Size Text Styles
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3. Font Color: Using this option, we can change the color or our contents in MS Excel. There is a wide
range of colors to be used for Foreground of text.

A

64 B

O s WN =

A

]Computer '

B

i
i

A
. Automatic
Theme Colors

"' m EEEEsEEN

|II— Blue, Accent 1 |
Standard Colors
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Fig 4.4: Font Color Text Styles

| A

1 |Computer I
2 | [
3 —

4

5

6

7

MICROSOFT EXCEL (PART-2)



4. Text Background color: This option of MS excel Allow User to change the background color of
text.

A LA - === A
Theme Colors
|| HEE = N |

L lli“lllll L

Standard Colors
A EEEEN

i

Computer I

No Fil
Yellow
-
W Morecovwn:.

1
2
3
4
5
6
ar

Fig 4.5: Text Background Color Text Styles

5. Basic styles: There are some other styles also available to be applied on text contents. Such as
Bold which makes our text a bit stronger than regular, Italic which is for making the text a little
slanted, Underline, which shows a line under the text to make them more emphasized.

y | A . A

1 [Computer e 1 |Computer
> Calibri 112 ~ | A A 2

: 1= B z U-|i- >-A-| ) 2

5! Font 5

6 6

- 7

Fig 4.6: Applying Bold, Italic and Underline Text Styles
Note: We can use shortcut keys for these text styles which are as under:

Bold: Ctrl + B, Italic: Ctrl + I, Underline: Ctrl + U
4.1.2 Changing the Cell styles:
Cells are the primary element of a spreadsheet. All the contents are all arranged in cells. There
are several options for changing the styles of cells too.

1. Cell Borders: We can use this option to have attractive presentation of data in spreadsheet
and highlighting the valuable contents. We can use Border option from Font group to apply
border to a cell following sports are used to apply cell Border.

1. Select the required cells and press the arrow key of Border button.

2. A dropdown menu appears. It displays the different options for borders to apply.

3. Select one or more option for a single selection.

We can use “More Borders” option to have advance setting of border using Format cell dialogue
box.
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Fig 4.7: Changing Cell Border

2. Changing cell width: Using this option for a cell style, we can change the width of a cell. This width
will be applied for entire column. Steps to change Cell Width:

Select one or more columns.

Click on Format button in the Cells group of Home tab.

A dropdown menu will appear. Choose column width option which will open “Column
Width” Dialog Box.

Enter the value of Column width.

5. Press OK button to apply cell width.

A

A <[l v - Ay 1 |Computer
1 |Computer R # Clear-  onE, 2
2 e 3
3 AutoFit Row Height Column Width [ 4 X 4

7 Column Width... ]
4 e toF ~ ) 5
i esi— Column width: | 15

5 ) .p.en,m Midth 6
6 v“:': & Unhide ’ Cancel 7
= Organize Sheets. 8

Fig 4.8: Changing Cell Width

3. Changing cell height: This option for a cell style can change the height of a cell. This height will be
applied for entire row. To change Cell height :

1.
2.

66 W

Select one or more rows.
Click on Format button in the Cells group of Home tab.

A dropdown menu will appear. Choose Row Height option which will open ‘“Row Height”
Dialog Box.

Enter the value of Row Height.
Press OK button to apply cell height.
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Fig 4.9: Changing Cell Height

Note: We can alternatively change the width or height of a cell by dragging the column boundary
at column header and row boundary at row header.

4. Merging Cells: By mean of merging the cells, we refer to joining two or more adjacent cells as a
one region. We can merge any number of cells forming a rectangular area. If the cells being merged
have contents, after merging the information in the upper left cell will be the only information remaining
in the merged cells. We can merge cells as follows:

1. Select the cells to be merged.
2. Click on “Merge and Centre” from Alignment Group of Home tab ribbon.
3. Select further options of Merging from drop down menu appeared.

The selected cells will get merged.

(A B c m| . A B C
1 |Computer Education | Merge & Center = 1 | Computer Education |
2 E] Merge & Center 2
i {E Merge Across . :
5 BB Merge Cells 5
g B UnmergeCells :

Fig 4.10: Merging the cells

The “Merge Across” Option will merge each row of selected cells into a larger cell. We can also
unmerge the already merged cells using “Unmerge” Option from the drop down.

5. Aligning Text: We can align the contents of a cell by using the Alignment group in the Home
tab of ribbon. Contents can be aligned to the top of the cell, the bottom of the cell or the center of
the cell. They can also be aligned left, right and center, just like the text in a word processing
program like MS Word. For aligning the text, we can use steps as follows:

1. Select the cells.

2. Choose the required alignment option form home tab ribbon.

MICROSOFT EXCEL (PART-2) B 67




The effect of each alignment option will be displayed on selected cells.
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Fig 4.11: Aligning the text in cells

6. Changing Orientation of Text: When we are designing the report having of a lot of data to arrange
our whole report on a single page, we have to compress the columns or rows in as minimum size as
possible. Sometimes, we have columns where column header is large than the data written under that
particular field. For example, Marks Obtained field will be wide enough but all the marks will not be
such long. In this case, we may require to change the orientation of our text written in the header. We
can change orientation of text within a cell as under:

1. Select the cells whose orientation is to be changed.
2. Choose “Orientation” option of alignment group of Home Tab.

3. Different orientation options will be displayed in appeared drop down menu appeared.
Select the required orientation.

Selected orientation will be displayed on selected cell.

A 1 ¢ |
4 A B c o == = - ® Wrap Text G §
T [Name  Subtyect Marks Oblsined
2 Il-vn Compter - =Y === % Angle Cunterclockwise q §
3 Sham Computer [$Y =
4 inder  Computer s QS Angle Clockwise ; :::e :uhm" i
: n m :: l; !Hﬁ(ll Text 3 Sham Computer &5
7 Inder Mgl 5 ’ r,a Rotate Text Up 1 ‘ 4 inder  Computer a5
5 Ram  Hindi s
8 Rfam (Ing a7 —— —
- I8 Retse Tt pown o= =
10 inder Ing » e
" C ¥, Format Cell Alignment l 8 fam (g “
L ——— = ! 9 Sham Eng 9

£ 10 inder ng

-
-

Fig 4.12: Changing Text Orientation

Now, as we can see in the picture shown in above figure, we can easily compress the size of
column containing Marks Obtained as our column header has been vertically oriented.

7. Wrapping Text : When typing within a cell, sometimes our contents go out of cell’s width.
According to the requirement of our report, we don’t need to increase the column width. In
such a case, we have to wrap text within a same cell. For this purpose, we can use Wrap
Text option of Alignment Group in Home Tab Ribbon after selecting the particular cell or
the range of cells.

68 B MICROSOFT EXCEL (PART-2)



A = == & - ® Wrap Text General - P? A

=== == B8 . - % | % Condit
|Marks Ob (_b’t') == EdMegeCenter - § - % » | %@ % Condiio Marks Ob

Alignment 5 Number (%)

1
2
Wrap Text

3 1 @ Wrap extra-long text into multiple
| < Sl lines so you can see all of it.
: N -
5
6
7

1]|Excel
2

N o AR W=

0 Tell me more

Fig 4.13: Wrapping cell contents

8. Applying Number Formats: We can change the appearance of numbers in MS Excel without
changing the values. The actual value is always displayed in the formula bar. The default format for
displaying numbers is “General”. In this format style, All the numbers, dates are right aligned but all the
contents that contain text are left aligned. To change the number formats, we can use following steps

1. Select the cells to change the number formats.

2. Click on “Number Format” option of Number Group of Home tab ribbon.

3. A Dropdown menu will appear. Select the particular number format to be applied.
4. The Select Format will be applied on selected cells.

Note:We can have more options related to formatting by clicking the “More Number Formats”
button at the bottom of the dropdown. This will launch the Format Cells dialogue box for
different formatting tasks.
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Fig 4.14: Applying cell formats
4.1.3 Conditional Formatting:

Conditional Formatting is a tool in MS Excel that enables applying particular formats to a cell or range
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of cells depending on the value under specified condition. This tool is very useful as it can highlight the
respective cells with certain formats to show valuable facts. For example, while preparing the result of
aclass, we can highlight cells who secured marks greater than 80%. We highlight cells with a certain
color or other formatting.

Conditional formatting applies one or more rules to any cell or range. We can use following steps to
apply conditional formatting :

1. Select the required cell or range where conditional formatting is to be applied.
2.  Click on Conditional Formatting button from Home tab ribbon.

3. Dropdown menu will appear and lot of pre-defined rules for conditional formatting will be
displayed. Choose the required rule. We can use Highlight cell rules like Greater Than, Less
Than, Between, Equal to, Duplicate Values etc.

4. Dialog box related to selected rule will appear. For example, if we choose Greater than
option then “Greater Than” Dialog Box will appear.

5. Enter the values for the given rule.

6. Press OK to apply specified Conditional Formatting.

y iz y B 8= Bx R Elnlnﬂ y
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4 62 (52| Color Scalex v | [ spaira % E with Gieen Fillwith Dark Geen Ted | ’ : | :2
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Fig 4.15: Applying conditional formatting with highlight cell option

Some other commonly used conditional formatting rules are Top/Bottom rules like Top 10 Items, Bottom
10 Items, Above average etc. The steps for applying this type of rule will remain same.
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Fig 4.16: Applying conditional formatting with Top/Bottom option
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We can also create new rule for conditional Formatting using “New Rule” Option.
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Edit the Rule Description: 3 7
4 62 -
-| Color Scales 4 Format anly cells with: 4 sz
5 96 | Cenvaue v ottween ) [+ 2] and [20 =] 5 96
=1 lconSets
6 95 ~ 6 95
7 45 U] bew Rule... Prevew. AaBbCeVyZt (=] = a5
B ClearRules >
8 [E ] Manage Bules oK Cancel A

Fig 4.17: Applying conditional formatting with New Rule Option
1.1.4 Formatting as Tables:

When we are going to design a report or any other tabular data representation in MS Excel, we have
several pre-defined formats. Once we have entered information into a spreadsheet without any formatting,
the information is not going to be as effective as a well formatted information is. Formatting our spreadsheet
can not only improve the look and feel of our spreadsheet, but it also can make it easier to use. To apply
this style of formatting, we can use following steps:

1. Select the cells to be applied formatting upon.

2. Click on “Format as Table” from Home tab.

3. Anew dialogue box will appear which shows a lot of different formats.
4

We can easily click the required format to be applied on the selected cells.

A B
A B
(M Name g Marks Ob (%}
1 |Name  Marks Ob (%) 2 Ram 80
2 |Ram 80 Format As Table ? X 3 Sham 75
3 |Sham 75
! ‘Where is the data for your table? 4 Inder 62
4 |Inder 62 =SAS1:5657] 2| 5 Mohan 96
5 |Mohan 96 £ My table has headers 6 Arif 95
6 |Arif 95 7 Joh 45
7 |John 25 T on 4
: o] e

Fig 4.18: Formatting as table
4.2 INSERTING ROWS, COLUMNS AND OTHER OBJECTS IN MS EXCEL

MS Excel provides the facility to add a variety of objects within an excel worksheet. Each one of them
is having its own importance. When we prepare a report, we need to add cell, row or columns within
the entered data. We can insert new cells, columns, or rows in the worksheet without going through all
the trouble of moving and rearranging several individual cell ranges.
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To insert new cells, rows, or columns in an Excel worksheet, Select the cell/cells, rows, or columns

where we want to insert a new cell or number of cells. Click on Insert option of Cells group in Home

Tab ribbon. Select the desired option from the dropdown menu appeared.

4.2.1 Inserting Cells:

Select the cell where new Cell is to be inserted. Select Insert = Insert cell from Home tab ribbon. Click
on the required option and press OK.

4 A B C
1 Name Class Marks
2 Ram 6th 80
3 Sham 7th 75
4 |inder [7th 62
5 Mohan 9th 96
6 Arif 10th 95
7 John 9th 45
8

4.2.2 Inserting Rows:

rmmxit

Insert Delete Format
. v v | @ CQear

=
I

5

'JE.J [

B

z AutoSum ~

[ Fin-
SOrl &
Filter »

[nsert Cells... Editing

(P -
Insert Cells (Ctrl+ Shift+=)

Insert cells, rows, or columns into
| the sheet or table.

)

| FYE: New rows will be added above
the selection and new columns will
be added te the left of the selection,

Insert 7 X 4 A B
o I 1 Name Class
e ‘ ) 2 Ram  6th
8,5_’1“_5.‘2322“_'1 3 sham 7th
{Shift cells down; 4 |Inder |:|
() Entire row
O Entire gob 5 Mohan 7th
ntire column 6 Arlf gth
Cancel 7 John 10th
) 8 9th

Fig 4.19: Inserting new Cell

"

Marks

80
75
62
96
95
45

Select the cell where new Row is to be inserted. Select Insert = “Insert sheet rows” from Home tab

ribbon. New row will be added on the place of our selected cells.

4 A B
1 Name Class
2 Ram 6th
3 Sham 7th
4 |Inder 7th
5 Mohan Sth
6 Arif 10th
7 John 9th
8

S - === ZAuh
Marks‘ = EX L.‘;I [Z] Fill
Insert  Delete Format
80 hd M - & Clez
75 &= |nsert Cells...
62 . & InsertSheet Rows ‘
96 URY  Insert Sheet Columns
95 L:j Insert Sheet
T
45

Fig 4.20: Inserting new Row

4.2.3 Inserting Columns:

A A B C

1 Name Class Marks
2 Ram 6th 80
3 Sham 7th 75
al [ ]

5 Inder 7th 62
6 Mohan Sth 96
7 Arif 10th 95
8 John Sth 45

Select the cell where new column is to be inserted. Select Insert = “Insert sheet column” from Home

tab ribbon. New column will be added on the place of our selected cells.

Y Y. B c | . i > AutoS A A B cC | D
1 Name Class Marks =2 == [@) Fill - 1 |Name Class  Marks
2 Ram 6th 80 Insert Delete Format e 3 |Ram 6th 80
3 sham 7th 75 S . 3 'Sham 7th 75
4 |Inder m 62 . g Insert Cells... ‘ 4 |Inder |:]?th 62
5 Mohan Sth 96 | €= Insert Sheet Rows 5 Mohan oth 96
6 Arif 10th 95 UsY Insert Sheet Columns 6 Arif 10th 95
7 loh 9th 45
ohn B Ingert Sheet 7 John 9th 45
8 , 8
Fig 4.21: Inserting new Column
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Note: To insert an entire column or row into the worksheet, we can right-click on the column
header or row header on the worksheet window frame and then select Insert from the shortcut
menu (or choose Insert Sheet Rows or Insert Sheet Columns from the Insert button’s menu).
Keyboard shortcut for quickly inserting any of these objects is pressing + (plus) in combination
with Ctrl key after selecting the required object. i.e. for inserting new line, select the line where
insertion is required and press Ctrl and + key together.

4.2.4 Using AutoSum:

Functions in MS Excel are pre-defined formulas that are used to perform calculations. MS Excel
provides a wide range of formulas like sum (SUM), average (AVERAGE), count (COUNT,
COUNTA), maximum (MAX) and minimum (MIN). Each of these functions is having its own specific
operations to be performed. We can Apply any of these functions using “AutoSum’ option from
Editing group of Home Tab ribbon. We can use arrow key of AutoSum option to use more functions.

A . . A B C

2 AutoSum ~ Ay ( A B C D 1 Name Class Marks

1 Name Class Marks I Py——
z 1 Name Class Marks 2 Ram  6th 80

2 Ram  6th 80 um ™ a0l
. ' 2 Ram 6th : 80 3 Sham 7th 75
3 Sham 7th 75 Average £ 3 Sham 7th : 75|: 4 Inder 7th 62
4 |Inder 7th 62 Count Numbers 4 \Inder 7th | 62 5 Mohan 9th 96

5 Mohan 9th 96 . ’ | |
R o Max 5 Mohan 9th | 96| 6 Arif 10t 95
i 6 Arf 10th | 95| 7 John  Sth 45

7 lohn oth 45 Min ! '
. l I 7 John 9th | 45 8 453

| More Functions... 8 [=su (CZ:C'ID 9

9 - | T T T e ‘ r—r

Fig 4.22: Inserting function in worksheet

As shown in the figures above, the range of function to be applied on is picked automatically. We can
change the range in desired manner. We can use more functions too with the help of “More Functions”
option of dropdown menu. We will discuss the use of functions in next chapters.

4.2.5 Inserting Charts

Chart is a graphical presentation of data written in a worksheet. Charts are useful in better understanding
of information represented by data values. There are different chart formats available in MS Excel
such as Bar, Column, Pie, Line, Area, Doughnut, Scatter, Surface, or Radar charts. We can easily
create chart using following steps:

1. Select the required group of cells.
2. Click on any type of chart from “charts” group of Insert Tab.

3. The chart will be appeared in the currently active sheet.
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WL i e iy T g—

A B 2 Marks

B NS N AW N -

Name Marks
Ram 80

Sham = H 1 1 » . \ ~
Inder 62 ‘ 208 .

Mohan 96 - ! (Chart Styles
Arif 95 l

John 45 7 B . | =

Fecommended
Cha:

ol &

Fig 4.23: Inserting Charts

The chart appeared will be designed with standard Layout. We can edit the style of chart using chart

Style Button. There are further lot of option regarding chart elements. We can use them as per our

requirement. Chart designs will be shown in the design tab. We can also change the design of chart with

the options of the ribbon.
POINTS TO REMEMBER

10.

I1.

12.

74 B

We can make our data more readable and effectively representing the information from
facts of data using Formatting options.

Fonts, Size, Font Color, Text Background Color, Border and other styles are some of the
basic Text Styles.

We can add Cell Borders, change cell width or height, Merge cells, Align Texts, Change
Orientation of texts, Wrap Texts, Change Number Formats as a cell style in MS Excel.

Conditional Formatting is a tool in MS Excel that allows applying formats to a cell or range
of cells depending on the value.

There are lots of pre-designed styles to be applied as a Table in MS Excel.

We can create own style including number formats, Alignment, Font, Border, Fill Style,
Protection etc. which can be applied to any group of data.

We can add any of our object like cell, row or column with keyboard shortcut pressing +
(plus) in combination with Ctrl key after selecting the required object.

Each newly created workbook is contains of three worksheets by default in it.
We can add new worksheets in a workbook using “Insert New Worksheet” Button.

SUM, AVERAGE, MIN, MAX, COUNT etc. are some of the examples of functions
being used in MS Excel.

Chart is a graphical presentation of data written in a worksheet which are useful in
better understanding the information represented by data values.

There are different chart formats available in MS Excel such as Bar, Column, Pie, Line,
Area, Doughnut, Scatter, Surface, or Radar charts
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EXERCISE

Que:1 Multipul Choice Questions :

I

\%

By default, each new workbook in MS Excel 2010 contains____ number of worksheets.
A.5 B. 2

C. 255 D.3

Which objects can be added in a worksheet?

A. Cells B. Charts

C. Rows D. All of these

Which are the valid types of Charts in MS Excel.

A. Bar, Column, Pie, Line B. Area, Doughnut, Scatter
C. Surface, Radar, Bar. D. All of the above.

Which function is used to find minimum number from the given range.

A. AVERAGE B. MIN

C. MAX D.RANK

is a powerful tool of MS Excel used to have graphical representation of our data in
MS Excel.

A. Data Validation B. Conditional Formatting
C. Charts D. None of these

Que:2 Write True or False:

I
I
I

v

A%

New cell, row or column can be added by using Ctrl and + keys from keyboard.
SUM and MIN are examples of Chart Types in MS Excel.

Cell Borders, change cell width or height, Merge cells, Align Texts, Change Orientation of
text, Wrap Text etc. are examples of cell styles.

Conditional Formatting is a tool in MS Excel that allows applying formats to a cell or range
of cells depending on the value.

Formatting options effectively represents the information from facts of data.

Que:3 Short Answer type Questions:

I
I
I
v

What do you mean by Formatting?

Which type of formatting can be used as Cell Styles?
What do you mean by Merging Cells?

Define alignment and its types.
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V  What are Charts?

Que:4 Long Answer type Questions:
I Whatis conditional Formatting? Explain its different options.
I What are charts? Give the name of any five types of charts.

III Explain any three objects which can be added in MS Excel worksheet.

| Lab Activity |

1. Put the following items in their respective types:
SUM

PIVOT TABLE
AREA

BOLD

MIN

FONT

TEXT COLOR
PIE

NEW ROW
MAX

BAR

CELL

LINE
AVERAGE
CHART
ITALIC

TYPE OF CHART MS EXCEL FUNCTION

INSERTABLE OBJECT FPORMAT STYLE

XY EEEBERNR S S S <=2 ESC
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2. Prepare the following “Detail Marks Card” Format in MS Excel by applying required

formatting styles

GOVERNMENT SENIOR SECONDARY SCHOOL
CITY NAME

'Roll No 30 Student ID 258965
‘Name of Student KAMALPREET
|Father Name SHIVPREET
‘Mother Name NAVLEEN
Class:  9TH  Date of Birth __ 27/08/2006 _ Section B
'UID No 4528-6985-4587 Gender MALE
% Subject ; Elel| 8| B Remarks
» x E|2|S
2|la|=
1 |ENGLISH 100 | 40 | 45 | 45 D
2 |PUNJABI 100 | 40 | 63 | 63 C §
m
3 |HINDI 100 | 40 | 56 | 56 D 3
o
4 [SCIENCE 100 | 40 | 45 | 45 D -
5 [MATH 100 | 40 | 88 | 39 =
6 |SOCIAL SCI 100 | 40 | 62 | 62 C
7 |COMPUTR SCI 100 | 40 | 45 | 45 D
8 |OPTIONAL 100 | 40 | 52 | S2 D
9 |WELCOME LIFE 50 | 20 | 44 | 88 B
TOTAL MARKS
[Maximum marks Secured
[Minimum marks Secured
(Grade : 0-40 : E, 41-60 : D, 61-80 : C, 81-90 : B, 91-100 : A)
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Microsoft Excel (Part-3)

,—[ Objectives of this Chapter: } \

5.1 Introduction of Formulas and Functions

5.2 Uses of Formula and Functions
5.3 Sorting and Filtering Data
5.4 Working with Data Tools

\. J

INTRODUCTION

We are now able to design our required report with different attractive formatting after learning
previous chapters of MS Excel. We have also studied about different objects. We can add these
objects in our MS Excel worksheet to create an advanced representation of our data. This is not
all,moreover we have powerful calculations and data manipulation functions to be used in MS
Excel. In this chapter we will have a close look over data manipulation using different Functions
and Formulas.

5.1 INTRODUCTION OF FORMULAS AND FUNCTIONS

As we have studied earlier that Excel is a spreadsheet program where one can record data in the
form of tables. It is easy to analyze data in an Excel spreadsheet. Formulas and functions play
very important role of MS Excel. These are the key features of every spreadsheet package.

A formula is an expression that operates on values in a range of cells or a cell. A lot of operators
can be used within a formula to describe the required operation to be performed on a group of
particular data.

A function is a predefined formula that performs calculations upon specific values in a particular
order. MS Excel spreadsheet programs include common functions like Sum, Average, Count, If,
Sumlf, Countlf, Max, Min, etc.

Let’s discuss about both these elements of MS Excel in detail.
5.1.1 Elements of Formulas:

A formula is an expression which is used for calculation. These expressions are user-defined and
can be as small as one single operation and can be complex enough to perform some advanced
calculations. These expressions can be designed using constant values, cell references and
operators. We have already studied about lot of operators to be used in a formula. Each expression
can be understood as two parts:
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e  Operators: This part of expression defines what to do on available data. We can
use symbols representing different operation known as “operators” for defining
operation of expression. In the fig. 5.1 + sign represents Operator part of Expression.

e  Operands: This part of expression defines the values on which the given operation is
to be applied. Each different operator is having particular operand requirement. i.e.
Some operators require one operand and some on the other hand require two or more
operands. In the given figure, A1l and 20 both are representing Operand part of
expression.

K Operands

Al + 20

e « «e « OQperators
Fig. 5.1

5.1.2 Operators used in MS Excel Formulas

Operators are the symbols which represent a particular operation to be performed in a particular
application. MS Excel follows general mathematical rules over operators for calculations. The
precedence of application of operators in an expression would be Parentheses, Exponents,
Multiplication and Division, Addition and Subtraction etc. There are four different types of
calculation operators being used in MS Excel are arithmetic, comparison, text concatenation
and reference.

1. Arithmetic operators

These operators are used to perform basic mathematical operations. The list of these operators is

as under:
Symbol | Arithmetic operator Meaning Example Result
+ plus sign Addition =343 6
- minus sign Subtraction =3-3 0
Negation =-3 -3
* asterisk Multiplication =3%*3 9
/ forward slash Division =3/3 1
% percent sign Percent =30% 0.3
A caret Exponentiation =373 27

Table 5.1: Arithmetic Operators
2. Comparison operators

We can compare two values with the following operators. When these operators are applied,
only logical values are given as a result. i.e. either TRUE or FALSE.
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Symbol Comparison operator Meaning Example
= equal sign Equal to =A1=B1
> greater than sign Greater than =A1>B1
< less than sign Less than =Al1<B1

>= greater than or equal to sign | Greater than or equal to =A1>=B1
<= less than or equal to sign Less than or equal to =Al<=Bl1
<> not equal to sign Not equal to =Al<>B1

Table 5.2: Comparison Operators
3. String concatenation operator

Strings are also known as text contents. We can use the ampersand (&) to concatenate (join) one
or more text strings as a single text.

Symbol | Text operator | Meaning Example Result

& Ampersand Connects, or concatenates, ="North” & “wind”| Northwind
two values to produce one
continuous text value

Table 5.3: String Concatenation Operators

5.1.3 The Operator Precedence in Excel:

Sr No Operator
1 Exponentiation (")
2 Multiplication (*), Division (/)
3 Addition (+), Subtract (-)
4 Concatenation ( & )
5 All Comparison Operators

Table 5.4: Operator precedence

5.1.4 Cell Referencing:

Cell reference is an another name of an address of a particular cell, group of cells or a range. MS
Excel is a powerful tool which provide a lot of calculation functions and formulas to be applied
over any single or multiple cells. The way of representing the cell addresses within a formula or
function is called “Cell Referencing”. The basic concept behind the use of cell referencing is
that, when a cell reference written in a cell as a part of any function or formula and if this cell is
being copied or filled to another cell then the references given in the cell also changed accordingly.
This feature is very useful for application of formulas over multiple cells without making a lot
of changes. But, Sometimes the references are required to be same fully or partially after being
copied. In such a case, different types of referencing are being used.
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Let’s discuss the different types of cell referencing.

Note: When any formula is written in the cell and we press enter key after completion of the
formula then only result is displayed in the cell itself. The formula written is displayed in the
formula bar. If we want to see all the formulas written in all the cells then we can use Ctrl +
~ (tild sign) key from the keyboard. We can use this shortcut key again to return back in
previous state.

o Relative References:

This is a default referencing in MS Excel. When cell/cells represented by relative referencing
copied to another location, they change based on the relative position of rows and columns. For
example, if we copy the formula=A1+B1 from row 1 to row 2, the formula will become =A2+B2.

4 A B C 4 A B C 4 A B C
1 Marksl Marks2 Total 1 Marksl Marks2 Total 1 |Marksl Marks2 Total
2(23 a5 [=a2em2 ] 2(23 a5 [=a2em2 2 T .

3 25 85 3 25 85 3

4 45 95 ’ 4 45 95 . 4

5 65 68 5 |65 68 5

6 62 35 6 62 35 6

7 52 62 7 |52 62 7

8 8 8

Fig 5.2: Example of Relative References

Relative references are especially convenient whenever we need to repeat the same calculation
across multiple rows or columns.

Note: In this type of cell referencing, No row or column is fixed.
e Absolute Reference:

Sometimes, we may do not want a cell reference to change when copying/filling the contents of
a cell/cells. Unlike relative references, absolute references do not change when copied or filled.
We can use an absolute reference to keep a row and/or column constant. An absolute reference
is designated in a formula by the addition of a dollar sign ($) before both column and row. Now,
if the cell will be dragged, the absolute references will not be changed. We can see the use of
absolute referencing as follows:

A BN C | A B c | A B c
1 Grace Marks= |5 1 Grace Marks= |5 1 Grace Marks= |5
2 Marks Total 2 Marks Total 2 Marks Total |
365 [-azescs1 | 365 [=azescsn + 365 [-Asescsr |
4 25 N ‘ 4 25 ’ 4025 =agescs1 |
B34 5 34 530 =AS+$CS1
6 85 6 85 685  |=A6+5C51
7 7 45 7 (a5 |=A7+8C51
877 Cell to make 8 77 8 (77 |=AB+SCS
9 95 9 95 9|95  |=A9+5CS1

absolute

-

>

Fig 5.3: Example of Absolute References
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As we see in the fig. 5.3, references $C$1 are in absolute form. So, after filling the cell formula
in another cells, the reference remains unchanged. But, for another reference A3 which is relative
by its type, it changes as per filling of formula in next row. This is a basic use of absolute
referencing.

Note: In this type of cell referencing, both rows and columns of a particular reference are
fixed.

e Mixed Reference:

As its name implies, this cell referencing is a mixture of both absolute and relative reference
because, only one out of a row or a column remain fixed while copying. This type of reference
is used in special kind of situations where operations are associated with particular row or
column in an advanced manner. In other words we can say that an absolute reference in Excel
refers to a reference that is “locked” so that rows and columns won’t change when copied. Such

as:

» B - n - - A B¢ D £ ; ACBTVCTDTETNF
1 : 6 8 10 12 4 : : L RN ARER Y
ol [eazms | 2|1 |ssatadn #SAR'CSL sSA'DSI SA2'ES1 sSA2'FSL 2|1/2 4 6 8 10
r— ' 31 SAIESI sSACSL sSADSI SSABUESH SSAB'ESL 3204 8 2 16N
N £ sSABSL SSM'CSL sSA'DSI SSAMVESD sSAAYFSL 436 2 1B W N
¥ 514 aSAS'BS1 mSAS'CS1 wAS'DSI sSASUESL sASUFSL 5148 16 ¥ RN 4
X 65 OGBSI sSAGMCSD s$AGYDS1 SBAGVESH SSA'FSL 6lsio 2 20 @ %
F 706 =SAT'BS1 =SAT'CS1 =SA7'DS1 =SAT'ES1 sSAT'FS1 706l12 0 3% 48 60
B Bl sANE1 AL SAB'DS] SANESL SAR'FSL 874 B & % N
. 0 AL A SSADSL AL AL e
A 1019 =8A10°B51 =$A10°C51 =$A10°D51 =$A10°ES1 =5A10°F$1 ol 3% 9 1 w0

o [ # U L
11110 sSALI*BSL #SA11'CS1 sSA1'DSLSALIESY sSALI'FSL om0 8 8

1110

1
Fig 5.4: Example of Mixed Reference
As we can see in the fig. 5.4, the column A of first reference and row 1 of second reference are

made fixed with dollar sign. When the particular cell is filled in other cells of different rows
and columns, the fixed row and columns are not changed.

Note: In this type of cell referencing, only one element either row or column of a particular
reference are fixed.

5.2 USES OF FORMULAS AND FUNCTIONS

In previous sections of this chapter, we have discussed about formulas and functions. Each
formula and function is having different operation to perform and different syntax to be applied.
We will learn the methods of applying formulas and functions in this section.

5.2.1 Using Formulas
5.2.1.1 Simple use of Arithmetic Operators:

This type of formulas is having different arithmetic operators applied on one or two values.
This is a simplest type of formula which performs basic calculations: Some examples of this
type of formulas are as under in fig. 5.5
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A B C D E

1 Nol No2 No3 Formula Result
22 8 4 =A2+B2 10

3 4 4 7 =A3+B3+C3 15

4 6 6 1 =A4+B4-C4 11

59 2 8 =A5+10+C5 27

6 5 3 -] =A6+B6-C6+3 6

Fig 5.5: Example of Simple use of Arithmetic Operators

Explanation:
S.No Formula Description
1 =A2+B2 Only one operation with two cell reference
2 =A3+B3+C3 Only one operation with more than two cell reference
3 =A4+B4-C4 Multiple operations with more than two cell reference
4 =A5+10+C5 Only one operation with cell reference and constant values
5 =A6+B6-C6+3 Multiple operations with cell reference and constant values

Table 5.5: Explanation of Simple use of Arithmetic Operators
5.2.1.2 Advanced use of Arithmetic Operators with operator precedence:

We can design more advanced formulas with more than one operator within a single expression.
In such a case, we have to take care of operator precedence which is the order of execution of
operators when multiple types of operators are used within a same statement. Let’s discuss this
fact with a particular example:

A B
1 Formula Result
2 =5+2*3 11
3 =(5+2)*3 21
4

Fig 5.6: Example of Operator precedence

As shown in fig. 5.6, same values and operators* are used. But the result with and without
parentheses is absolutely different. We must understand the reason behind it. The root cause of
this difference is “Operator precedence”. The default precedence of operators from high to low
is considered as show in the table 5.4.

In the case, when this default precedence is to be managed according to our requirements then
we must use parentheses within our expression. Let’s have a look of some advanced use of
formulas with the use of precedence.
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A B C D

1 Valuel Value2 Formula Result
2 2 7 =(A2*10)+2 22

3 3 4 =(A3+B3)*10 70

4 4 6 =A4*2+B4*5 38
56 5 =A5*B5+A5 36

6

Fig 5.7: Example of Advanced use of Arithmetic Operators

Explanation:

S.No | Formula Description

1 =(A2*10)+2 | In this example, two operators are used. * is having highest precedence
so the result will remain same with and without parentheses.

2 =(A3+B3)*10 | Here + operator is put in parentheses which is having lower precedence
over *. Here the result will be changed if parenthesis are not used.

3 =A4*2+B4*5| If two operators with equal precedence are put in single formula then
both these would be executed at a same time. So, here + will be executed
after execution of both * operators.

4 =A5*B5+A5 | Here again * will be executed prior to + operator.

Table 5.6: Explanation of Advanced use of Arithmetic Operators
5.2.1.3 Using formula for calculating the percentage

Calculating percentage is one of the most useful tasks to be used in any of the application. For
example, if we are going to design a result card in MS Excel then this operation is also required.
As we already know that we can calculate the percentage using following method.

(Marks Obtained) v
Total Marks

Percentage of Mark = 100

We can apply this formula in MS Excel data of student marks as follows:

A B C D E F €
Name Marks1 Marks1 Marks1 Total Percentage

1 (Max 100) (Max 100) (Max 100) Max 300

2 |Ram 45 45 74 | 164 [=(£2/300)*100 |
3 Gagan 25 84 84 193

4 John 62 55 99 216

5 Arshid 45 65 64 174

A

Fig 5.8: Example of finding Percentage using Formulas
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Here the formula written above is shown in the MS Excel Worksheet. The results would
appear as per fig. 5.8 shown below.

A A | B | € | D | E F C
Name Marks1 Marks1 Marks1 Total Percentage

1 {Max 100) (Max 100) (Max 100) Max 300

2 |Ram 45 45 74 164 | 54.66666667
3 |Gagan 25 84 84 193 | 64.33333333
4 |1ohn 62 55 99 216 | 72
5 |Arshid 45 65 64 174 58

6 :

Fig 5.9: Example of filling Percentage formula in a group of cells
5.2.1.4 Using caret (*) operator:

This operator is used to find the power of any given value. This operator is applied between two
operands. Such as, if this operator is applied as =A”B, then it will calculate A®. For example, if
=23 is written then 2° become 8 and it would be return as a result. Let’s understand the use of
this operator in MS Excel. This is an alternate of POWER function of MS Excel.

A B C D E
1 Value Power Formula Result
2 - - =472 16
3|3 2 =A37B3 9
4 |- 3 =2AB4 8

5
Fig 5.10: Example of caret ( * ) Operators
5.2.1.5 Using ampersand (&) operator:

This operator is used to join two string values. This operator can be applied on text data values
only. We can use more than one ampersand (&) operators within a single statement. We can
write & operator between two string values to operate upon. This is an alternate of
CONCATENATE function of MS Excel.

A B = D
1 String1l String 2 Formula Result
2 Ram Singh =A2&B2 RamSingh
3 Ram Singh =A3&" "&B3 Ram Singh
4 John - =A4&" smith" John smith
5 |- - I="Computer"&" Science"” IComputer Science
6

Fig 5.11: Example of ampersand (&) Operators

Note: CONCATENATE function joins the given strings without adding anything before or
after the given strings. No blank space or other symbol like comma or dot will be added.
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5.2.2 Using Functions:

We have already discussed that a function is a predefined formula that performs calculations
using specific values. MS Excel includes many functions that can be used to perform required
calculations over given value for a range of cells. We can classify functions in several categories.
In this section of chapter, we will read about some main categories of functions in MS Excel.

Let’s study about the common types of functions in detail.
5.2.2.1 Mathematical Function
These functions are mainly used for mathematical calculations. Such as:

I. SUM Function: This function is mainly used for finding the sum of values provided

in given cells or range. We can use this function as:

=SUM (<values for finding sum>)

A B C D E F G H
T Nol No2 No3 Nod4 No5 Nob Function Result
22 4 s 8 6 9 |=sum(a2F2) |34

3
Fig 5.12: Example of SUM function

II. COUNT Function: This function can be used to count the number of cells that contain
numbers. It will leave the cells having non-numeric values from being counted. We
can use this function as:

=COUNT/(<values to be counted>)

A B « D E F G H
1 Nol No2 No3 Nod4 No5 Nob Function Result
S D 4 B A 9 =COUNT(A2:F2) |3

3
Fig 5.13: Example of COUNT function

ITII. COUNTA function: This function can be used when we want to count all the cells
having any type of contents. Only those cells will be left from counting in a range that
are empty. We can use this function as:

=COUNTA (<values to be counted>)

A B C D E F G H
1T Nol No2 No3 Nod4 No5 Noé6 Function Result
22 4 B A 9 =COUNTA(A2:F2) 15

-
. Fig 5.14: Example of COUNTA function
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IV. COUNTBLANK function: This function can be used to count only the blank cells in
arange selected. We can use this function as:

=COUNTBLANK (<values to be counted>)

A B C D E F G H
1 Nol No2 No3 Nod4 No5 Nob Function Result
2 [2 4 B A 9 |=COUNTBLANI<(A2:F2) ll
3

Fig 5.15: Example of COUNTBLANK function

AVERAGE Function: This function can be used when we want to get the average

(arithmetic mean) of the specified group of cells or range. We can use this function

as:
=AVERAGE (<values to find average>)
A B C D E F G H
1 Nol No2 No3 Nod4 No5 Nob Function Result
2|12 4 8 6 5 9 |=AVERAGE(A2:F2) |s.e666666
3

Fig 5.16: Example of AVERAGE function

VI. MIN Function: This function will be used when we want to find the minimum number
from a group of cells or range selected as a result. We can use this function as:

=MIN(<values, out of which minimum no is to find>)

A B = D E F G H
1 Nol No2 No3 Nod4 No5 Nob Function Result
2 [2 4 8 6 5 9 |=MIN(A2:F2) 2
3

Fig 5.17: Example of MIN function

VII.MAX Function: This function will be used when we want to find the maximum

number from a group of cells or range selected as a result. We can use this function as:

=MAX(<values, out of which maximum no is to find>)

A B C D E F G H
T Nol No2 No3 Nod4 NoS5 Nob Function Result
22 a4 8 6 5 9 [=MAX(A2:F2) o
3

Fig 5.18: Example of MAX function

VIII. RANK Function: This function will provide the rank to the selected cell or value
within a selected range. We can use this function as:
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=RANK (<group of all values> , <value whose rank is to find>)

A
Nos

=

Formula

Result

[a~ [-RANK(A2,5A52:5A512) |8

1
2
3
4
5
6
7
8

9
10
1
12
13

rm:awmmmuum

=RANK(A3,5A52:5A512)
=RANK(A4,5A52:5A512)
=RANK(A5,5A52:5A512)
=RANK(AG,5A52:5A512)
=RANK(A7,5A52:5A512)
=RANK(A8,SAS2:5A512)
=RANK(A9,5A52:5A512)

NNGOULEO®

|

=RANK(A10,5A52:5A512) 8
=RANK(A11,5A52:5A512) 2
|=RANK(A12,5A52:5A512) 8

Fig 5.19: Example of RANK function

IX. LARGE Function: This function will give the Nth Largest no from a group of cells
or range. We can use this function as:

=LARGE (<group of all values> , <value of N to find Nth largest No>)

A B

1 Nos Formula

L]
Esy

&S 0 B W0 0L B WU

=LARGE(SAS2:5A512,1)

=LARGE(SA$2:5A512,2)
=LARGE(5A$2:5A512,3)
=LARGE(5AS2:5A512,4)
=LARGE(SAS2:5A512,5)
=LARGE($5A$2:5A512,6)

Fig 5.20: Example of LARGE function

X. ROUND Function: This function is used to round a number to the given numbers of
digits. If we give number of digits in negative then it will round the number before
decimal point with 10s. We can use this function as:

88

[, A -SSR TV S TP

=ROUND (<value>,<significance of round off>)

A B
Nos Formula
476584 =ROUND(A2,2)
4.54341 =ROUND(A3,2)
4532.652 |=ROUND(A4,-2)

Result
4.77
4.54
4500

Fig 5.21: Example of ROUND function
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5.2.2.2 Conditional Functions

These functions are used to perform calculation based on some condition. We can use any of the

comparison operator within these functions. Some of the conditional functions are as under:

I.  IF Function: This function is used to perform some particular operation based on a

comparison operator. It’s main function is decision making within MS Excel worksheet.

We can have some of the use of this functions as shown in fig. 5.21

Simple Use of IF Function: IF Function can be applied simply by giving one comparison

operator and based on that operator, two different operations or values can be given.

Such as:

A B C
1 Marks Formula Result
2 |65 =IF(A2<40,"FAIL","PASS") |PASS
B 25 =IF(A3<40,"FAIL","PASS") FAIL
4 45 =IF(A4<40,"FAIL","PASS") PASS
S 90 =IF(A5<40,"FAIL","PASS") PASS
6 (33 =IF(A6<40,"FAIL","PASS") FAIL

Fig 5.22: Example of Simple if Function

Using Complex conditions used in IF Function: IF function can also be used for any

complex operation to be applied in MS Excel. For example, we can use this type of IF

function for providing Grades in a Result Sheet. i.e. A,B,C or D.

Marks

B C

Formula Result

65

=IF(A2<40,"D" IF(A2<60,"C" IF(A2<80,"8" "A")))  |B

25
45
90
33

S Oy o BW N =

=IF(A3<40,"D" IF(A3<60,"C",IF(A3<80,"B","A")))
=IF(A4<40,"D" IF(A4<60,"C" IF(A4<80,"B","A")))
=IF(A5<40,"D" IF(A5<60,"C",IF(A5<80,"B","A")))
=IF(A6<40,"D" IF(A6<60,"C",IF(A6<80,"B","A")))

o > OO0

Fig 5.23: Example of complex IF function
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II. SUMIF Function: We can find the sum of any specific value from the given range or

group of cells by using this function. We can use this function as:

=SUMIF (<group of values>, <value as a criteria>)

A B C
1 Nos Formula Result
2 [4 =SUMIF(A2:A12,8) |24
5

w

R - - T T -

Fig 5.24: Example of SUMIF function

III. COUNTIF Function: We can count the number of cells having any specific value

from the given range or group of cells by using this function. We can use this function as:
=COUNTIF (<group of values> , <value as a criteria>)

A B C
os Formula Result
=COUNTIF(A2:A12,8) |3

r

0~ U oha W -

w

10
1n
12

12

Fig 5.25: Example of COUNTIF function

N
a4
5
4
7
5
8
8
9
4
8
4

5.2.2.3 String Functions

These functions are used on text data only. There are lots of different operations which are
generally required to be performed on text data. Let’s discuss some of the string functions these

are being used in MS Excel:

I.

9 ®

LEN Function : This function is known as Length function. We can find the no of
characters including spaces and symbols within a string using this function. We can
use this function as:

=LEN (<String value>)

A B C
1 String Formula Result
2 [PERSONALITY  |=LEN(A2) [11

3
' Fig 5.26: Example of LEN function
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II. LEFT Function: We can have left part of string for any length provided by the user
with the help of this function. We can use this function as:

=LEFT (<String value> , <length in numbers>)

A B C
1 String Formula Result
2 |PERSONALITY =LEFT(A2,8) PERSONAL

3

Fig 5.27: Example of LEFT function

ITII. RIGHT Function: We can have right part of string for any length provided by the
user with the help of this function. We can use this function as:

=RIGHT(<String value> , <length in numbers>)

A B ©
1 String Formula Result
2 |PERSONALITY  |=RIGHT(A2,8) |SONALITY

3]

Fig 5.28: Example of RIGHT function

IV. MID Function: In case, when a part of string is required the specific character from
the middle of string to the specific number of characters of a string, then this function is
used. We can use this function as:

=MID (<String value> , <Starting position>,<required length>)

A B =
1 String Formula Result
2 |PERSONALITY [=MID(A2,4,5) |SONAL

&

Fig 5.29: Example of MID function

V. LOWER Function: This function of MS Excel will convert the characters of whole
string to the lower case. We can use this function as:

=LOWER(<String value>)
A B C D
1 String Formula Result
2 [Computer I=LOWER(A2) lcomputer

=

Fig 5.30: Example of LOWER function
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VI. UPPER Function: This function of MS Excel will convert the characters of whole string
to upper case. We can use this function as:

=UPPER (<String value>)
A B C [
1 String Formula Result
2 |Computer |=UPPER(A2) NCOMPUTER

3
Fig 5.31: Example of UPPER function
VII. PROPER Function: This function of MS Excel will change the case of whole string.

The first letter of each word would become CAPITAL and all rest of the letter will become small
after using this function. We can use this function as:

=PROPER (<String value>)

A B C
1 String value Formula Result
2 |THis STRing is NoT proPER =PROPER(A2) This String Is Not Proper
3 |COMPuter =PROPER(A3) Computer

4 [This is very USEFUL FuncTION |=PROPER(A4) [This Is Very Useful Function
5

Fig 5.32: Example of PROPER function

VIII. TRIM Function: Trim Function is used to delete th extra space from the string. This
function will not delete the single space between the words and will delete all the extra leading
and trailing spaces in the string.

=TRIM (A2) = TRIM (<String value>)

String Value Formula Result
This string is very useful Trim (Aj) This string is very useful
Fig 5.33
5.2.2.4 Date Functions:

These functions are special ones which are used to manipulate dates in MS Excel. We can use
several functions for different purposes. Let’s understand these functions with examples.

L TODAY Function: This date function would return the system date as a result. The
format of date appeared can depend upon the system setting for Date and Time option. We can
use this function as:

=TODAY()
A B &
1 |[Formula Result
2 |=TopAy() | 6/24/2021
3 (System Date)

Fig 5.34: Example of TODAY function
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IIL. NOW Function: This function will return the date of a system in conjunction with the
current time. This time will be updated automatically when the sheet is opened or the formula is

refreshed by editing it. We can use this function as:

=NOW()
A B C
Formula Result
=NOW() 6/24/2021 18:13

(System Date & Time)

» W N =

Fig 5.35: Example of NOW function

III. DAY Function: This Function will return only Day part of the date given as an argument.
We can use this function as:

=DAY (<date value>)

A B
1 Formula Result
2 |=DAY(TODAY()) |24

3
Fig 5.36: Example of DAY function

Iv. MONTH Function: This function will return only Month part of the date given as an

argument. We can use this function as:
=MONTH (<date value>)

A B €
Result

Formula
2 |=MONTH(TODAY()) 6
2

Fig 5.37: Example of MONTH function

V. YEAR Function: This function will return only Year part of the date given as an argument.

We can use this function as: =YEAR (<date value>)
A B |
1 Formula Result
2 |=YEAR(TODAY()) | 2021

3
Fig 5.38: Example of YEAR function
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5.3 SORTING AND FILTERING DATA

Sorting and Filter are very useful option of MS Excel. Both options are having their own
importance. We will discuss both these options in this section.

5.3.1 Sorting Data

By the mean of sorting data in MS Excel, we refer to rearranging the rows based on the contents
of a particular column. We may require to sort a group of data to keep it in an ordered manner.
The process of sorting data in MS Excel can be applied in different ways. Let’s discuss the
common methods as under:

Sorting using Home tab ribbon:

This is a simplest form of sorting data in MS Excel. In this method of sorting data in MS Excel,
the selected data is being sorted in the particular order using last column of the selection. We
cannot manage multiple columns in this method of sorting. To apply sorting we can use following
steps.

1. Select the required data to be sorted.
2. Click “Sort & Filter” button from Home tab ribbon.
3. Select the sorting order from the Dropdown menu appeared.

Our selected data would be get sorted.

A | B | C { D | A B C D
1| SrNo Name  Subject Marks 1 SrNo Name  Subject Marks
2| 5 Ram  English 2% 2| 'S Ram  English x|
3 6 Sunil Math &6 | By| O 3 4  Harish  Science 34
4| 4 Harish Science 34 | . <~ 4| 1 John  Scence 37
S| 8 Yatn  Math 85 | Fite = Seect~ S| 7  Yogesh English a2
6 3 Aman  English 95 | "‘ Sl et b Ty 6| 9 Neeraj Math 65
7| 7  Yogesh English 42 | ’*1 :"m“k""““ | & senl  Math 6
8| 9 Neeraj Math 65 | o 8| 8 Yain  Math 85
9| 1 John  Science 37 | My 2 Smith  Scence 85
10| 2 Smith  Science 8 | Y 10| 3 Aman  English 95

Fig 5.39: Example of Sorting using Home Tab Ribbon

Here, we can see that the selected data has been sorted in ascending order according to the
Marks column i.e. Last column of selection.

Sorting Data using Data Tab:

If we want to sort this data according to Subjects then we have to use another method. We can

A

1 N

2 5

3 6 — X = St T X
s I | Clear

a| a W Y S B | i i) B ] @ e

5 8 \;‘m Fltar |0 P Textt Column Order
= Vo Advanced | colun Sort by [l [awz -

6 B Sort & Filker ’

7 7 9 sort i it

8 'D 7 Find values quickly by sorting your |/

9 1 data.

L2 | 8 | | © Tamenoe ) =

Fig 5.40: Example of Applying Sorting from Data Tab Ribbon
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After this process, when we press OK button then the selected data will be sorted according to
Subject column in an ascending manner. The data after this sorting will look like this:

A B C D
1 SrNo Name Subject Marks
2 5 Ram English 25
3 3 Aman English 95
4 7 Yogesh  English 42
5 6 Sunil Math 66
6 8 Yatin Math 85
7 9 Neeraj Math 65
8 4 Harish Science 34
9 1 John Science 37
10 2 Smith Science 85

Fig 5.41: Output of Applying Sorting from Data Tab Ribbon

Here, our data is sorted as per our selection i.e. according to Subject column. But we can have
further requirement to sort our data according to Name when the Subject remain same in the
given order. For this purpose, we can use option of adding multiple columns in our sorting
dialog box as shown below:

5ot by [Sutjea

@

R B C D

1 SrNoe Name Subject Marks
2 3 Aman English 95
3 5 Ram English 25
4 7 Yogesh  English 42
@ 9 Neeraj Math 65
6 6 Sunil Math 66
T 8 Yatin Math 85
8 4 Harish Science 34
9 1 John Science 37
10 2 Smith Science 85

Fig 5.42: Example of Applying Sorting according to multiple columns

Now, the result is sorted by subject in an ascending order. But, when the subject column remains
same then further our data is sorted according to Name column in an ascending order.

Note: if column names are not shown in the column list of Sort dialog box, make sure we
checked “My data has headers” option at top right of the box. This option will make first row
of our selection as column names. If it is not checked then columnl, column2, . ... will be
displayed in the place of column name in column list.
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5.3.2 Filtering Data

Filter option of MS Excel can be used to selectively show our data in a worksheet after hiding
particular parts of unwanted data. This option of data manipulation is very important to the
applications point of view because we can have only data of our interest rather than the whole
data. For example, from a data of all students and all subject, we can filter only one needed
subject from the data to be displayed. We can use this option as under:

1. Prepare our data as per the availability of different options.
2. Select the data to be filtered.

3. Select “Filter option”from Data Tab Ribbon.

4

Filter Option will be applied as shown below:

EEER B C B

1| SrNo Name  Subject  Marks A B L D

2 5 Ram English 25 1| SrNo _Name _Subject . Marks .
: 2 5  Ram 25

3 6  Sunil Math 66 % a - 3

U - S E D 2 R -

5| 8 VYatin  Math R e gl et =

6 3  Aman  English 95 e — . 2 = =

o [of] e (3 | Tt o ilgseng foe thie selected 6 3 Amz i 23 a5
7| 7 Yogesh English 42 == e =
8| 9 Neeraj Math 65 | |} 2 f wevemmmm@™ ! gl 9 Nee 65
s \ B | CE) o

9 1 JOh‘I'I Sc!em:e 37 | ¥ | 9 1 John auietiue 37

10] 2 Smith Science 85 O Tamemore 10 2 Smith Science 85

‘L 1

Fig 5.43: Example of Applying Filter Command
Filtering by Data Items:

As we can see in the figure shown above, an arrow option will start displaying with each selected
column. We can click on any of the particular arrow of required column to filter our data according
to which the selection is to be made. We can use different options for filtering. Such as, we can
select the require data from the list by ticking only particular values selected for a particular
column. The list of all distinct values will be shown automatically in this dialog box.

A B © D A B C 5]
1| SrNo _Name _Subject . Marks . 1| SrNo _Name _Subject , Marks _
2 5 Ram 25 3 6 Sunil Math 66
3 6 Suni 66 5 8 Yatin Math 85
4 4 Hari - 34 8 9 Neeraj Math 65
5 8 At Re— 85 11
6| 3 Ams — os B
7 7 Yoge 42 13
8 9 Nee — 65 14
9 1 John JuenLe 37 15
10 2 Smith Science 85 16

Fig 5.44: Example of Filtering using List Items
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As we can see in above result, only those rows are displaying which are having only math value
within a select column i.e. Subject.

Filtering according to range of data:

Using this option of filter, we can have all the rows as a result of filter which are having data
value in a particular range of data. In the data selected, we will apply this option on Marks
column. We can use this option as follow:

| A B G D E |
@ 1 Sr No _ Name _ Subject . Marks
1 81 Sort Smaliest to Lasgest
2 5 Ram R ri——
T = 1 1 Sorg by Color
3 6 Sunil Matis oo rine from run
| | = , :
4 4 Harish Scie| == 0 =
T 1 1 [Search 0| Coes bict Equal.
5 8 Yatin Mat il R——
i { = eater Than Or Equal To
A s Than
6 3 | Ama n Engl} g:: | :ou Than Or Egual To...
7 7 'Yogesh Engl e —
| 23 s
8 9 Neeraj Mat : = |
| | R | L o (ES.Coness : Custom Fiker.
9 1 John Science >7
10 2 Smith Science | 85
Custom AutoFilter  § X
Show rows where:
Marks
is greater than or equalto |v 50 ~
®ana Oor
is less than or equal to v 80

| Use 7 to represent any single character
Use * to represent any series of characters

Fig 5.45: Example of Filtering using Custom Auto filter Option

As we can see, a new dialog box “Custom AutoFilter” appeared. We can create required filter as
one or two conditions with different options and using “and” , “or” operators between those
operators. As we have selected greater than or equal to 50 and less than or equal to 80 as our
filter criteria. The result will be as per shown below:

A B & D
1 SrNo .Name _ Subject _ Marks ,
3 6 Sunil Math 66
8 S Neeraj Math 65

1

Fig 5.46: Result of filter used as a custom auto filter
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Filtering by color:

Sometime, we are having our data highlighted with different colors and we may require to filter data
according the colors. Both fill color and text color can be used for this option. We use this type of filter
by choosing “Filter by color” option from filter menu and then clicking the particular color. Such as:

A B C D A B C D
1 SrNo _ Name Subject . Marks 1 SrNo _Name , Subject Marks .
2 I English 25 2 5 Ram English 25
3 ‘|Math 66 B 4 Harish Science 34
4 T2 34 8 9 Neeraj Math 65
5 . 85 9 1 ohn  Science 37
6 English 95 ‘ 11
7 English 42 12
8 ______Math 65 13
9 I JurHL Science 37 14 |
10 2 e 85 15 |

Fig 5.47: Example of Filtering using Color

As we can see, only those rows are selected for display which are having selected color (Yellow) as a
fill color in that particular column.

Note: Filter on color can be applied on one color at a time. We cannot apply multiple colors
for one filter.

5.4 WORKING WITH DATA TOOLS

We have already studied very tools being used in MS Excel. All these tools are on the top to
their user point of view. MS Excel provides some more advanced data tools too which can be
used in some special type of operations. Let’s have a look over these tools.

1. Text to columns: This option of MS Excel can be used to split our contents according
to a fixed length or any particular symbol (like comma or space or any other) into
different cells. This option can be applied by using “Text to Columns” option from Data
Tab Ribbon after selecting the cell having contents to be split. Such as:

A Colamas Fil Dupbcates Vekda

1 VRam,Sham,Inder,Mohan
2

Fig 5.48: Example of applying Text to column option
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We can see, our contents are showing in the 2 of 3 step in different columns. We can change the
delimiter if these are not in required manner. Then go to Next step and press finish after selecting the
required data format.

| Convert Text to Columns Wizard - Step 3 of 3 ? X

This screen lets you select each column and set the Data Format.

Column data format
‘.i" General

O Text ‘General’ converts numeric values to numbers, date values

10 dates, and all remaining values to text.

O pate: MDY v Advanced...
(© Do not jmport column (skip)
Destination:  SAS1 2
Data preview
Censzlbenszalbensral
Fham Inder Mohan
< >
| R
A B (] D E
1 |Ram Sham Inder Mohan
2
3

Fig 5.49: Finishing Text to column option and output

Now, as we can see, our selected cell contents have been copied into different cells based on comma
delimiter.

Note: We can use more than one delimiter to be applied for text to columns option.

2. Remove Duplicates: This option of MS Excel can be very useful when any of our cell is
having values written for more than one time and we have to create a list with all the values
exactly once. We can do this by using this option of Data Tab Ribbon. We can use “Remove
Duplicates” option from Data tab ribbon after selecting the cells to do the needful.

A D -
A B 1 Name  Marks
1 |Name  Marks 2 |Ram 45
2 |Ram 45 3 |Sham 62
3 |Sham 62 4 |Mohan 25
4 |Mohan 25 B = o 5 |Sohan 52
5 |Ram 45 Remove Data  Consolidate . . . 6 |Sunil 62
Duplicates Validation | Remave Duplcates rox
6 |Sohan 52 Data Tools | Yﬂ:’_’"m"""_'" """""""" ;71 e Bl bt 7
i Todedn | [5 umeietan by dola bia honén
7 |Sunil 62 ‘ Remove Duplicates » | . 8
8 |Sham 54 Delete duplicate rows from a sheet. e 9
9 |Mohan 52 ¥ou can pick which columns 1 . 10 J“‘:'"" x
should be checked for duplicate | A o T ] At S e kot e |
10 [Ram 25| H fometon Pl | — " | .

Fig 5.50: Example of removing duplicate values
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Note: In some cases, we have duplicate values in one column but these are associated with another
column for their uniqueness to be considered. We can apply this feature on more than one column also
to have uniqueness based on multiple columns.

3. Data Validation: This option is very useful in those cases where we have any column in
which only some particular values are allowed to be entered. For example, we can apply this feature
on marks column where the marks must be in the range of 1 to 30. If the value entered does not
meet the given criteria, a specific error message will be displayed. We have several options regarding
this tool of MS Excel. We can apply this tool by selecting Data Validation option from Data Tab
Ribbon after selecting the required column or cells.

v = ey < CR e
A B ® =] -
Marks Data  Consolidate = 7] Bt o
 Validation ~ S :
‘ 54 Data Validation... = "
E Circle Invalid Data o +
S Clear Validation Circles o e

Fig 5.51: Example of applying Data validation

As we can see in the figure shown above, if the value (like 36) given out of specified set of values
then given error message will be displayed. We can leave the cell blank either. If we do not want to
allow blank cells too then untick the “ignore blank™ checkbox on setting tab of Data Validation dialog
box.

Note: We can also add input message for our data validation applied cells to tell the user
about given criteria of valid values for that particular cell.

POINTS TO REMEMBER

1. Function is a predefined formula that performs calculations upon specific values in a
particular order.

2. We can have SUM, AVERAGE, COUNT, IF, SUMIF, COUNTIF as examples of
functions available in MS Excel.

Formula is an expression that calculates values in a cell or in a range of cells.
A formula can be designed using any type of operator. Such as =A1+10.

Each formula and function must begin with equal to (=) sign.

SN s W

Operators are the symbols which represent a particular operation to be performed in a
particular application. Arithmetic, Comparison, Reference are some examples of MS
Excel operators.

7. Examples of Arithmetic operators are +,-,/,*, % , .

8. Examples of Comparison operators are = ,>, >=, <, <=, <>.
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10.

11.
12.

13.

14.
15.

16.

17.

18.

19.

The way of representing the cell addresses within a formula or function is called “Cell
Referencing”.

Absolute referencing, Relative referencing and Mixed referencing are some of the examples
of cell referencing.

Each expression of formula can be represented as a combination of Operators and Operands.

Operator precedence is the order of execution of operators when multiple type of operators
are used within a same statement.

Main categories of functions in MS Excel are Mathematical Functions, Conditional Functions,
String Functions, Date Functions.

IF, SUMIF and COUNTIF are some examples of Conditional Functions in MS Excel.

Sorting is acommand used for rearranging the rows based on the contents of one or more
particular columns.

Filter option of MS Excel can be used to selectively show our data in a worksheet after
hiding particular parts of the unwanted data.

Text to columns option of MS Excel can be used to split our contents according to a fixed
length or any particular symbol into different cells.

Remove Duplicates option of MS Excel can be very useful when any of our cell is having
values written for more than one time and we have to create a list with all the values exactly
once.

Data Validation option is very useful in those cases where we have any column in which only
some particular values are allowed to be entered.

EXERCISE

Que:1 Multiple Choice Question :

I
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Each function or formula must start with symbol in MS Excel.

A+ B. =

C. & D.»

Which function of MS Excel can be used to find minimum numbers from given range?
A. MINIMUM B.MID

C. MIN D. None of these
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I  Ampersand (&) symbolisanlternateof _ function in MS Excel.
A.SUM B. AND
C. CONCATENATE D.POWER

IV Which data tool can be used to have only distinct values in a particular column?
A. Data Validation B. Text to Columns
C. Formula D. Remove duplicates

V  Which one is an example of Arithmetic Operator?
A+ B. %
C. A D. All of these

Que:2 Write True or False:

I We cannot count blank cells in MS Excel.

I Formulais an expression of operators and operands to perform calculations.
I SUM function can be used to perform addition of values in a particular range.
IV Text to columns option can be used to split our contents in multiple cells.

V  NOW function returns current data and time in MS Excel.

Que:3 Short Answer Type Questions:

Write arithmetic operators being used in MS Excel.
What do you mean by Data validation?

Give the name of any three mathematical functions.

What is sorting in MS Excel?

< 2 =7

Define formula.

VI. Provide the name of various conditional functions used in MS Excel.
Que:4 Long Answer Type Questions:

I Whatis Cell Referencing? Explain its types.

I Define any 3 String Functions.

I Whatis Function? Explain any two mathematical functions with suitable example.
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| Lab Activity |

1. Apply all the given formulas or function in MS Excel and write the output:

=SUM(34,45,67,65,34)

=MIN(54,67,1,34,67,1,2,1)

=COUNT2,4,6,A,3,D,A,5,6)

=COUNTA(2,4,6,A,3,D,A,5,6)

=LEN(“I LOVE COMPUTER”)

=MID(“MYSELF”,3,3)

=RIGHT(“AUTOMATIC”,S)

=NOW()

=TODAY()

=“MY”&” “SELF”

=“MY”&” “&“SELF”

=PROPER(*“I aM a GOOD stUDent”)

=SUM(3,4,5)+LEN(“GOOD”)

=4"3

=MIN(3,9,8,0)+MAX(0,5,2,4)
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2. Enter the required formulas in ‘“Detail Marks Card” prepared in chapter 4 as shown

below.

GOVERNMENT SENIOR SECONDARY SCHOOL
CITY NAME
DISTRICT NAME

Detail Marks

Card

Pre-Board Examination

Roll No 30 Student ID 258965
Name of Student KAMALPREET
Father Name SHIVPREET
Mother Name NAVLEEN
Class: 9TH Date of Bith 27/08/2006 Section B
UID No 4528-6985-4587 Gender MALE
Detail of Marks Obtained
I o : =
. £ = 3
2 : s 2 -
= Subject = | 8 » < ® | Remarks
. = a =
1 |ENGLISH 100 40 45 45 D
2 |PUNJABI 100 40 63 63 C g
m
3 |HINDI 100 40 56 56 D 3
4 |SCIENCE 100 40 45 45 D §
5 |[MATH 100 | 40 | 88 | 39 S
6 |SOCIAL SCI 100 40 62 62 o
7 |ICOMPUTR SCI 100 40 45 45 D
8 |OPTIONAL 100 40 52 52 D
9 |WELCOME LIFE 50 20 44 88 B
TOTAL MARKS 359
Maximum marks Secured F 88
Minimum marks Secured 45
(Grade: 0-40: E,40-60:D, 60-80.C, 80-90:B, 90-100: A)
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Microsoft Excel (Part-4)

,_{ Objectives of this Chapter:}
6.1 Setting Page Layout in MS Excel

6.2 Working with different views in MS Excel
6.3 Protecting Sheet and Workbook.

INTRODUCTION
We all have become able to prepare any kind of MS Excel worksheet with rich formatting, Data tool,
Functions and formulas and other kind of operation needed to represent our data in required style. In
this last chapter related to MS Excel, we are going to learn about Page layout and security options used
for our workbook. This is very important chapter because all these objectives related to this chapter
are concerned with finalizing MS workbook to be printed or shared. Let’s understand all the related
tools in detail.

6.1 SETTING PAGE LAYOUT IN MS EXCEL

These options or tools being used in MS Excel are mainly concerned with printing of our worksheet.
Page Layout tab provides some commands which let us control the way our content will appear on a
printed page. These commands may include several options like Margin, Page orientation, Paper size,
Print area, header/footer and other printing related tasks. Some of the page layout options, such as
print titles and page breaks, can help make our workbook easier to read. We can explain these tools in
details as follows:

6.1.1 Margin
Margins are the empty

Header Margin

space between the w
worksheet data and the i LA
left, right, top, and

bottom edges of the St

printed page. We can . |1d I
adjust margin to add S Vet e Tl | - Right Margin

more or less space

around user contents
on all the sides. We
can understand

Bottom Margin

Footer Margin

different margins a

under: S Fig 6.1 Different types of margins in MS Excel
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We can remove any of the margins shown above by setting as zero for its value. Let’s understand the
different ways to manage Page Margins in MS Excel.

6.1.1.1 Setting Margins:

We can change any of the margin according to our requirement in MS excel. We can change margins
from Page Layout Tab as described below:

Applying standard margin:

This is a simplest and fastest method of setting the margins in MS Excel. There are some pre-
defined margin templates to be applied. We can use Margin option from Page Setup group in
Page Layout Tab.

Insert Page Layout Formulas Data

B 5B E

{@rientation Size  Print Breaks Ba

v v Area~ v
Last Custom Setting |
Top: 0.39° Bottom: 033" |
Left: 0.25° Right: 0.25"
Header: 0.3 Footer: 0.3°
17 Normal |
Top: 0.75° Bottom: 0.757
| Left: 0.7 Right: 0.7°
Header: 0.3 Footer: 0.3°
I R Wide
[ Top: 1" Bottom: 1~
Left: 1" Right: 1°
Header: 0,5 Footer: 0.5
£
R Narrow
Top: 0.75° Bottom: 0.75" |
Left: 0.25° Right: 0.25"
Header: 0.3° Footer: 0.3°

J Custom Margins... .'|

Fig 6.2 Pre-defined Margins of MS Excel
We can see in the figure above, some of the margin templates are:

i. Last custom setting: We can apply any size for margins in MS Excel using “Custom
Margins” option at the bottom of margin menu. Once we set any margin using this
option, the user given margins become the sizes of this template and we can apply the
same margin for any of the other worksheet with this option.

iil. Normal: This is the default margin for every MS Excel Worksheet. It is having top
and bottom margin as 0.75". Left and Right margins in this template are 0.7". Header
and Footer margins are pre-defined as 0.3" in size.
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iii. Wide: Thisis the largest size template for margins of MS Excel Worksheet. It is having all
the margins pre-set as 1" but the Header and Footer margins are pre-defined as 0.5" in size.

iv. Narrow: This is the template with smallest sizes for margins in MS Excel. Itis having top
and bottom margin as 0.75". Left and Right margins in this template are 0.25" and Header

and Footer margins are pre-defined as 0.3" in size.

Once we click on any of these options, the selected size for margins will be applied to the current

worksheet of MS Excel workbook.

Note: If we are working in more than one worksheet of one MS Excel workbook then we have

to apply the margin setting for each sheet.
6.1.2 Orientation

Page Orientation refers to how output is to be printed on the page/pages. We can use our page
either in vertical or horizontal direction. MS Excel provides two orientations for our page. i.e.

Portrait and Landscape.

e (1) Portrait Orientation is used in the case when we have a report which is longer
than a page and less number of columns then we can use portrait orientation for

our page layout.

e (2) Landscape orientation option of Page Layout is very useful when we have to our

worksheet in wider format and number of columns are more to print.

Landscape

Portrait
We can use these options of MS Excel using following way:

Changing page orientation from Page Layout Tab Ribbon:

This is a very easy method of setting the page orientation in MS Excel. We can use Orientation
option from Page setup group in Page Layout Tab to change the page orientation in MS Excel.

Such as:
Page |La Lt Formulas Data Review
=l
’7)1...: “ .,;-:i-‘ ' | - ;.-' = ;‘
Orientation Size Print Breaks Background Print
- - Area ~ - Titles
] Portrait
- G -
1 Lands
| — RS SECONDARY SCHO(

Fig 6.3 Page Orientation option of MS Excel

MICROSOFT EXCEL (PART-4)

B 107




As we can see in the figure above, the menu appeared after selecting orientation option will
display both Portrait and Landscape option. We can choose any one layout from this menu. The
currently selected orientation will be displayed highlighted already in the menu.

6.1.3 Size

Size option of Page Layout Tab is used when we want to adjust

the contents of a worksheet on a specific size of paper. On the =~ p&—=y"" Dna‘a e | s
basis of amount of information and the layout size of our contents, [ E = a2 S|

. . . size |fPrint Sreaks Background Print
we can change different sizes such as Letter, A4, Legal, different |- el Titles
types of Envelops etc. To have our printing on a specific size of | L] ’ 857 :
follows.

A4
| u 8.27"x11.697

Executive
| 7.257x10.5°

paper with full page utilization we can change the size of paper as 1 E e
Changing Size from Page Layout Tab Ribbon: )
|

This method of choosing the required paper size in MS Excel is asx13

very fast and easy. We can use Size option from Page Setup s

group in Page Layout Tab to change the page orientation in MS [T sevaazr

Excel. It will display all the pre-defined options of Paper Size S35

available in MS Excel. We can see the menu appeared when we | O

choose Size Option from Page Layout Tab in the given figure. sk 195070

As we can see in the given figure, the menu appeared after 16K 184x260

selecting Size option will display all the size options to be used Ma::::i: =l

as a paper size. We can choose any one size from this menu. — '
The current selected Paper size will be displayed highlighted Fig 6.4
already in the menu.

6.1.4 Print Area

Sometimes, we may require printing of only a specific part of a worksheet. To make this task
easily, we can use Print Area option of Page Layout Tab. Once a print area specified, we can see
the printing contents and its layout can be viewed with the help of print preview.

Set Print Area :
This option of MS Excel Page Layout Tab will let us define a new print area. We can have our selected
area as a print area by following given steps.

e Select the required area to be marked as a print area.
e  Click of Print Area option of Page Layout Tab.

e A dropdown menu will appear. Select Set Print Area option from dropdown menu
appeared.
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Our selected area will be marked as print area. We can see how our printing will look like by using Print
Preview appeared after selecting Print Option of File Tab.
@9~ o-i= N "

anme Insert Page Layout Formulas Data
Aa n Colors = D Iin I T
...... @ch " Hl -.j
Themes Margins Orientation Size)
[EE =

Eda-o - A (IMEC Format - Mool sl -

---, Wi Tagriwsdl Remet Dea  feers v SENORackesdndl Vs ROF

Print
Area~

Themes PO 5 setPrintArea

A4 v {8 2 D*e_ Clear Print Arei

[= BT C 10 [ ETF [ 0 [N—

GOVERNMENT SENIOR SECONDARY SCHOOL
CITY NAME

Breaks Back

-

e
Frint
B teeds A
Gopies 1

Print Area
" 1 i 3t thed actual se
s | 1 [ENGLIEH 00|40 | 45 [ ¢5| D Buctsia
I >
« | 2 [PUNIBEL w0(d40 | 83|63 C E
4 | 3 |HND 0|40 |ss| 0| B

Fig. 6.5 Setting Print Area
As we can see in the Print Preview option, only the selected part or worksheet which is set as Print
Area s displaying as a printing content.
Clearing Print Area:
Once a print area is set in a worksheet, no other content will be printed for as long as print area exists.

If we want our whole sheet to print again then we can clear any existing print area using Clear Print
Area option of the same menu of Print Area of Page Layout Tab.

Note: If multiple regions are selected for print area then each of the different region will be
selected as a different print area and will be printed on different page.

6.1.5 Page Break

Page Break option of Page Layout Tab is very useful to split our contents to be printed among
different pages. Sometimes we see the page break option similar to the print area but both are
not same as when we insert page break at a location then it splits the whole worksheet as a
different page/pages from that point. All the contents remain printable but on different pages.
Print area on the other hand prints only the selected part of worksheet and all other contents are
skipped from being printed.

Page break is always inserted at top left corner of active cell. We can insert a page break using
following steps.

e Place the active cell accordingly to the desired location where Page Break is to be
inserted.

e  Click on Breaks option from Page Layout Tab.
e Select Insert Page Break from the menu appeared.
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After these steps, we can see the page break effect in print preview option.

-0 & Ok

| Fonts =
Themes — Marging Orientation Size  Prnfl |Breaks |Background Print
. feass | - . A s | Tithes

- B - Fage Set [ntest Page Sreak | gseat
- S| a0 Bemave Page Break

Reset A1l Page Breaks

] I I .
1 GOVERNMENT SENIOR SE

2 CITY NAME i
DISTRICT NAME i

Delail Marks Card

s Pre-Board Examinalion A v
& RollNo 30__ StudentID 258965 .
7 Name of Student KAMALPREET
& Father Name SHIVPREET
3 Mother Name NAVLEEN
10 Class:. 9TH  Date of Bith _ 27/08/2006 Sechion
u UID No 4528-6985-4587 Gender
13 Detail of Marks Obtained
E12(8)s¢
g _‘_m_j__ g | 2 § @
3 () a -

(_i ActiveCell | =
1 1 [ENGUSH ‘0\ 40 | 45 | 45 | D - v
“‘ 2 |PUNJABI 100 40 | 683 | 63| C E

3 |HINDI 100 | 40 | 56 | 56 | D (=]
17 =1
. 4 |SCIENCE 100 | 40 | 45 | 45 | D 3
W P W Sheett Sheet?  Sheet3 3
Ready

Fig 6.6 Applying Page Break

We can see in the Print Preview option, our contents have been split among 4 pages and contents of
first page are displaying in the print preview. We can remove existing page break with the help of
Remove Page Break option of the same menu of Break option of Page Layout Tab after placing our
active cell on the existing page break.

Note: If we want to remove all the page breaks existing in a worksheet then we can use Reset
All Page Break option of the same menu appeared after clicking Break option of Page Layout
Tab.

6.1.6 Scaling

Scaling refers to compress or expand the size of contents when printed on the specific paper
size. This option is very useful when we have to a large worksheet to be adjusted on one or
more pages when printed. We can also do vise-versa. i.e. A small content is to be expanded
over multiple pages. We can use this option using Print Preview Option as follows :—

Setting Scaling using Print Preview option

This option is very easy when we have to adjust our whole contents on page or one aspect
either row wise or column wise on one page. We can use this option by clicking Scaling option
displaying as a last option of Print Preview menu. Such as:
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Fig 6.7 Setting Scale option using Print Preview
As we can see in the figure above, there are some of the different options.

1. FitSheet on One Page: This option of scaling a worksheet on one page. It will reduce
the scaling percentage automatically as much as our contents become fit on one page.

2. Fit All Columns on One Page: This option of scaling will fit all the columns on one page.
It will reduce the scaling percentage as much as whole contents become horizontally fit on
one page. The vertical length of the contents can be on any number of pages.

3. Fit All Rows on One Page: This option of scaling will fit all the rows on one page. It will
reduce the scaling percentage as much as whole contents become vertically fit on one page.
The Horizontal length of the contents can be on any number of pages.

4. Noscaling: This option of scaling will reset the existing scaling to 100%.
We can select the required option of scaling and the print preview will be updated accordingly.
6.1.7 Setting Header and Footer

In the case when we require to add any particular content on the top or bottom of each page then we
can use this option of MS Excel. This option is very useful to add any important information like page
number, file name or any other custom message. We can use this option from Page Setup dialog box. In
this dialog box, Header/Footer Tab let us specify the required Header or Footer. we can use this
option as under:
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Page Setup [ & i
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Fig 6.8 Setting Header/Footer

In the Page Setup dialog box, we can use Custom hHeader or Custom Footer buttons to give a
custom message to be displayed at top or bottom respectively. By clicking any of the button,
respective Header/Footer dialog box will be opened. It will display three sections as Left, Center
or Right. We can add contents to be aligned according to any of these options. We have other

options like Insert Page Number, Inert Number

of Pages, Insert Date, Insert Time, Insert File

Name, Insert Picture etc. on this dialog box. We can add any of these options also as a header or

footer.

Page Setup

===

|| page. | margs | Header Foster | sheet |

|

deagier:

{none)
Page 1
Page 10f ?
Sheetl
Confidential, 6/27/2021, Page 1
| Suids (DMC Format)
Different odd and even pages

Different first page
| Scale with document
| Align with page margins

Brint..,

| PrntPrevies | | Opbonsi. |

Cox ][ conad |

Fig 6.9 Choosing pre-defined Header/Footer

Another option for header or footer is applying any of the header/footer from pre-defined template.
We can select required template to easily apply header or footer.

When we have given all the options for header
clicking OK button.

/footer, we can apply the header or footer by

6.1.8 Setting Page Layout using Print Preview Window

Page Layout settings can also be changed through Print preview window. We can change almost all the

settings from this window. When we choose Print opti
which also displays Print preview.
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on from File tab, then following windows appeared
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Fig 6.10 Setting margins using Print Preview

e Orientation:We can change page orientation when we print or seenthe print preview
of our worksheet. To apply page margins using this way, we can use print preview
option displayed when we go to print option of File menu. We can see the Page
Orientation option just above the Paper size option. Both portrait and landscape
options will displaywhen we click on this option. We can change the required
option and the changed page layout setting will be displayed in print preview

showing in the same screen.

e  Size:We can change page size also when we have finished the spreadsheet creation
and want to see the print preview of it. We can see the paper size option just above the
margin option. All the paper sizes will display when we click on this option. We can
change the required option and the changed paper size will be displayed in print

preview showing in the same screen.

e  Margin:In some cases, we may require to adjust the margin with the help of mouse.
To apply this way of setting margins in MS Excel, we can use print preview option
displayed when we go to print option of File menu. We can see the dotted lines in this
print preview window of print option. If these lines are not showing there then we can
press “Show Margins” button displaying at right bottom of the print menu. These
dotted lines can be moved with the help of mouse to adjust any of the margins being
displayed. When we change any of the margin such a way, the print preview will be

updated accordingly.

e Scaling:As we have discussed earlier in this chapter, Scaling is the process of
compressing or expanding the contents to be arranged on a specific page. We have
already discussed about this option in previous section of this chapter. We can change
any type of scaling we want from the scaling option shown as last option of Print

Preview Window.
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6.2 WORKING WITH DIFFERENT VIEWS IN MS EXCEL

View in any of the software refers to the way of how our working area in the application software
should look like. For example, when we start creating any worksheet in MS Excel then it is convenient
to see the maximum working area. It is also very important to have our work done in such a size and
layout that is able to be printed on desired number of pages. To keep all these things on track, we can
use following different views available in MS Excel. Each one of them are very important as they have
different methods to represent our contents. We can use them at any specific time in a same spreadsheet
to have best management on our contents to the printing point of view. Let’s discuss different views
available in MS Excel to have best use of it.

There are five different types of views available in MS excel.
1. Normal View (Default View) 2. PageLayout View
3. Page Break Preview 4.  Custom Views
5. Full Screen View

We can explain each one of these views as under:

1. Normal View: This is a default view of MS Excel. When we open MS Excel then it is automatically
displayed in Normal View. This view is the easiest view to use for managing data, creating formulas and
formatting rows and columns. In this view of MS Excel, all the rows and columns header are displayed
just adjoining to the respective row or column. This made it more easy to work with these because we
can easily identify the name of row or column. This view gives the best zoom level to work with. So, for
the purpose of creating a new spreadsheet or editing an existing spread sheet with best use of formulas
or functions, this view is very much useful. We can change our view to Normal view from the View Tab
ribbon. The option to activate this view is located as a first option on this ribbon. We can see our
spreadsheet in Normal view as under.

Suldii [DMC Format) - Microsoft Excel
Fiteo POF

A 5 c o B G © i i
;. GOVERNMENT SENIOR SECONDARY SCHOOL
2 CITY NAME

DISTRICT NAME

Rall No 30 StwdemiD 258988

7 Name of Studen! KAMALPREET
Father Name SHIVPREET

]
4
] Pre-Board Examinalion
(]
'

5 Mather Name NAVLEEN

1|Class 8T Date of Birth _27/08/2008 _ Section I —
LI UID No 452858854587 Gender MALE
1 Detail of Marks Obtained
—— Detail of Marks Obtain
e[ =4
o B =
< Subj ZElls (& Remarks
B = 5| 8|8 | % §
2| & |=
14
. 1 [ENGUSH 100| 40 |45 a5 | D
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Erady i
. .
Fig 6.11 Normal View
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2. Page Layout View: As we can understand from its name, this view is basically concerned about
displaying our contents page wise to have best layout of our contents on each page. We use this view
of MS Excel to add design elements to the headers and footers of a worksheet, such as company
logos, page numbers, document names, dates and times. These elements are not usually visible in other

view types, but will print with each page of the workbook. The main aim of using this view is to have
best

management of our spreadsheet on particular pages when printed. We can change our view to Page
Layout View from the View Tab ribbon. The option to activate this view is located as second option on
this ribbon. Our spreadsheet will look as follow when it is displayed in Page Layout View.

N 3 ]
(SN B R R - - Sukhi (DMC Format) - Microsoft Excel - ]
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Fig 6.12 Page Layout View

3. Page Break Preview: This view of MS Excel is mainly concerned with Printing of our
worksheet. This View is a very powerful print preview that allows us to manually move page
breaks and reorganize a worksheet into pages for printing. We can break off columns or rows in
exactly the best location by moving the blue lines which represent Page Break in MS Excel
2010. The arrangement of our contents on different pages will be exactly same as the sheet will
look like after printing. This View of MS Excel can be seen by selecting Page Break Preview
option of View tab ribbon which is located as third option on it. The screen will display as
shown in following figure when viewed in Page Break Preview.
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Fig 6.13 Page Break Preview

4. Custom View: We have discussed all the three views of MS Excel with having particular
importance of each other. But, if none of the views listed above is exactly what we are looking for,
MS Excel has added a further customizable view type, named Custom Views. This option allows
us to set the exact view and print settings we prefer and allows us to apply this view to other
worksheets, if required.

5. Full Screen View: This view of MS Excel can be used with any of the currently active view.
The main advantage of using this view is that it can be used for maximizing our work area by hiding
everything else. We can see just the work area of spreadsheet along with row or column headers
when the sheet is viewed in this view. Let’s have full screen from Normal view by clicking Full
Screen option of View Tab Ribbon.

Note: We can return to our previous view from Full Screen View by pressing ESC key from
keyboard.

6.3 PROTECTING WORKSHEET AND WORKBOOK

Protection in MS Excel refers to restrict our workbook or worksheet from unauthorized access.
For this purpose, we can:
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6.3.1 Protecting Worksheet:
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Protect Sheet option in MS Excel is used to safeguard the data in our worksheet with the help
of setting up a password in it. We can lock any row, column or cells from any of the operation
been performed by unauthorized person. To prevent other users from viewing hidden
worksheets, adding, moving, deleting, or hiding worksheets, and renaming worksheets, we
can also protect the structure of our MS Excel workbook with a password too. The method of
protecting a worksheet can be a series of steps to be performed. Let’s have a look on the
method of protecting a Worksheet in MS Excel.

When we are working with a worksheet, by default all cells are locked. It means that if we
protect the sheet as such, all the cells will become locked. If it is so then the sheet is not so
useful. To have best use in a protected sheet, we can unlock any group of cells. The unlocked
cell will be able to be changed even in protected sheet. We can use the values of these unlocked
sheets in the formulas in locked cells also. It will increase the usability of MS Excel Worksheet.
We can protect the sheet as follows.

As we can see in the given figure 6.14, some cells are highlighted with yellow color. We can
create a Detail marks card of any student by changing these yellow highlighted cells only. Rest
of the cells are either pre-defined or automatically calculated. So, to have the best use of this
excel worksheet is to protect it from any accidental change.

First what we have to do is, Unlock the highlighted cells. For this purpose, select the cells and
then launch format cell dialog box from Font group of Home tab ribbon.

Note: We can select multiple cells with different location by pressing the Ctrl key while
clicking on the cells.
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Fig 6.15 Unlocking the required Cells

As we can see in the figure above, In the Tab “Protection”, Locked option is checked for the
selected cells. To keep these cells unprotected even in protected sheet, remove the tick from this
option by clicking on it. Press OK button when the tick is removed.

Now, it is time to protect the sheet from unauthorized access. We can do this by selecting “Protect
Sheet” option from Review tab ribbon.

Protect Sheet [ER )
[¥] Protect worksheet and contents of locked cells
Password to unprotect sheet:
Algw allusers of ths worksheet to: P r——— [ 9 )
Fdlselectlocked cels |
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Fig 6.16 Protecting Sheet

the “Protect Sheet” dialog box will appear. As we can see in the fig. 6.15, Two options are
already checked which means that we can select any protected cell. No other operation can be
performed on protected cells. We can optionally give password to the protection option so that
no unauthorized person can unprotect it. When we press OK Button, it will ask the password
again to confirm. Fill the same password and press OK again.

Now our sheet become protected and no change is allowed other then those yellow highlighted
cells. This is the main use of this feature to restrict the sheet from being changed.
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Note: When a sheet is needed to be unprotected again, We can choose Unprotected Sheet option
which will be appeared on the place of Protect Sheet when the sheet was not protected. If we have
given password while we protected the sheet, It will ask for that password. Such as:
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Fig 6.17 Unprotecting Sheet

After giving correct password the sheet will become unprotected when we will press OK button.
6.3.2 Protecting MS Excel Workbook:

This option of MS Excel is also very useful to the protection point of view which can be used by
selecting a password to open an existing workbook of MS Excel. We can use Tool option of Save
As Dialog box for this purpose. Such as:
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Fig 6.18 Protecting Workbook
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After entering the password for both Open and/or Modify option, press OK button. Now Confirm
Password option will be appeared for both these passwords. After confirmation, the file will be saved
with protection option.

Opening a protected Workbook : When we open a protected workbook, A “password” dialog
box will appear to authenticate the user.

If authentication is successful then workbook will be opened, otherwise an error message will be

-
Password @lél

'Sukhi (DMC Format).xlsx' is protected.

displayed for the same.

Password:

[ OK ][ Cancel ]

Fig 6.19 Opening Protected Workbook

Now, we are capable enough to create a worksheet, applying formatings, creating own formulas,
using functions, inserting different objects and finally protecting our workbook or worksheet in
several types. We can use all these options to have best use of MS excel spreadsheet in our day-
to-day activities.

POINTS TO REMEMBER

1. Page Layout tab provides some commands which let us control the way our content

will appear on a printed page.

2. Margins are the empty space between the worksheet data and the left, right, top, and
bottom edges of the printed page.

3. Page orientation refers to how output is printed on the page. We can use either in

horizontal or vertical direction.
4. Two page-orientations are Portrait and Landscape.

5. Size option of Page Layout Tab is used when we want to adjust the contents of a
worksheet on a specific size of paper.

6. Page break option is very useful to manage our contents to be split among different
pages.

7.  Scalingrefers to compress or expand the size of contents when printed on the specific

paper size.

8. View in any of the software refers to the way of how our working area in the application

software should look like.
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9. There are mainly three views in MS Excel: Normal View, Page Layout View and Page
Break Preview.

10. Full Screen View of MS Excel can be used in any of these three views to have maximum
working area by hiding all the menus, ribbon and bars.

11. Protect Sheet option in MS Excel is used to safeguard the data in our workbook or
worksheet with the help of setting up a password in it.

12. Protect Workbook option of MS Excel is very useful to the protection point of view
which can be used by selecting a password to open an existing workbook of MS
Excel.

13. Header/Footer option is used to add any particular content on the top or bottom of
each page in MS Excel.

EXERCISE
Que:1 Multiple Choice Question :
I Which option belongs to Page Layout Tab?

A. Page Orientation B. Paper Size
C. Print Area D. All of these
I Which one is not a view in MS Excel?
A. Formula View B. Normal View
C. Page Layout View D. Page Break Preview
m is the empty space between the worksheet data and the edges of the
printed page.
A. Paper Size B. Print Area
C. Margin D. Print Preview
v appears on the top of each page in print preview and printed sheets.
A. Footer B. Header
C. Bottom Margin D. None of These
V  We can lock our cells from being accidently changed with the help of ___ Option.
A. Save As B. Save
C. Print Area D. Protect Sheet

Que:2 Write True or False:
I Workbook cannot be protected in MS Excel.

I We cannot remove Page Break once inserted.
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Page Orientations are of two types: Portrait and Landscape.

Margins can be on top, bottom, left, right header and footer of a page.

We can use Print Area option to print a specific part of a Worksheet.

Que:3 Short Answer Type Questions:

]

< 2 g =

What do you mean by Margin?

Write a short note on Page Orientation.
What do you mean byScaling?

Give names of views in MS Excel.

What is the use of Page Break?

Que:4 Long Answer Type Questions:

mi—(

What do you mean by Page Layout? Explain three Page Layout options.
Explain any two Views of MS Excel in detail.

What is Header and Footer? How will you apply Header and Footer in Excel?
| Lab Activity |

Design the given format of Detail Marks Card and Protect it in such a way that only yellow
filled cells are able to be selected or changed. Our active cell should not be entered in any
other cell.

Protect this workbook with a password to open it. The password to open this workbook
should be “LetsExcel”.

A B C (] E F G H i
1 GOVERNMENT SENIOR SECONDARY SCHOOL
2 CITY NAME
DISTRICT NAME
3
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3 Pre-Board Examinglion
& Roll No 30 Student ID 258965
7 Name of Student KAMALPREET
8 Father Name SHIVPREET
9 Mother Name NAVLEEN
W Class aTH Date of Birth __27/08/2008 _ Section B
T UID No 4528-6985-4587 Gender MALE
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25 9 |WELCOME LiFE 50 20 44 88 B
24 TOTAL MARKS 359
F [Maximum marks Secured [ 88 |
26 Mmmum marks Secured r 45 I
27 (Grade: 0-40: E.40-60.D, 60-80.C. 80-90-8, 90-100: A)
£
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E-GOVERNANCE

,—[ Objectives of this Chaptelg
7.1 Introduction

7.2 Characteristics of Good Governance

7.3 E — Governance

7.4 Governance vs. E-Governance

7.5 History and development of E — Governance
7.6 Objectives of E — governance

7.7 E-Governance Models

7.8 Services of E — Governance

7.1 INTRODUCTION

Before we start learning E-Governance, we must know the meaning of governance. The concept
of “governance” is not new. It is as old as human civilization.”Governance” means the process
of decision-making and their implementation. Various actors are involved in governance. An
analysis of governance focuses on the formal and informal actors involved in decision-making
and implementing the decisions. Government is one of the actors in governance. Other actors
involved in governance vary depending on the level of government. Following figure shows the
various levels of governance:

~

National Level

S
\

State Level

Local Level

Urban (Municipality)
{ Rural (Panchayat)

Fig 7.1 Levels of Governance
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7.2 CHARACTERISTICS OF GOOD GOVERNANCE:

Good governance is the processes of making and implementing decisions in a preferred way. It’s not
about making ‘correct’ decisions, but about the best possible process for making and implementing
those decisions. Following are some of the important characteristics of a Good Governance:

1. Good governance is answerable to the community, for the consequences of decisions it has
made.

2. Good governance is transparent which means that people are able to clearly see how and
why a decision was made.

3. Good governance follows the rule of law.

4. Good governance is responsive which means that government always tries to serve the
needs of the entire community timely and appropriately.

5. Good governance is effective and efficient in implementing decisions and follows processes
that make the best use of the available people, resources and produce results that meet the
needs of society.

6. Good governance is participatory. Anyone affected by or interested in a decision have the
opportunity to participate in the process for making that decision. This can be done in
several ways such as by providing community members with information, ask for their opinion,
given the opportunity to make recommendations or, in some cases, be part of the actual
decision-making process.

Responsive Citizen Friendly
Administration Administration

Good

Excellent Public Transparent

Services Governa nce Administration

Ethical
L Administration J

Fig 7.2 Characteristics of Good Governance
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7.3 WHAT IS E-GOVERNANCE:

E-Governance stands for Electronic Governance. The application of Information Technology (IT) and
communication for the purpose of governance is commonly known as E-Governance. Using E-
Governance, government provides various types of services online to its citizens at their door step. E-
Governance has made the working of government more efficient and more transparent to its citizens.
Success or failure of any government depends on following major factors:

1. The way the government works.
2. Transparency in its working and information.
3. Communication to its citizen.

In E-Governance, government makes best possible use of Information Technology to communicate
and provide information to citizens and businesses.

There are four pillars of E-Governance:

1. Connectivity: Connectivity is required to connect the people to the services of the
government.

2. Knowledge: Here, knowledge is referred to as I'T knowledge. Government employees
and skilled engineers make it possible to work E-Governance in an efficient way.

3. Data Content: To share information over the internet, government maintains its
database which should have the data related to government services.

4. Capital: Capital refers to the investment made by government to provide their services.

Due to widespread demand of E-governance and exponentially increasing size of data, new
technologies like Open source solutions and cloud computing need to be used in the working of
government. Today, electricity, water, phone and all kinds of bills can be paid over the internet.

7.4 GOVERNANCE VS E-GOVERNANCE:

We can differentiate governance and e-governance as given in following table.

GOVERNANCE E-GOVERNANCE
e Governance refers to the process of decision- | e E-Governance refers to the use of ICT
making and their implementation without the in enhancing the range and quality of
use of ICT. - information and services delivered to

the public, in an effective manner.

e Ituses one-way communication protocol. e Ituses two-way communication
protocol.
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7.5 HISTORY AND DEVELOPMENT OF E - GOVERNANCE:

In India E-Governance originated during the seventies. At that time government adopted its
applications in the areas of defense, economic monitoring and planning. The ICT was used to
manage data related to elections, census, tax administration etc. After that, with the efforts of the
National Informatics Center (NIC) all the district headquarters were connected during the eighties.
From the early nineties, e-governance has used IT for wider sectoral applications with emphasis
on reaching out to rural areas.

Earlier, a talk between a citizen and the Government takes place in a government office.But with
the advancement of Information and Communication technologies, work culture of government
offices have enhanced. Information and Communication Technologies has made it possible to
locate service centers near to clients. Such centers may consist of an unattended kiosk in the
government agency, a service kiosk located close to the client outside the government agency, or
the use of a personal computer at home or office.

In all the cases public traditionally look for information and services addressing his/her needs. In
both cases quality and efficiency are of great importance. Therefore, the establishment of E-
Governance requires a good knowledge of the needs that exist in the society and that can be
offered using ICT.

7.6 OBJECTIVES OF E - GOVERNANCE:

The objective of E-Governance is to support and simplify governance for all parties - government,
citizens and businesses. In other words, E-Governance uses electronic means to support and
encourage good governance. Therefore, the objectives of e-governance are similar to the objectives
of good governance.

The main objectives of E- Governance are:

1. Tosatistactorily fulfill the public’s needs and expectations by simplifying their interaction
with various online services.

2. To facilitate a speedy, transparent, accountable, efficient and effective process for
performing government administration activities.

Here we can say that e-governance is more than just a Government website on the Internet.Political,
social, economic and technological aspects are determined in E-Governance.

7.7 E-GOVERNANCE MODELS:

E-GOVERNANCE services can be shared between Government and Citizens, Businessman,
Government and Employees. These four models of e-governance are as:-

I. Government to citizens (G2C)

II. Government to businessman (G2B)
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III. Government to employees (G2E)

I'V. Government to government (G2G)

Fig 7.3 E-Governance Models

I. Government to Citizens (G2C):

This model of e-governance refers to the government services which are shared by citizens. In this
model, citizens visit the official government web-portals for accessing various types of services. This
model strengthens the bond between government and its citizen. Type of services which are provided
by this model includes:

e  Payment of online bills such as electricity, water, telephone bills etc.

e  Online registration of applications for different services like passport registration, applying
various types of licenses.

e  Copies of land-record.

e Online filing of complaints.

e  Availability of any kind of online information.
II. Government to Businessmen (G2B):

Through this model, bond between private sector and government are strengthened. It is used by
businessmen to communicate to the government. Type of services which are provided by this
model includes:

1 Collection of taxes.

2 Rejection and approval of patents.

3 Payment of all kind of bills and penalties.

4 Sharing of all kind of information, rules and data.

5 Complaints or any kind of dissatisfaction can be logged.
III. Government to Employees (G2E):

This model increases the transparency between government and its employees. Here, employee
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can keep a check on the functioning and working of government or vice-versa. Information shared by
this model includes:

e All kind of data submission (attendance record, employee record etc.) from various
government offices.

e Employees can file all kinds of complaints and dissatisfaction.

e  Employees can access any kind of rule-regulation and information.

e Employees can check their payment and working record.

e Employees can send all kind of applications online.
IV. Government to Government (G2G):

This model refers to the services which are shared between the governments. There is lots of information
that need to be shared between various government agencies, department and organizations. These
types of services or information includes:

Sharing of information between police department of various state.

2 Exchange of government documents including preparation, approval, distribution, and
storage of all governmental documents, is also done through e-governance.

3 Most of the finance and budget related activities are also performed through this model of
e-governance.

7.8 SERVICES OF E - GOVERNANCE:

Today area of e-governance is very wide. E-governance services are provided by the center, state and
local governments for various sectors. From urban areas to rural areas, e-Governance has spread its
root everywhere. Either it is public or private sector, common man or businessman, all are heavily
dependent on e-governance services. Here we will go through different areas where e-governance is
widely used.

7.8.1 E-Governance Services at National Level:

E-governance services at national level are provided by Center Government of India. In a fast-growing
and demanding economy like India, e-governance has become essential. The rapid growth of digitalization
has led to incorporate technology into governmental processes. Some of the important E-governance
services at national level are:

e  Banking Services.

e Aadharservices.

e  Passport Services.

e  Immigration & Visa Services.

e  Filing of income tax returns.

e  Payment of various types of taxes.

e  Central Excise and Custom services.
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Digital land management systems.
Voter card services.

PAN Card services.

Digital India initiative.

National Portal of India.

Conducting various types of on line Entrance Tests by National Testing Agency (NTA).

Various projects at National Level:

1.

IRCTC (Indian Railway Catering and tourism Cooperation Itd.) Offers online rail ticket
booking, and checking of ticket reservation status.

e-Pramaan is a National e- Authentication service which provides a simple, convenient and
secure way for the users to access government services via internet/mobile as well as for the
government to assess the authenticity of the users.

UMANG (Unified Mobile Application for New-age Governance) is a common, unified
platform, aggregating major government services (of Center, States, local bodies),
including important utility services, to facilitate single point access through mobile
app anytime, anywhere.

DigilLocker is an initiative of Ministry of Electronics & IT (MeitY) under Digital
India programme. Targeted at the idea of paperless governance, DigilLocker is a
platform for issuance and verification of documents & certificates in a digital way,
thus eliminating the use of physical documents.

7.8.2 E-Governance Services at State Level:

E-governance services at state level are provided by State Governments. In Punjab, to implement

the E-Governance projects for the overall benefit of the citizens Punjab Government has

established a society named Punjab State e-Governance Society (PSEGS). Its primary object is

to set up the necessary administrative, financial, legal and technical framework, implementation

of mechanism & resources in the State of Punjab.

Some of the main E-governance services at state level are:

e-District services such as licenses, Complaints, electricity and water bill payments,
birth/death/caste/income certificates etc.

Agriculture services like providing information on quality pesticides, seeds, soil health,
market prices etc.

Commercial Taxes services like sale tax, development tax etc.

CCTNS-Police is an initiative in the department of Police in increase awareness of
various laws among public.
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Land Record service includes e-registries, e-fard, e-stamping etc.
Road Transport service is related to the management of state highway projects.

Employment Exchange service includes employment assistance to both employers and
unemployed candidates.

Various projects at State Level:

1.
2
3.
4

5.

HRTC (Himachal Road Transport Corporation project) is for online bookings, cancellation
of seats, for enquiry about departure of buses, availability of seats and buses etc.

SAMPARK by Chandigarh government.
E-Suvidha by the government of Uttar Pradesh.
E-SEVA (Electronic seva) by Andhra Pradesh.

E-Mitra by the Government of Rajasthan

7.8.3 E-Governance Services at Local Level:

E-Governance at local level in a state may refer to the services provided by local bodies in different

sectors of rural and urban areas. In urban areas, these services are provided through Municipal

Corporations and Municipal Councils, whereas in rural areas, these services are provided through
Panchayats. All these services in rural and urban areas are controlled as per State and Center guidelines.

Some of the main E-governance services at local level are:

7.8.3.1 E-Governance Services in Urban Areas:

1.
2.

1.

House Tax Assessment, Billing and Collection.

Maintaining records of Land & property. Certificates like Land sale Permission, Legal
heir certificate.

Issue of Passport Verification Certificate.
Issue of Birth or Death Certificates.

Registration & Attorneys of properties such as computerization of the Document registration
work at Sub Registrar Office.

Provide services such as issuance of certificates, issuance of orders in respect of Social
Security Schemes such as old age pension, widow pension, freedom fighter pension
etc.

Review and approval authority for site plans

Various projects in this area are:

1.

SDO Suite by Assam government.

7.8.3.2 E-Governance Services in Rural Areas:

1.
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Conducting various welfare schemes for the poor and needy sections of the society.
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2.

3.

To provide wage employment to the needy from amongst the poorest section of the rural
society.

Rural water supply and sanitation.

Various projects in this area are:

1. E-GramViswa Gram Project by Gujarat.
2. Rural Digital Services.
POINTS TO REMEMBER
“Governance” means the process of decision-making and their implementation.

2. Good governance is the processes of making and implementing decisions in a
preferred way. It’s not about making ‘correct’ decisions, but about the best possible
process for making and implementing those decisions.

3. E-Governance stands for Electronic governance. The application of Information
Technology (IT) and communication for the purpose of governance is commonly
known as e-governance.

4. There are four pillars of E-Governance: Connectivity, Knowledge, Data Contents
and Capital.

5. Governance uses one way communication protocol whereas e-governance uses two
way communication protocols.

6. E-GOVERNANCE services can be shared between Government and Citizens,
Businessmen, Government and Employees.

7. G2C model of e-governance refers to the government services which are shared by
citizens.

G2B is used by businessmen to communicate to the government.

9. G2E model increases the transparency between government and its employees.

10. G2G model refers to the services which are shared between the governments.

11. E-governance services at national level are provided by Center Government of India.

12. E-governance services at state level are provided by State Governments.

13. E-Governance at local level in a state may refer to the services provided by local

bodies in different sectors of rural and urban areas.
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EXERCISE

Que:1 Multiple Choice Questions:

|

IV

Which is/are the levels of E-Governance?

A. National Level B. State Level
C.Local Level D. All of the above
Which of the following is not a pillar of E-Governance

A. Capital B. Knowledge

C. Delay in Work D. Connectivity
E-Governance Services can be shared between Government and
A. Citizens B. Government

C. Businessmen D. All of these

model of e-governance refers to the government services which
are shared by citizens.
A. G2B B. G2E
C.G2G D. G2C
E-governance services at National level are provided by
Government of India.
A. Local B. State
C. National D. All of these

Que:2 Write the Full Forms of the Following:

I

G2C I G2G III G2E IV G2B V IRCTC

Que:3 Short Answer Type Questions:

I
I
m
v
A%

Define Good Governance.

What are the different levels of E-Governance?
Write the name of Four Pillars of E-Governance.
Differentiate Governance Vs. E-Governance.
Write about the G2C model of E-Governance.

Que:4 Long Answer Type Questions:

I

I
m
v
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Write the main characteristics of Good Governance.

What is E-Governance? Explain the four models of E-Governance.

Make a list of various Services provided at National level of E-Governance.
What are the E-Governance Services in the Urban Areas?
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DATABASE MANAGEMENT SYSTEM

,—{ Objectives of this Chapter:

8.1Introduction

|

8.2 Data and Information

8.3 Database Terminology

8.4 File Processing System

8.5 DBMS

8.6 File Processing System vs DBMS
8.7 Components of DBMS Environment

8.8 Database Operations

8.1 INTRODUCTION

A database management system is an important tool for enterprise organizations that operate digitally
and rely on consistent, clean data to make decisions. While databases are essential for data storage, it’s
the DBMS that helps database users to modify, manage and make proper use of data of organizations.
DBMS systems are essential for businesses because they offer an efficient way of handling large amounts
of data. In this chapter, we will cover various aspects of databases and the systems to manage these
databases.

8.2 DATA AND INFORMATION

Data and information have an important role in the world of database management systems. So, first of
all we discuss these two basic concepts:

e Data (or Raw Data): Data is raw and unorganized fact that requires processing to
make it meaningful. Various types of facts, figures, statistics etc. that have no
particular meaning by themselves are known as Data.

Raw Data e

. Information
Raw Data |—71 E> Processing E> (Processed Data)

Raw Data —

Fig:8.1 Concepts of Data and Information
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e Information (or Processed Data): Information is a set of data which is processed in a
meaningful way according to the given requirement.In simple words, we can say that
Information is the processed data.

Data vs. Information:

Data Information
* Data is raw and unorganized fact that * Information is processed data that does not

requires processing to make it meaningful. | require any processing to make is meaningful.

¢ Data does not have any specific purpose |* Information carries a meaning

* Data alone has no significance. * Information is significant by itself

e Data is measured in bits and bytes. * Information is measured in meaningful
units like time, quantity, etc.

8.3 DATABASE TERMINOLOGY

Before going to discuss in detail about DBMS, it is necessary to know about various concepts and
terms that are used in context with database management systems. Some of the essential and important
terms and concepts are explained below:

e Attribute: It is the smallest unit of named data in a relational database. It may consist
of bits or bytes. It represents one piece of information about an object. Every attribute
in a table has a unique name and a data type. This data type defines the type of values
that can be stored in that column. An Attribute is also known as a field or column or
data-item in a table.

e Record: Itis a collection of named data-items which represents a complete unit of information
in the table.A Record is also known as a Tuple.

Attributes
/\ﬁ_‘

Roll No Name Marks

101 Ram Singh 452

102 Mohan Lal 412 Record
103 Gurmeet Kaur 512

104 Paramveer 402

Table: Students

Fig:8.2 Concept of Table, Attribute and Record

134 B DATABASE MANAGEMENT SYSTEM



e Table: Table is the main component of database. It is used to store data. A Table contains
rows which are called records. There may be more than one table in a relational database.
A table usually has a name. Every row in a table contains the same set of columns.A table is

also known as a Relation.

e Database: A database can be defined as the organized collection of interrelated data.
Databases are used to store the vast amount of data in various organizations, A database
provides organized structure to store data electronically. Generally, data in the database
is organized into rows, columns and tables so that it can be easily accessed, managed

and updated.
8.4 FILE PROCESSING SYSTEM

File based systems are an early attempt to computerize the manual filing system. In this system,
data or record were stored in the form of flat files. These files can be created in simple text
editors, such as notepad etc. The information was stored with each field separated by space, tab,

comma, semicolon or any other symbol.

All files were grouped according to their categories; files use only related informations and each
file is named properly. For example: for storing Student information, Student files for each class
were bundled inside different folders to identify it quickly. Now, if we want to see a specific
Student detail from a file, what do we do? We must have to know which file will have the data,
we open that file and search for his details. Here we see the files; we can open it and search for
it. But imagine if we want to display student details what we will do. It is really a difficult work

to do. Now how will we open a file, read or update it?

These kinds of problems were arising in file processing system. Now we are going to discuss the

drawbacks of file processing system as follows:
e  File Processing systems lead to duplicacy.
e Datais isolated and separated in different files
e  Poor data security is there in File Processing System.

e In the files, data are stored in specific format, say tab, comma or semicolon. If the
format of any of the file is changed, then the program for processing this file needs to

be changed.
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8.5 DBMS

DBMS stands for Database Management System. To overcome all drawbacks of file processing

system, a new system called database management system was developed. A database management

system (DBMYS) is a system software. It is used for creating and managing databases. The DBMS

provides us the facility to create, retrieve, update and manage data of the database. In simple

terms, we can say that DBMS is a software layer that provides an interface between user and the

database.

User 1 D‘n
| p‘
Database User 2 n

=] R

Fig: 8.3 DBMS relation with database & users

8.5.1 Advantages and disadvantages of DBMS:
Advantages of DBMS:

Redundancy is being controlled in DBMS. By having centralized database most of
the redundancy can be avoided.

When the same data is duplicated and changes are made at one site, which is not
propagated to the other site, it gives rise to inconsistency. These kinds of situations
can be controlled in DBMS.

Data is shared by multiple applications or by multiple users in DBMS.

We don’t have to worry about the loss of data because DBMS provides Backup and
Recovery options.

In DBMS, there is Restriction on unauthorized access to the database.

DBMS systems provide mechanisms to provide concurrent access of data to multiple
users.

Disadvantages of DBMS:
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It is complex, so users must have to get training to use the database.
Higher impact of a failure so there is the possibility of data damage.

The cost of DBMS varies significantly, depending on the environment and functionality
provided. There is also the recurring annual maintenance cost.

An extra hardware is needed.
Conversion cost is very high of the DBMS.

Itis not easy to move it to another locations due to hardware and software specifications.
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e DBMS s an extremely large piece of software. It requires substantial amounts of memory
in our PC to run efficiently.

8.6 FILE PROCESSING SYSTEMyvs. DBMS

There are following differences between DBMS and File system:

DBMS

* DBMS is a software for managing the

File Processing System

* File system manages and organizes the files
in a storage medium within a computer. | database.

* Redundant data can be present in a file [* In DBMS there is almost no redundant data.
system.

* File system doesn’thave a crash recovery |« DBMS provides a crash recovery mechanism.
mechanism

* It doesn’t provide backup and recovery
of data if it is lost.

* There is no efficient query processing in

* It provides backup and recovery of data even
if it is lost.

* Efficient query processing is there in DBMS.

file system.
* There is less data consistency in file ¢ [t has more complexity in handling as
system. compared to file system.

e Itis less complex as compared to DBMS. [« DBMS has more security mechanisms as

* File systems provide less security in
comparison to DBMS.

compared to file system.

« It is less expensive than DBMS. e It has a comparatively higher cost than a file

system.

In short, we can say that DBMS is better than the File based system for managing data.
8.7 COMPONENTS OF DBMS ENVIRONMENT

DBMS components define and regulate the collection, storage, management and use of data
within a database environment. There are the following components that exists in the DBMS
environment:

DATABASE MANAGEMENT SYSTEM

Hardware }

%

Fig: 8.4 Components of DBMS Environment
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Following is a brief description of these components:
a. Software:

Software refers to the collection of programs used with in the database system. It includes the operating
system, DBMS Software, application programs and utilities.

e  The operating System manages all the hardware components. It helps to run other
software on the computers. UNIX, LINUX, Microsoft Windows etc. are the popular
operating systems used in database environment.

e DBMS software manages the database with in the database system. Oracle, DB2,
MYSQL, MS Access and SQL Server etc. are the popular DBMS (RDBMS) software
used in the database environment.

e Application programs and utilities software are used to access and manipulate the
data in the database.

b. Hardware:

This component includes all the physical devices of database system environment. The most
important and necessary component is a powerful computer system for processing a large amount
of data of organizations. It might be a mainframe computer or minicomputer in large organizations.
DBMS requires large amount of memory. A large secondary storage (HDD or RAID disks) is
essential to store the large amount of data in the database. Similarly, a large main memory (RAM)
is also required to handle the requests of multiple users.

c. Procedures:

Procedures refer to general rules and instructions that help to design the database and to use a
database management system.

Procedures are used to setup and install a new database management system (DBMS), to login
and logout of DBMS software, to manage DBMS or application programs, to take backup of the
database, and to change the structure of the database, etc.

d. Data

It is the most important component of the database management system.The main task of DBMS
is to process the data. Here, databases are defined, constructed, and then data is stored, retrieved
and updated to and from the databases.The database contains both the metadata (description
about data or data about data) and the actual (or operational) data.

e. Users

The users are the people who control and manage the databases and perform different types of
operations on the databases in the database management system.
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There are many types of users who play different roles in DBMS. Following are some of the common
types of DBMS user:

o  Application Programmers: The users who write the application programs in programming

languages to interact with databases are called Application Programmer.

e Database Administrators: A person who manages and controls the overall DBMS is
called a database administrator or simply DBA. The Database Administrator, better
known as DBA, is the person (or a group of persons) responsible for the wellbeing of

the database management system.

e End-Users: The end-users are those who interact with the database management
system to perform different operations on data by using the different database

commands such as insert, update, retrieve or delete on the data, etc.
8.8 DATABASE OPERATIONS

Various types of operations can be performed in the databases by its different types of users.
Some users perform regular operations on the databases while some users perform operations to
control the various activities on databases. All these operations can be classified broadly into

three categories:

e Data Definition Operations: It includes those operations which are used to define,
modify or delete the data structures, such as tables etc., in the database. CREATE,
ALTER and DROP are the important commands to perform these operations. All

these commands on databases are usually performed by the Database Administrators.

e Data Manipulation Operations: It includes those operations which are used to
perform day to day operations on the data stored in the database, for example: inserting
new records, editing records, deleting records or viewing records etc. INSERT,
UPDATE, DELETE, and SELECT are the important commands to perform these

operations. All these commands are usually performed by the end users of the database.

e Data Control Operations: It includes those operations which are used to control the
activities on the database, for example: giving or revoking permissions to user to
perform selected operations on the selected tables. GRANT and REVOKE are the
main commands to perform these operations. All these commands on databases are

usually performed by the Database Administrators.

Database management systems (DBMS) provides Structured Query Language (SQL) to perform

these operations on the databases.
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POINTS TO REMEMBER

10.

I1.

12.

13.

14.

Data is araw and unorganized fact that requires processing to make it meaningful.
Information is the processed data.

Attribute is also known as a field or column or data-item in a table. It is the smallest unit of

named data in a relational database.

A Record is also known as a Tuple. It is a named collection of data-items which represents
acomplete unit of information in the table.

A database can be defined as the organized collection of interrelated data.
In File ProcessingSystem, data or record were stored in the form of flat files.

To overcome all drawbacks of file processing system, a new system called database

management system was developed.
DBMS is a software layer that provides an interface between user and the database.

Procedures refer to general rules and instructions that help to design the database and

to use a database management system.

A person who manages and controls the overall DBMS is called a database

administrator or simply DBA.

The end-users are those who interact with the database management system to perform
different operations on the data by using the different database commands such as

insert, update, retrieve and delete data, etc.

Those operations which are used to define, modify or delete the data structures, such

as tables etc., in the database are termed as Data Definition Operations.

Those operations which are used to perform day to day operations on the data stored

in the database are termed as Data Manipulation Operations.

Those operations which are used to control the activities on the database, are termed
as Data Control Operations.
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EXERCISE

Que:1 Multiple Choice Questions:

| is a raw and unorganized fact that requires processing to
make it meaningful.
A.Data B. Information
C. Database D.DBMS

II' A Record is also known as a
A. Column B. Attribute
C. Field D. Tuple

III A person who manages and controls the overall DBMS is called a
A.DBA B. End User
C. Database Designer D. Programmer

IV DBMS is a software layer that provides an interface between and
the
A. Data, Information B.DBA, End User
C. User, Database D. Data, Database

A\ refer to general rules and instructions that help to
design the database and to use a database management system
A. Information B. Procedures
C. Application Programs D. System Programs

Que:2 Write the Full Forms:

I DBMS

I DBA

o SQL

Que:3 Short Answer Type Questions

What is record?
Define Database.

<2 E=R"~

Write the name of different types of users of database.
What do you know about DBMS?

Write the name of various components of Database environment.
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Que:4 Long Answer Type Questions:
I Write the differences between Data and Information.
I Explain the various components of DBMS Environment.
I Differentiate File Processing System and DBMS.
I Whatis DBMS? Explain any five advantages of DBMS.

Lab Activity

Write the name of various components of DBMS Environment.

omponents
of DBMS
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Appendix-I

Lab Activity for Typing Practice in English

Exercise-1

asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg
asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg
asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg
asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg
asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg ;1kjh asdfg

Exercise-I1

Ask Fad Alsas Shad Lads Flags Flask
Jag Fag Fall Hash Glad Galls Salad
Jak Had Gaff Dash Gall Flash Slash
Sad Lad Adds Lash Hall Lakhs Dhalls
Dad Asks Alas Dall Fall Glass Shall

Exercise-111

gwert poiuy gwert poiuy gwert poiuy gwert poiuy gwert
poiuy gwert poiuy gwert poiuy gwert poiuy gwert poiuy
gwert poiuy gwert poiuy gwert poiuy gwert poiuy gwert
poiuy gwert poiuy gwert poiuy gwert poiuy gwert poiuy
gwert poiuy gwert poiuy gwert poiuy gwert poiuy gwert
poiuy gwert poiuy gwert poiuy gwert poiuy gwert poiuy
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Exercise-1V

awerqfa ;o1upj; awerqfa ;01upj; awerqfa ;o1upj;
awerqfa ;olupj; awerqfa ;olupj; awerqfa ;olupj;
awerqfa ;olupj; awerqfa ;o01upj; awerqfa ;olupj;
awerqfa ;olupj; awerqfa ;olupj; awerqfa ;olupj;
awerqfa ;olupj; awerqfa ;01upj; awerqfa ;olupj;
Exercise-V
Fish Dirks Oldest Apple Grade Falls Kodak
Rails Jaded Dead Usual Sales Filed Legal
Lease Lakes Agile Isles Ahead Larks Roses
Forks Hedge Skill Rupee Grass Would Alpine
Jaded Liked Equip Quail Jokes Asked Walks
Fiddle Saddle Dead Filed Lakes Lease Legal
Exercise-VI
azxcvf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxcvf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxcvf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxcvf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
azxcvf lkmnbj azxcvf lkmnbj azxcvf lkmnbj
Exercise-VII
Cat Jack Colour Neither Enemy Boat Calcutta
Not Have Joints Calling Voted Very Vineyard
Met Wind Nerves Enlarge Money Move Material
Men Verb Verbal Someone Marry Give Sterling
Bent Joint Jackets Examine = Thousand  Cylinder Assessment
King Carry Jumbled  Examined  Struggle Possible Beginning
Zeal Night Booklet Gracious Grizzled  Frequent Meanings
Zero Tonic Cutting  Becoming Zodiacal = Exponent Doubtless
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Exercise-VIII

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

12345
12345
12345
12345
12345

098767
098767
098767
098767
098767

Exercise-IX

[am—

My steps are measure

10. Truth never fails.

Type the following sentence S times :
Lost time is never regained
Get-up early and do your work

Today’s youth and tomorrow’s old

A friend in need is a friend indeed

Age is a virtue when wisdom is with it.

2

3

4

5. Measure your word before it goes out of you

6

7

8. Children are innocent and should be guided rightly.
9

Our Land has great sages who knew the eternal truth.

11. The Quick Brown Fox Jumps Over A Lazy Dog

Exercise-X

Type the following paragraph 10 times :

Our flag is tri-colour. SAFFRON is the symbol of sacrifice and a string mind. WHITE
is the symbol of purity, love and peace. GREEN is the symbol of plenty and joy. We
hoist and salute our flag. We are ready to make sacrifices for our country. We want peace

and progress. We want to be pure.
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Lab Activity for Typing Practice in Punjabi (AnmolLipi)
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Home Row Exercise-1

Sresar
Sresar

Sresar  Bang
Sresar  Bang
Sresar  Bang
Sresar  Bang
Sresar  Bang
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grege U f
grege U f
grege U f
grege U f
grege U f
gt6. 5 T
gt6. 5 T
gt6. 5 T
gt6. 5 T
g7€. 3 G

Gregzs e
Gregzs e
Gregzs e
Gregzs e

Gregzz€

APPENDIX

Second Row Exercise-I11

ITE&Jd<C

ITEJd<C

ITEJd<C

ITEJd<C

ITEJd<C

u

ITEJC

ITEJC

ITEJC

ITEJC

ITEJC

Second Row Exercise-IV

gt§. &
gt§. 5
gt§. 3
gt§. 3

g8 3

T

L

EN

g

L

a\_-sa

gtg
gtg
gtg
gtg

gt6. 5

Home Row Second Row Exercise-V

S fuwa

Cfu

=y =y
nd i~
o o
1 1 1

Ty
i~
c
1

’

mMiG gea
mMiG gea
mig gEA
mMiG gea

mig gEA

o,

o,

o,
[(§

A -
A -
A -
TY ey,

A - -
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enfg gfgan  "BEEHC UUSE
Sfen gGeee  uEle s
<daH RCr b (&S _ uge
ESECE] sfaee G3fu gofs

Home Row Second Row Exercise-VI

wabee
Ae®en
nmJeSe
wabwn

=

SATH

gfeesr mboeme uwebe efgee w09ww

Home/Second/Third Row Exercise-VII

Sazsves BIHEITHA MIATTESTE
Sazsves BIHEITHA MIATTESE
Sazsves BIHEITHA MIATTESE
Sazsves BIHEITHA MIATTESE
Sazsves BIHEITHA MIATTESE

Fourth Row Exercise-VIII
"12345 09867 T # 4%
"12345 09867 T # 4%
"12345 09867 T # 4%
"12345 09867 T # 4%
"12345 09867 T # 4%
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SISy EISEy
efsre  mEalsm
tASCE] AeH
s wsufse
wAgee  O%an
BEOAE  BTICH
BY gy
BY ‘gY
BY ‘gY
BY ‘FgY
BY ‘gY
HE * ()
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Exercise-IX
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Appendix—Practice Lessons for Typing in Raavi Unicode Font

Unicode Font “Raavi” in key map
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Home Row Lesson Using Shift Key
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1%t Row (Upper Row) — Practice Lesson using Shift Key
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15t Row (Upper Row) — Practice Lesson using Shift Key

o |[wa || ew || R& || TG (| Y3 [|us || 1w |[ow (| py| {7} |||,
Tab "
Q0 || wd |[eor || rat |[tg ||y || vT [|iT || o= |[pa |l [ ]q | \

fywmAgusgesdmwessed@uouedsuwyasy
nmeewydegfruesddwmeudesiesgse
803383 TUIREIUGTWNIITEIETYIIESR
MsfssImd A s wuTINIEIRTYWEES
AW TI T3 umwIgusdsQududenwmu
N 3gIgMdu gl ssswsusdgesnd oo
swmeyRnQf@wIIvsvQussQuesAsuey§
mgdawmaessdomsnyssn@asggyd

g8 #y wsd wus el sus Q3Fhs Ewr wisu vus BQ wisu wie o wh@
wigu ve V183 w3 Wl 5@ v iy wisu Wik wu fy Wik TRIU wu TRUs3
el 3 wigu U @ wsEl v wsdl w@ ¥y ¥I83 wm wisu ¥su sus g
Qau div wsd w W Q30 wIs §38 YE wm §3u WU W usH we T
g8eu »arQ wQew ol Wws usel eeuss W@ G193 @ wsBd a3 s
»u TYs U3 wiw YT ¥9s ¥9s wu §3u Tevu wk vus HI93 H18s #6s
By wu o o 5§ wdl usd @y wdl vesu wsGH wsu W s wbag

APPENDIX



2" Row (Buttom Row) — Practice Lesson without using Shift Key
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2" Row (Buttom Row) — Practice Lesson using Shift Key
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Appendix-I1

COMMONLY USED FULL FORMS

Acronym Full Form

Al ARTIFICIAL INTELLIGENCE

ARPANET ADVANCED RESEARCH PROJECT AGENCY NETWORK

BMP BITMAP PITURE

bpi BITS PR INCH

CD COMPACT DISK

CPU CENTRAL PROCESSING UNIT

CSS CASCADING STYLE SHEET

CUI CHARACTER USER INTERFACE

DMP DOT MATRIX PRINTER

DOS DISK OPERATING SYSTEM

DRAM DYNAMIC RANDOM ACCESS MEMORY

DSL DIGITAL SUBSCRIBER LINE

DTP DESKTOP PUBLISHING

DVD DIGITAL VIDEO DISK

E COMMERCE ELECTRONIC COMMERCE

EEPROM ELECTRONICALLY ERASABLE PROGRAMMABLE READ
ONLY MEMROY

EMAIL ELECTRONIC MAIL

EPROM ERASABLE PROGRAMMABLE READ ONLY MEMROY

FTP FILE TRANFER PROTOCOL

GB GIGABYTE

GIF GRAPHICS INTERCHANGE FORMAT

GUI GRAPHICAL USER INTERFACE

HTML HYPER TEXT MARKUP LANGUAGE

IAP INTERNET ACCESS PROVIDER

IBM INTERNATIONAL BUSINESS MACHINE

IC INTEGRATED CIRCUIT

ISDN INTEGRATED SERVICES DIGITAL NETWORK
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Acronym

Full Form

ISP

INTERNET SERVICE PROVIDER

IT

INFORMATION TECHNOLOGY

JPEG JOINT PHOTOGRAPHIC EXPERTS GROUP
KB KILOBYTE

MB MEGABYTE

MIDI MUSICAL INSTRUMENT DIGITAL IDENTIFIER
MODEM MODULATOR DEMODULATOR

MPEG MOVING PICTURE EXPERTS GROUP

MROM MASKED READ ONLY MEMORY

NIC NETWORK INTERFACE CARD

PB PETA BYTE

PC PERSONAL COMPUTER

PNG PORTABLE NETWROK GRAPHICS

POP POST OFFICE PROTOCOL

PROM PROGRAMMABLE READ ONLY MEMORY
RAM RANDOM ACCESS MEMORY

ROM READ ONLY MEMORY

RTF RICH TEXT FORMAT

SERP SEARCH ENGINE RESULT PAGE

SMTP SIMPLE MAIL TRANSER PROTOCOL

SRAM STATIC RANDOM ACCESS MEMORY

TB TERABYTE

TCP/1P TRANSMISSION CONTROL PROTOCOL

ULSI ULTRA LARGE SCALE INTEGRATED CIRCUIT
UPS UNINTERRUPTED POWER SUPPLY

URL UNIFORM RESOURCE LOCATOR

USB UNIVERSAL SERIAL BUS

VLSI VERY LARGE SCALE INTEGRATED CIRCUIT
WWw WORLD WIDE WEB

WYSIWYG WHAT YOU SEE IS WHAT YOU GET
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Appendix-III

Commonly used shortcut keys

(MS word)
Shortcut Keys Used for
Ctrl+A Select All
Cul+B Bold the selected text
Ctrl+C Copy the selected contents
Ctrl+D Opens the Font Dialog Box
Cul+E Center Align text
Ctrl+F Find text
Cul+G Goto line/page no etc
Ctrl+H Replace text
Ctrl+1 Italic the selected text
Ctrl+] Justify paragraph
Ctrl+K Create Hyperlink for the selected text
Ctrl+L Left Align the paragraph
Ctrl+M Increase Indent
Ctrl+N Create a New File
Ctrl+O Open Existing File
Ctrl+P Print File
Ctrl+Q Clear Indents and Tabs
Cul+R Right Align the text
Ctrl+S Save File
Ctrl+T Increase Hanging Indent
Ctrl+U Underline the selected contents
Ctrl+V Paste the contents from the clipboard
Ctrl+W Close File
Curl+X Cut the selected contents
Ctrl+Y Redo the last action (if possible)
Cul+Z Undo the last operation
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Ctrl+1 Single Line Spacing

Ctrl+2 Double Line Spacing

Ctrl+5 1.5 Line Spacing

Ctrl+] Increase Font Size

Ctrl+[ Decrease Font Size

Ctrl+Shift+C Copy the Formats of selected text
Ctrl+Shift+V Paste the copied Formats on selected text
F3 Change Case

F7 Spelling and Grammar Check

Alt+F4 Close Program
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COMMONLY USED SHORTCUT KEYS
(MS POWERPOINT)

Shortcut Keys Used For

Alt + A Go to the Animations tab

Alt + F Open the File tab menu

Alt + F2 or F12 Open the Save As dialog box

Alt + G Open the Design tab

Alt + H Go to the Home tab

Alt + K Go to the Transitions tab

Alt + N Open the Insert tab

Alt + Q Directs to the “Tell me what you want to do” box
Alt + R Go to the Review tab

Alt + S Go to the Slide Show tab

Alt + W Go to View tab

Alt + X Go to the Add-ins tab

Alt +Y Go to the Help tab

Alt or F10 Turn the key tips to ‘on’ or ‘off’

Ctl + A Select all the objects on an active slide

Ctrl + Alt + V Open the Paste Special dialog box

Cul + B Toggle bold on the selected text

Ctrl + C Copy the selected text, object, or selected slide
Ctrl + D Duplicate the selected object or a slide

Cul + E Center align the selected text

Ctrl + F Search in a presentation or use Find and Replace
Ctrl + F1 Show or hide the ribbon

Ctrl + F2 Print Preview View

Ctrl + 1 Toggle italics on the selected text

Ctrl +] Justify the selected text

Cul + K Insert a hyperlink

Ctrl + L Left align the contents

Cul + M Insert a new slide
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Shortcut Keys Used For

Ctl + N Create a new presentation

Ctrl + O Open an existing presentation

Ctrl + P Annotate using a Pen tool while playing the slideshow
Ctrl + Q Save and close a presentation

Ctrl + R Right align the selectd text

Ctrl + S Save a presentation

Cul + T Display the Font dialog box after text or object is selected
Cul + U Add or remove underline to selected text

Ctl +V Paste the selected text, object, or slide

Ctrl + W or Ctrl + F4 | Close a presentation

Ctl + X Cut the selected text, object, or slide

Cul +Y Redo an action

Cul + Z Undo an action

Delete Delete the selected text, object, or slide

Esc End the slideshow

F5 Play the presentation from the start

F7 Check for spellings

Home Go back to the beginning of the slide

N or Page Down Move to the next slide while playing the slideshow
P or Page Up Return to the previous slide while playing the slideshow
Shift + F5 Play the presentatin from the current slid

‘mfaa fant, rifgeraaT M3 Wie farest fegmar uae
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